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PART 4: Hydrologic and Geologic Information 

4.1  Regional Characteristics.  As described in Illinois State Geological Survey Circulars 192, 198, 207, 212, 222, 
225, 232, 248, Coop 1, etc., other sources or personal knowledge, provide the following required hydrogeologic 
information. All materials utilized in the preparation of this Part shall be clearly identified and a bibliography 
provided at the end of this Part. [1780.22(b)/1784.22(b); 1779.25(a)(6)/1783.25(a)(6)] 

 

4.1.1  Describe/discuss the major and minor unconsolidated aquifers of the permit area, shadow area for 
underground proposals (if applicable), and their respective adjacent areas. 

ISGS Circular No. 212 reports that Quaternary sand and gravel deposits capable of delivering water to a 
well bore are generally absent in area of the proposed surface effects area.  Local unconsolidated materials 
are typically composed of clay and lacustrine silt. This material rarely exhibits sufficient permeability for 
development as a reliable source of potable water. No buried bedrock valleys are known to be present 
within or immediately adjacent to the proposed permit area.  The Kaskaskia bedrock valley is located over 
13 miles to the west.  No major sand or gravel aquifers are known to exist within or immediately adjacent 
to the proposed permit area. 
 
 

4.1.2  Describe/ discuss the generalized water yield, supply, existing use and potential use of the major and 
minor unconsolidated aquifers. 

This area of Randolph County has poor unconsolidated aquifer potential with sand and gravel deposits 
generally absent (Pryor 1975).  Shallow (<30 feet deep), excavated, large-diameter wells are sporadically 
present in the area. These wells are typically used as cisterns because the groundwater output is seldom 
capable of meeting average contemporary residential demand.  Yields from wells completed in local 
Quaternary aged unconsolidated sediments water bearing zones in this region are generally limited to 20 
gpm or more but these deposits are not located within the permit or adjacent area (USGS 82-858).  Because 
of low yields most residents within the region are connected to public water supply. Three wells, all located 
on the same property tract, were identified as present within 0.5 miles of the proposed permit area. Only 
one of the three wells (GW100) was reported as being in use. The well, which is screened within the 
unconsolidated material, was reported as being used for potable water supply. 
 
 

4.1.3  Describe/discuss the major and minor consolidated aquifers in the permit area, shadow area for 
underground proposals (if applicable), and their respective adjacent areas. 

The underlying bedrock strata are primarily Pennsylvanian shales and claystones with some limited 
limestone intervals exhibiting permeability on the order of 10-6 to 10-11 cm/sec (Freeze and Cherry, 1979). 
These strata are generally considered impermeable and act as aquicludes. Pennsylvanian bedrock water 
bearing zones of thin sandstone and limestone beds typically yield less than 25 gpm (Smith and Stall 1975).  
The balance of strata within this area are composed of localized carbonate and arenite lenses exhibiting 
variable purity and hydrologic properties. Arenilitic strata in this area are typically fine grained and 
cemented (Pryor 1975).  Arenilitic strata capable of storing and delivering groundwater to a well bore 
typically do not possess adequate reservoir volume and recharge to provide yield sufficient to meet average 
residential use. No major bedrock aquifers are known to be present. 
 
 

https://www.isgs.illinois.edu/publications
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4.1.4  Describe/discuss the generalized water yield, supply, existing use and potential use of the major and 
minor consolidated aquifers. [1780.22(b)(1)/1784.22(b)(1)] 

ISGS Circular No. 212, reports that local Pennsylvanian sandstones are fine grained and exhibit low 
permeability. Most local sandstone units exhibit considerable secondary intergranular cementation which 
significantly impedes efficient delivery of groundwater to a well bore. Additionally, local Pennsylvanian 
shale, limestone, and coal strata are well known and well referenced as being generally unsuitable for 
development as sources of water. IWS Report of Investigation No. 55 reports that Pennsylvanian bedrock 
units typically exhibit transmissivity ranging from 122 to 840 gpd/ft, with hydraulic conductivity ranging 
from 3 to 12 gpd/ft2.  In Randolph County, wells typically obtain groundwater from the lower 
Pennsylvanian sandstones, but the depth to these sandstones is over 600 feet in the permit and adjacent 
areas.  
 
 

4.2  Hydrogeologic Information. 

4.2.1  Within the permit area, shadow area (if applicable), and their respective adjacent areas, assess the 
geologic setting, including a description of the landscape and terrain, stratigraphy, and the groundwater 
regime including water table depths and aquifer characteristics; using material available from sources, 
including, but not limited to, the Illinois State Surveys, the Illinois Environmental Protection Agency, other 
State and Federal organizations, water well drilling logs, and previous investigations. [1780.21/1784.14; 
1780.22(b)/1784.14(b); 1779.25/1783.25] 

REGIONAL PHYSIOGRAPHY 
 
The surface effects area is located in Randolph County on the southwestern shelf of the Eastern Interior 
Coal Basin.  The proposed surface effects permit area overlies the existing Permits 426, 225, 160, and 53.  
Prior to mining activity associated within these Permits, the area associated with Cell 5 Phase 2 was 
comprised of approximately 230.55 acres of rural agricultural and forested property. U.S.G.S. Open File 
Report 81-858, Hydrology of Area 29, reports the general area of the proposed permit as being in the Mt. 
Vernon Hill Country Physiographic Division, which is within the Till Plains Section of the Central 
Lowland Province. Landforms in the region are the result of both Illinoian Stage glaciation and recent 
degradation processes such as weathering, mass wasting, and stream erosion. Regional topography is 
characterized by generally flat ridge tops, moderately steep valley slopes and broad flat valley floors 
adjacent to major streams. The local surface drainage pattern is dendritic with minor influence from 
regional jointing patterns. The total topographic relief of the site is approximately 58.34 feet, ranging from 
approximately 486.1 to 544.4 feet above mean sea level (AMSL). 
 
CLIMATE 
 
The area has a continental climate with a mean cumulative annual precipitation of about 39 inches. Mean 
annual runoff is about 15 inches. Precipitation is generally greatest in the late spring and early summer. 
Thunderstorms provide the majority of summer precipitation. The 24-hour storm events for the area are 
4.76 inches for a 10-year event, 6.02 inches for a 25-year event, and 8.21 inches for a 100-year event. The 
mean cumulative annual snowfall is about 14 inches. In general, the highest mean monthly stream flows in 
the region occur from March through May during the spring rains. The highest peak flows are typically in 
July resulting from thunderstorms. The mean annual air temperature is about 58°F. July is usually the 
warmest month (80°F) and January is usually the coldest month (36°F). Cumulative annual 
evapotranspiration averages about 29 inches. Prevailing winds vary seasonally, generally being from the 
southwest in summer and northwest in winter. The average wind speed ranges between 6 and 11 m.p.h. 
 
GEOLOGY AND HYDROLOGY OF THE SURFICIAL UNCONSOLIDATED MATERIAL 
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The Handbook of Illinois Stratigraphy (Willman et al. 1975) assigns local surficial unconsolidated material 
to the undifferentiated member of the Pleistocene Glasford Formation. The Glasford Formation is believed 
to have been deposited during the Liman, Monican, and Jubileean Substages of the Illinoian glacial period 
and consists of till with sporadic sand and gravel lenses.  Piskin and Bergstrom (1975) describe the 
materials as till, silt, outwash, and mixed ice-contact deposits. Recent alluvium is mappable within and 
immediately adjacent to local perennial and intermittent streams. Unconsolidated sand and gravel deposits 
suitable for storage and delivery of groundwater to a well bore are generally absent locally (Pryor 1975).   
 
GEOLOGY AND HYDROLOGY OF LOCAL PENNSYLVANIAN BEDROCK 
 
Consolidated Pennsylvanian bedrock of the Modesto and Carbondale Formations, consisting primarily of 
shale, limestone, sandstone, coal, and underclay, unconformably underlies the Quaternary unconsolidated 
surface material within the proposed permit area (USGS 82-858; Willman et al. 1975). The Pennsylvanian 
bedrock does not outcrop within the permit area and is not proposed for disturbance. The thickness and 
continuity of Pennsylvanian bedrock strata within the permit area vary considerably and consists of cyclic 
sequences of clastic and carbonate sediments indicative of near-shore marine and brackish deltaic/fluvial 
paleoenvironments. Sandstone lenses exhibiting sufficient intergranular porosity and permeability, and/or 
carbonate bodies exhibiting sufficient density of interconnected fractures to store and deliver groundwater 
to a well bore are known to exist sporadically and randomly in the region. However, these reservoirs are 
typically very limited in storage volume. Because these bodies are surrounded by low permeability strata 
their ability to receive recharge is minimal, typically resulting in rapid reservoir depletion when developed 
as water sources.  
 
COAL REFUSE DISPOSAL CELL 5  
 
Coal refuse disposal Cell 5 Phase 1 was constructed to facilitate the need for additional storage capacity of 
coarse (gob) and fine (slurry) coal refuse generated at the Gateway Mine coal preparation plant. Cell 5 was 
constructed west of existing Cell 4 on agricultural and wooded lands. The embankment was constructed 
from excavated clay soil from the interior of the impoundment and coarse coal refuse. The clay soil 
borrowed from the excavation pit was compacted to 95% Standard Proctor and constructed with an outside 
slope of 3 (run):1 (rise) and minimum 20-ft top width. The interior embankment was constructed with a 2:1 
slope. Coarse refuse was placed against the inside face of the clay embankment, compacted to 95% 
Standard Proctor, and constructed with a 2:1 inside slope and 236 feet top width. The permeability of the 
site-specific compacted clay is low (arithmetic mean: 3.22×10-8 cm/sec) and acts as a soil liner. To ensure 
protection of the hydrologic balance the in-situ material beneath the embankment and impoundment 
interior was compacted to a depth of twelve inches and overlain by three successive lifts of twelve inches 
of material; all compacted to optimum density and moisture proven to achieve a permeability of no more 
than 1×10-7 cm/sec (see Part 4.10).  This liner design will be augmented at final reclamation with a 
designed enhanced cover. The engineered cover plan will consist of twelve inches of gob (into which 
agricultural limestone is incorporated at a minimum rate of twice the material’s potential acidity) 
compacted to a minimum permeability of 1×10-7 cm/sec, overlain by two six-inch layers of soil material 
compacted to a minimum permeability of 1×10-7 cm/sec, overlain by 27 inches of noncompacted rooting 
media, and topped with 9 inches of protective cover topsoil, at a minimum, which will provide the 
appropriate protection from infiltration.  Quality control and quality assurance compaction specifications 
were implemented for the liner according to permit requirements.  Similarly, the engineered cover will have 
the same quality control and quality assurance compaction specifications implemented as described in Part 
4.10. This composite minimum 4 feet thick compacted clay liner prevents infiltration of water under the 
embankment and recharge to the underlying water table. Sandy soils encountered at the base of the cell 
were removed and replaced with clay soils.  The completed cell height for Phase 1 will vary from 25 feet at 
the south end to 66 feet at the northwest corner. At its final stage of and normal pool elevation (548.2 ft 
AMSL) Cell 5 Phase 1 will impound 3122 acre-feet, with a surface area of 78.9 acres. Additional design 
details including physical properties and engineering test results of the remolded soil and refuse materials 
and slope stability analysis can be found in the 2011 NPN Environmental Engineers Cell 5 Slurry 
Impoundment Design, Gateway Preparation Plant, Mine Safety and Health Administration Permit 
Application.  
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Construction of Cell 5 Phase 2 will raise the embankment elevation from 553.2 ft AMSL to 585 ft AMSL.  
The south side of the embankment will extend from Cell 5, over Cell 4, and abut Cell 1.  On the north side, 
the Phase 2 embankment will abut the Cell 3 embankment.  At completion of construction to an elevation 
of 585 AMSL, Cell 5 will overtop the current Cell 4.  At capacity, Cell 5 Phase 2 will impound 9,405 acre 
feet of slurry up to a pool elevation of 579.4 feet AMSL.  The outer slope of the embankment will be 
constructed at a slope of 3.2:1 and the inner slope at a slope of 2:1, with an embankment top width of 50 
feet.  The Phase 2 embankment will be constructed of coarse refuse material compacted to 95% of the 
maximum density attainable by the Standard Proctor Compaction Method at optimum moisture content.  
The degree of compaction will be verified utilizing both field density testing and Standard Proctor testing.       
 
Cell 5 is a diked impoundment and the internal drainage area consists of only the area enclosed within the 
cell, which is part of the overall coal refuse/makeup water circuit. External drainage will be from the 
embankment out slopes only and reports to lined sediment basins with permitted NPDES outfalls. The 
compacted clay liner at the base of the sediment basins was constructed in the same manner as the liner 
beneath Cell 5 and consists of in situ material compacted to a depth of twelve inches, overlain by three 
successive lifts of twelve inches of material. All compacted layers were compacted to optimum density and 
moisture proven to achieve a permeability of no more than 1×10-7 cm/sec (see Part 4.10). The watershed 
area is currently defined by the top of the dam for the Cell 5 embankments, with the eastern watershed 
boundary defined by the top of the Cell 4 embankment.  The total watershed area is 120.6 acres at the 
completion of Phase 1.  At completion of Phase 2, Cell 5 will encapsulate Cell 4 and will receive runoff 
from the reclaimed surface of Cell 3.  The watershed area of cell 5 will increase to 345 acres at completion 
of Phase 2 (See Attachment 3.12.2.1 MSHA Application).  Hydrologic inputs into Cell 5 include 
precipitation, runoff along the interior of the embankments, and base flow from the slurry disposal 
operations. Discharge will be directed to the recirculation pond at the Preparation Plant for reuse.  
 
The Cell 5 MSHA classification for size and hazard are large and low-hazard, respectively, which has a 
recommended design event of 0.5 PMP.  Storm duration modeling indicated that the 72-hour PMP 
produced the most critical conditions for total runoff, peak flood stage, and peak discharge.  The 72-hour, 
0.5-Probable Maximum Precipitation (PMP) event was used to evaluate peak storage capacity and drainage 
of the impoundment under critical conditions. Total rainfall for a 72-hour, 0.5 PMP in this region is 20.3 
inches. The resulting runoff using the U.S. Army Corp of Engineers HMS program is 537.6 acre-feet. 
Inflow to the impoundment also includes a slurry discharge of 3450 gallons/minute (7.7 cfs) from the 
Preparation Plant. A normal operating level of 579.7 ft AMSL for the impoundment was determined from 
the stage-discharge relationship derived under various modeling scenarios. Results of the 72-hour, 0.5 PMP 
indicate that the flood storage capacity of the impoundment will be maintained and able to fully contain the 
design storm event. At the peak stage of 582.0 ft AMSL, 3.0 feet of freeboard will remain at the top of the 
damn, an adequate height for this area and size of impoundment.  In addition, the discharge system was 
capable of dewatering 90% of the peak flood within a 10-day maximum, a period considered adequate for 
impoundments relying on flood storage capacity rather than discharge capability.  Additional details 
concerning the modeled results and various inputs can be found in the 2020 NPN Environmental Engineers 
Cell 5 Phase II Slurry Impoundment, Gateway Preparation Plant, Mine Safety and Health Administration 
Permit Application (Attachment 3.12.2.1).   
 
 

4.2.2  Within the permit area, shadow area (if applicable), and their respective adjacent areas, assess and 
include a general description of the hydrogeologic characteristics such as: the vertical and lateral extent of 
the uppermost aquifer; the hydraulic conductivities of the uppermost aquifer and all other aquifers that may 
be impacted by the proposed mining operation; the direction and rate* of groundwater flow; structural 
characteristics and distribution of underlying strata including bedrock; chemical and physical properties 
including, but not limited to, lithology, mineralogy, and hydraulic characteristics of underlying strata 
including those below the uppermost aquifer. Methods to accumulate this information may include, but are 
not limited to literature, borehole logs, geophysical methods, aerial photography and test pits. 
[1780.21(b)/1784.14(b);1770.25/1783.25] 
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*NOTE: The rate of groundwater flow may be determined via pump tests or based on an estimation using 
the calculated hydraulic conductivity.  

Prior to the Phase 1 construction of the refuse impoundment, thirty borings were advanced within the 
permit area for subsurface characterization (Attachment 4.2.2.1).  The surficial unconsolidated layer ranges 
from 18.5 to 49.0 feet thick (mean: 27.8 feet thick), and is composed primarily of Quaternary clay and 
alluvium. The Quaternary clay consists of silty clay layer ranging from 4 to 15 feet thick (mean: 8.5 feet 
thick) underlain by a sandy clay ranging from 8 to 22 feet thick (mean: 16 feet thick). These strata 
generally exhibit low permeability and produce low groundwater yields. Measured conductivities for 
monitoring wells GWM-8, GWM-10, W3-11, W3-12, W3-13, and W3-16  ranged from  1.76×10-4 to 
8.31×10-6 cm/sec (arithmetic mean: 5.95×10-5 cm/sec). Because of low permeability and poor recharge, 
yield from local surficial strata is generally insufficient to meet contemporary residential consumption 
requirements. Unconsolidated sandy material is reported in the southern portion of the permit area in 
borings B-20, B-20A, B-21, and B-22 (Map 4SF, Attachment 4.2.2.2). The horizontally and vertically 
discontinuous sand lenses range in thickness from 2.5 to 12.5 feet thick (median: 3.5 feet thick). Boring 13 
in the central portion of the permit area also contained an interval of clayey sand with a thickness of 2.5 
feet.  Again, the absence of this material in surrounding borings demonstrate that this is laterally isolated.  
Similar to previous boring investigations (ILDNR-OMM Permit 416) in the region, all other borings drilled 
in the proposed permit area record no presence of sand further demonstrating that the specified bodies are 
limited in aerial extent and likely hydraulically isolated. Based on the limited nature of these sand bodies 
the applicant considers their presence to be of no consequence regarding mining activities proposed herein.  
 
Groundwater flow direction within the unconsolidated zone near the permit area should mirror topographic 
drainage.  There are two main drainages near this mine site, the Mary’s River drainage is to the south of the 
mine and the Plum Creek drainage is to the west of the mine.  The Gateway Mine surface facility lies on 
the divide between these two drainages with the proposed permit area located solely within the Plum Creek 
watershed.  The water table onsite is shallow with the static water level generally less than 10 feet below 
ground surface. Groundwater flow within the proposed permit area is to the west-northwest towards Plum 
Creek (see Attachment 4.2.2.3). 

Drillholes for underlying consolidated materials include DH-1, DH-2, DH-21, DH-CELL5, and 16892C 
(Attachment 4.2.2.1).  As is shown in the drillholes, there are no extensive sandstone intervals within these 
holes, exhibiting a maximum sandstone thickness of 10 feet.  This is consistent with literature of the area 
indicating that the Pennsylvanian bedrock typically exhibits poor aquifer potential.  Field studies (Martin, 
et al, 1990) indicate that permeability of Pennsylvanian strata in the Illinois Basin averages about 10-6 
cm/sec. Because of low permeability and poor recharge, yield from local bedrock aquifers is generally 
insufficient to meet average residential consumption requirements. In general, dissolved solids in 
groundwater of the Illinois Basin increase with depth and freshwater is generally found at depths of 300 
feet or less (USGS 82-858; Cartwright and Hunt, 1978). The presence of public water supply providers, 
which source their water from surface water bodies, in the area indicates that local bedrock groundwater 
resources are unable to fulfill average residential demands. Drill hole boring logs and a generalized 
geologic column are provided in Attachment 4.2.2.1. 

 

4.2.3  Within the permit area, shadow area (if applicable), and their respective adjacent areas, identify 
unusual or unpredicted geologic features, where present, including: fault zones, fracture traces, facies 
changes, solution channels, buried stream deposits, cross cutting structures and other geologic features that 
may affect the ability of the operator to monitor the groundwater or predict the impact of the facility on 
groundwater.  [1780.21/1784.14; 1780.22(b)/1784.14(b); 1779.25/1783.25] 

There are no unusual or unpredicted geologic features within the permit area or adjacent areas that would 
affect the ability to adequately monitor groundwater for potential impacts.   
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4.3  Area Specific Characteristics. 

4.3.1  Provide a description of the areal and structural geology of the permit area, shadow area (if 
applicable), and their respective adjacent areas for the deeper of either the stratum immediately below the 
lowest coal seam to be mined, or any aquifer below the lowest coal seam to be mined which may be 
adversely impacted by mining.  Provide logs showing the lithologic characteristics including physical 
properties and thickness of each stratum and the location of groundwater that could potentially be affected 
if encountered.  Provide location and elevations of test borings or core samplings on the Hydrogeologic 
Map. [1780.22(b)(1) & (b)(2)(A)/1784.22(b)(1) & (b)(2)(A)] 

Lithologic logs must be detailed enough to determine the physical characteristics of both the 
unconsolidated and consolidated materials present. 

Provide a minimum of two geologic cross-sections, perpendicular to each other, for the proposed permit 
area and a minimum of two geologic cross-sections, perpendicular to each other, for the proposed shadow 
area, if applicable. [1779.25/1783.25] 

At a minimum, the cross-sections should depict any water-bearing zones/formations, any local and/or 
regional aquifers, any impermeable zones/formations, and both the unconsolidated and consolidated 
formations. The core logs shall clearly identify and name the coal seams (both intended to be mined, 
unmined and spoiled). [1779.25/1783/25] 

The permit application is for expansion of an existing refuse disposal facility and does not permit coal 
extraction within the permit area.  The description of geologic characteristics is being limited to the 
unconsolidated and shallow consolidated materials within the permit and adjacent areas.  Boreholes 
collected beneath the Cell 5 refuse area show that the area is dominated by fine grained sediments, 
primarily clay, intermixed with silty and sandy materials.  The generalized composition of the 
unconsolidated sediments below Cell 5 consisted of an uppermost layer of silty clay underlain by a layer of 
sandy clay.  There were isolated pockets of clayey and silty sand identified, but these were found to be 
limited in both thickness and lateral extent.  The permeability testing completed on the soil borings had a 
range from 7.60×10-9 cm/sec to 8.10×10-8 cm/sec with an arithmetic mean of 3.22×10-8 cm/sec.   Design 
specifications included construction of a 4 feet thick liner compacted to a maximum permeability of 10-7 
cm/sec.  Pre-construction soil boring logs are provided in Attachment 4.2.2.1.  The location of the geologic 
cross sections of the pre-construction unconsolidated materials are provided on Map 4SF.  The geologic 
cross sections of the unconsolidated material previously approved in permit 426 are provided in attachment 
4.2.2.2.   

As shown in the geologic cross sections, Cell 5 is underlain by shale.  The shale surface is undulating, 
dipping to the southeast in the southern portion of the permit area, to the northeast in the central portion, 
and to the northwest in the northern portion.  The shale bed is nearly flat, with a strike of N 58.02° W and a 
dip of 0.5° N in the center of the permit area.  The shale is approximately 78 feet thick and is underlain by 
another 30 feet of claystone prior to encountering the Piasa Limestone at a depth of 144 feet, based on the 
drill log of DHCELL5.  Thick shale beds make up the majority of the Modesto formation (Willman et al 
1975).  This shale bed acts as an aquiclude and provides further protection from the potential downward 
migration of seepage from the overlying compacted liner and refuse contained in Cell 5.   
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4.3.2  Within the permit area and its adjacent area, characterize potential pathways for contaminant 
migration below and around sediment ponds, disposal areas, coal storage piles and connecting ditches by 
identifying zones of potentially high hydraulic conductivity using correlation of stratigraphic units between 
borings; where applicable, information on geologic materials sorting, grain size distribution, cementation, 
hydraulic conductivity and the presence or absence of any confining layers shall be discussed. 
[1780.21(c)(d)(e) & (f)/1784.14(c)(d) & (e)] 

Sedimentation basins 011 cell A, cell B, and 012, as well as the surface water control structures that contain 
runoff from the outslopes of Cell 5, were constructed with a compacted clay liner.  The clay liner was 
constructed in four separate lifts of compacted clay, each 1 foot thick.  Based on the soil borings underlying 
Cell 5 and the drillholes of the surrounding area, there are no known zones of high hydraulic conductivity 
in the permit or adjacent areas.  The unconsolidated material is dominated by clay material and the 
underlying bedrock consists of a thick bed of shale, both of which exhibit low hydraulic conductivity and 
will prevent migration of groundwater offsite.    

 

4.3.3   Provide chemical analyses of all strata, including the coal seam(s) (both intended to be mined, 
undisturbed or spoiled) through either the strata immediately below the lowest coal seam to be mined or 
any aquifer below the lowest coal seam to be mined which may be adversely impacted by mining.  The 
analyses shall identify those strata that may contain acid or toxic-forming or alkalinity-producing materials 
and determine their content and the net-neutralization potential on a weighted basis. [1780.22(b)(2)(B) & 
(c)/1784.22(b)(2)(B) & (c)] 

For carbon recovery operations, total sulfur and pyritic sulfur analyses must be performed on the materials 
to be recovered.  

For waste disposal operations, chemical analysis of the fine and coarse refuse waste streams shall be 
provided, including the identification of acid or toxic-forming or alkalinity-producing materials and 
determine the content and the net-neutralization potential on a weighted basis. 

This permit application is for construction and operation of a coal refuse disposal structure and does not 
include mining of coal within the proposed permit area. The impoundment will receive refuse from the 
Gateway preparation facility. The net neutralization analytical results for overburden core GWN-04E, 
drilled for the Gateway North Mine (Permit 416), are provided in Attachment 4.3.3.1 and the boring log 
can be found in Attachment 4.2.2.1. The core penetrates the interval from the ground surface to below the 
coal seam for extraction (Coal-6). The total sulfur, pyritic sulfur, acid generating potential and 
neutralization potential is provided in Table 4.3.3.1 below for the Coal-6 as well as the roof and floor 
material. Of those three units, only the coal seam was identified as potentially toxic (<-5.0 TKT/CaCO3).  
 
TABLE 4.3.3.1: CHEMICAL ANALYSIS OF COAL AND SURROUNDING STRATUM 
 

GWN-04E 

Description 
Top 

Depth 
(ft) 

Bot. 
Depth 

(ft) 
Thick. 

(ft) 

Tons CaCO3 Equiv. Per 1000 tons Material 

NNP = NP - AP 

Potential Acidity 
(AP) 

Neutralization 
Potential 

(NP) 

Net 
Neutralization 

Potential 
(NNP) 

shale 289.8 292.5 2.7 35.31 481.34 446.03 
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Coal-6 292.5 299.3 6.8 15 15.47 0.47 

underclay 299.3 300.9 1.6 63.44 99.19 35.75 

 
The refuse disposal operation consists of fine refuse disposal within a compacted outer berm.  The chemical 
analyses of the fine refuse and coarse refuse are provided in Table 4.3.3.2 below and the laboratory results 
are included in Attachment 4.3.3.2.  The fine refuse shows a slightly negative net neutralization potential.  
The coarse refuse has higher potential acidity and lower neutralization.  However, the construction of the 
outer embankment includes compaction of the material in accordance with permit requirements, which 
prevents infiltration and subsequent leaching following precipitation events.   
 
TABLE 4.3.3.2: CHEMICAL ANALYSIS OF REFUSE 
 

Description Paste 
pH 

Total 
Sulfur 

% 

Total 
Pyrite 

% 

Tons CaCO3 Equiv. Per 1000 tons Material 
NNP = NP - AP 

AP NP NNP 
Fine Refuse 7.8 2.44 1.23 38.44 32.81 -5.63 
Coarse 
Refuse GP1 2.2  2.04 63.75 -10.74 -74.49 
Coarse 
Refuse GP2 6.1  6.70 209.38 17.62 -191.70 
Coarse 
Refuse GP3 6.4  5.60 175.00 30.92 -144.00 
Coarse 
Refuse GP4 2.5  2.34 73.13 -13.67 -26.80 
Coarse 
Refuse GP5 2.0  1.92 60.00 -29.51 -89.51 
Coarse 
Refuse GP6 7.0  4.46 139.38 34.51 -104.80 
Coarse 
Refuse GP7 6.7  4.67 145.94 25.66 -120.20 
Coarse 
Refuse GP8 6.5  5.09 159.06 56.65 -102.40 
Coarse 
Refuse GP9 6.6  4.55 142.19 23.56 -118.60 

 
 

4.3.4   Provide coal seam(s) name and number and an analysis of the coal seam(s) as to total sulfur and 
pyritic sulfur.  Show all coal crop lines (where applicable) and the strike and dip of the coal to be mined on 
the Hydrogeologic Map. [1780.22(b)(2)/1784.22(b)(2) & (b)(3); 1779.25(a)(3) & (a)(4)/1783.25(a)(3) & 
(a)(4)] 

This permit application is for construction and operation of a coal refuse disposal structure and does not 
include mining of coal within the proposed permit area.  Therefore, the coal seam crop lines and strike / dip 
are not shown on Map 4SF.  The coal seam chemical analysis is provided in Table 4.3.4 below and the 
laboratory report is provided in Attachment 4.3.3.1. 
 
TABLE 4.3.4: CHEMICAL ANALYSIS OF COAL SEAM SULFUR CONTENT 
 

Description Top Depth (ft) Bot. Depth(ft) Paste 
pH 

Total 
Sulfur 

% 

Total 
Pyrite 

% 

Coal-6 292.5 299.3 7.0 2.89 0.48 
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4.3.5  Identify the general land uses of the watersheds upstream of the proposed permit area and any 
potential pollution sources which could significantly affect the surface and groundwater quality at the 
proposed permit area. If none exist, note here.  [1780.21(i)(1)/1784.14(h)(1)] 

The permit area is at the headwaters of the Plum Creek watershed.  There is no upgradient drainage that 
will impact surface water quality within the permit boundary.  The groundwater potentiometric surface 
indicates that groundwater flow is to the west-northwest towards the Plum Creek drainage.   

The land use upgradient of the refuse cells is predominantly agricultural.  The use of agricultural fertilizers 
and pesticides is a potential pollutant source for shallow groundwater.  The primary components of 
fertilizer are nitrogen, phosphorus, and potassium.  However, there are several other secondary components 
of fertilizer that may manifest in surface water or groundwater.  For example, potassium is typically applied 
as potash, which is composed of potassium sulfate, potassium chloride, or potassium nitrate.  These 
secondary components of sulfate, chloride, and nitrate would also become mobilized upon dissolution of 
the potash material.   

There is also a paved road that bounds the northern, western, and southern boundaries of Cell 5.  The use of 
deicing agents on paved roads during winter months can potentially affect shallow groundwater quality.  
Deicing agents typically consist of salts that are highly mobile in surface water and groundwater.  Effects 
of road salt usage would be observed by an increase in chloride concentrations, which is a key component 
in typical road salt, as well as an associated cation (typically sodium).   

Lastly, the Spartan Mine refuse disposal area lies immediately to the south of Cell 5.  This is another 
potential source of pollutants for the shallow groundwater in this area.  Evidence of pollution from the 
Spartan Mine refuse area would primarily be in the form of increased sulfate, chloride, and resultant TDS 
concentrations.  There are no other potential pollutant sources identified in the vicinity of Cell 5 at this 
time.   

 

4.3.6  Do surface or groundwater discharges into underground mines exist? [1780.21(b)/1784.14(b)] 

  YES    NO 

 If YES, locate on the Public Water Supply Map and discuss here. 

 

4.3.7  Do Public Water Supply intakes for current users of surface water flowing into, out of, and/or within 
ten miles of the proposed permit area exist? [1779.24(g)/1783.24(g); 1780.21/1784.14] 

NOTE: Public Water Supply intakes include groundwater wells. 

  YES    NO 

If YES, complete Table 4.3.7; locate on the Public Water Supply Map; discuss the possible effects that the 
mining operation will have on the public water supplies and explain what precautions will be taken to 
prevent an adverse impact from occurring. [1780.21(h)/1784.14(h)]. 
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See Table 4.3.7 for a listing of public water supply intakes within ten miles of the proposed permit area.  
Runoff from the proposed operations area, which will include the out-slope embankments only, will be routed 
through NPDES basins and will be subject to permit limitations.  Process water from inside the embankments 
will be routed through the preparation plant which is a closed circuit and discharge of the water will be 
minimized to the extent practicable. The out-slope embankments will be vegetated to reduce sheet flow runoff 
and suspended solids. The effluent testing requirements for the NPDES permit are more stringent than the 
federal limits for coal mining and should be sufficient to address potential problems and reduce the likelihood 
of adverse impact to public water resources. The installation and maintenance of surface and groundwater 
monitoring points will provide sufficient information that will alert the applicant to potential adverse impact in 
a timely manner. Construction of sediment control structures that are required to meet NPDES quality limits 
will reduce potential for offsite adverse impacts.  Surface runoff from the affected areas will be routed through 
sediment basins with a minimum 10-hour detention time. 
 
PROTECTIVE MEASURES TO ADDRESS ACTIVITIES IN THE SURFACE EFFECTS AREA 
 
Measures to be taken to assure the protection of the quality of surface and groundwater systems from potential 
surface effects of the activities proposed within this application include: 
 

1. Where warranted, construction of professionally designed sediment control structures, including 
sediment basins, overland flow diversion ditches, temporary terracing, straw dikes or rip-rap filters to 
control flow and routing of surface water originating from the surface effects area. 

 
2. Chemical treatment where necessary, of water leaving sediment basins and entering state waters. 

This water will meet all the applicable performance standards. 
 

3. Through final bond release, periodic monitoring of water exiting the surface effects area. 
 

4. A compacted clay liner (1x10-7 cm/s permeability) was constructed beneath the refuse cell 
embankment and interior, beneath the sediment basins, and constructed drainage ditches receiving 
refuse contact water.  Existing clay subsoil was suitable for use as liner material and was compacted 
to 95% standard Proctor dry density (See Permit 426 Attachment IV.6.MSHA Appendix B).  The 
original Construction specifications and quality assurance procedures are also included in the 
previous MSHA application. 

 
No adverse effects associated with the mining operation were identified in the preceding sections on either 
surface water or groundwater quantity and quality. All of the measures detailed above will also act to 
safeguard the surface water and groundwater systems.  It is concluded that the site will have a negligible 
impact on the adjacent surface water and groundwater systems.   
 
 

4.4  Groundwater Information. 

4.4.1  On the Hydrogeologic Map, provide the location and ownership of existing wells, including private 
water supplies and private water wells within ½ mile of the proposed permit area and shadow area (for 
mines with underground extraction), springs, and other groundwater resources in or within ½ mile of the 
proposed permit area, shadow area (if applicable), and their respective adjacent areas. If any of the existing 
wells are to be employed for monitoring, designate on Hydrogeologic Map and complete Table 4.4.2. 
[1780.21(b)(1)/1784.14(b)(1); 1780.21(h)/1784.14(g)] 

4.4.1.1  Provide results of a Groundwater User’s Survey which includes, well identification, 
location relative to permit, shadow and/or adjacent areas, construction details, water bearing strata 
well is screened in, total depth, usage and public water availability in Table 4.4.1.   
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The groundwater users survey was completed for Permits 426, 225, 160, and 53.  Since this 
application does not expand these permit areas, the previously completed surveys are still valid.  The 
results of the most recent survey (Permit 426) are summarized in Table 4.4.1. 

4.4.1.2 Provide a discussion of the Groundwater User’s Survey, discussing the existing and 
potential use of the water-bearing strata identified in 4.4.1.1 above. This information and the 
information required by Part 4.4.1.1 above shall be cross-referenced with the information depicted 
on the map required in Part 4.4.1 above.  

The applicant submitted a groundwater user’s survey to all land owners identified as owning 
property within ½ mile of Permits 426, 225, 160, and 53. The most recent Groundwater Users 
Survey identified a single residence utilizing groundwater within ½ mile of the permit boundary 
(Table 4.4.1). Three wells (GW100, GW101, and GW103), all screened within the unconsolidated 
material, are known to be present on property tract 1091 from previous interactions with the resident, 
however only one well (GW100) was reported as being on the property and in use by the resident on 
the groundwater survey (Map 4). The well is used for potable water supply and the applicant was not 
given permission to sample it. No springs were identified within ½ mile of the permit boundary. 
Additional information about the presence or lack thereof, of residential wells within ½ mile of the 
permit boundary is provided in Table 4.4.1. No commercial or municipal groundwater resources are 
present within the vicinity of the permit. The local municipal water supply districts all obtain water 
from surface sources (see Part 4.3.7). 
 
The applicant also researched the “Illinois Geological Survey’s Water and Related Wells in Illinois” 
website for wells within and adjacent to the proposed permit area.  Three wells were identified as 
being present within ½ mile of the permit area on the “Illinois Geological Survey’s Water and 
Related Wells in Illinois” website. All three of the wells were identified as being located on 
applicant-controlled property. One was identified as being present beneath the levee of one of the 
existing Gateway Refuse impoundments and the other two were identified as being associated 
with former residences that have since been vacated and knocked down. Therefore, none of the 
ILGS wells are displayed on Map 4. Additional information for the ILGS wells, including the 
property tracts the wells were identified on, the well ID’s and their total depths, is included in Table 
4.4.1 Water User’s Survey. 

4.4.1.3  Provide a discussion for any groundwater users downgradient, as determined through 
groundwater elevation, of the proposed permit area that details factors and protective measures in 
place to ensure these groundwater resources are not adversely impacted. 

The domestic well that was reported to be in use (GW100) is located 500 feet to the northeast of 
the Permit 426 boundary.  Groundwater monitoring well W3-11 is located approximately 800 feet 
to the southwest of GW100, well GWM-8R is located approximately 380 feet to the south, and 
well W3-07, which is associated with Permit 225, is located approximately 1020 feet to the north-
northeast.  These wells will be monitored according to the groundwater monitoring plan detailed 
in Part 4.5.  The groundwater monitoring schedule and parameter list is sufficient to identify any 
potential impacts to groundwater quality prior to the impacted water migrating offsite and 
reaching the well GW100. 
 
Numerous measures have been taken to ensure that Cell 5 and associated surface water control 
structures were constructed to ensure that the potential for environmental impacts has been 
minimized.  The compacted liner and cap for these features prevents downward migration of 
pollutants to the shallow groundwater.  The unconsolidated material is also low permeability 
minimizing the potential for advective transport of pollutants in the groundwater.     
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4.4.2  Provide a description of seasonal groundwater quality, including the following constituents (at a 
minimum), for each source of groundwater in the identified areas: 

For Surface Mining: Within the permit area and its adjacent area: pH, total dissolved solids, 
hardness, alkalinity, acidity, sulfate, total and dissolved iron, total and dissolved manganese, and 
chloride.  Please provide in Table 4.4.2.   [1780.21(b)(1)A)]  

 

For Underground Mining:  Within the permit area and its adjacent area: pH, total dissolved 
solids, hardness, alkalinity, acidity, sulfate, total and dissolved iron, total and dissolved 
manganese, and chloride.  Please provide in Table 4.4.2. [1784.14(b)(1)(A)(i)] 

For an underground mine, within the shadow area (if applicable) and its adjacent area: pH, total 
dissolved solids, total iron, and total manganese. [1784.14(b)(1)(A)(ii)] 

Groundwater quality in shallow unconsolidated aquifers often displays seasonal fluctuations in the 
concentration of dissolved ions.  Dissolved ions result from the dissolution of minerals contained 
in the unconsolidated sediments.  The resulting concentration is dependent on a number of factors, 
including pH, oxidation reduction potential, and groundwater temperature.  The concentration can 
also be highly influenced by the recharge rate of the aquifer, which has a relatively consistent 
pattern in this region.  Greater precipitation in the late winter and spring months leads to higher 
recharge and infiltration rates and increases in groundwater velocity.  This provides dilution to 
shallow groundwater aquifers and decreases the overall residence time of the aquifer, both of 
which result in lower concentrations of dissolved species.  During the summer and fall months, the 
evapotranspiration rate exceeds the precipitation, resulting in a net loss of water contained in the 
vadose zone and leading to an increase in dissolved ion concentration in shallow groundwater.  

Water level elevations in the unconsolidated wells peak annually in the first and second quarter 
and decline across third and fourth quarters, which is consistent with the regional precipitation 
patterns.  The concentration of dissolved ions are expected to be inversely proportional to this 
seasonal water level trend, with decreased concentrations in the spring and increased 
concentrations during the fall.  However, these predictable patterns in groundwater elevation and 
dissolved ion concentration ignore the complex geochemistry of groundwater systems.  Seasonal 
groundwater quality results are provided in Table 4.4.2.  The unconsolidated wells at this facility 
do not exhibit consistent seasonality in dissolved ion concentrations.  For example, the historical 
record of total dissolved solids at Well W3-11 typically shows annual maximum in January and 
February, annual maximums at Well W3-12 are observed in June, July, and August, and Well W3-
13 does not show clearly defined annual fluctuations.   

Groundwater quality statistics are provided in Attachment 4.4.2.1, which shows the overall range 
in concentration as well as the long-term averages.  The monitoring wells associated with Cell 5 
have a neutral to slightly alkaline pH and alkalinity concentrations that greatly exceed the potential 
acidity.  Total dissolved solids concentrations in actively monitored wells range from 156 mg/L to 
1,310 mg/L and the elevated hardness concentrations are indicative of waters high in dissolved 
calcium and magnesium.  Metals concentrations are consistently low, with dissolved iron and 
manganese concentrations averaging below 1 mg/L.  Total concentrations are somewhat elevated, 
although this is likely a result of suspended sediments contained in the water sample.  Wells 
screened in glacial unconsolidated material are often susceptible to transport of clay and silt 
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through the well screen during purging.  Seasonal concentrations within the unconsolidated wells 
associated with Cell 5 are typical of shallow groundwater in this region.   

Nearby residential well water quality was compiled for a groundwater quality investigation 
requested by Illinois Environmental protection Agency.  The wells showed numerous exceedances 
of the Class I and Class II groundwater standards in background and pre-mining data.  In 
particular, total dissolved solids concentrations ranged up to 3,271 mg/L and sulfate 
concentrations reached 1,510 mg/L.  Iron and manganese concentrations also exceeded standards 
showing concentrations up to 23.60 mg/L and 3.14 mg/L, respectively. Lastly, pH was below the 
allowable minimum level at one well with a reading of 6.11 standard units.  Results from these 
residential wells are shown in Attachment 4.4.2.2.  

 

4.4.3  Provide a description of seasonal groundwater quantity in the proposed permit, shadow and adjacent 
areas,  including, at a minimum: 

4.4.3.1  the appropriate rates of discharge or usage; 

4.4.3.2  the elevation of the potentiometric surface of the coal to be mined; 

4.4.3.3  the elevation of the potentiometric surface in each water-bearing stratum above the coal to 
be mined AND in each water-bearing stratum below the coal to be mined which may be 
potentially impacted. At a minimum, a potentiometric map must be provided for the uppermost 
aquifer, and any aquifer which may be potentially impacted by the proposed operation(s). 

A general description may be given for water bearing strata with no collected data. If no known water-
bearing strata that could be impacted, exist above or below the coal seam to be mined or if the coal seam is 
not water-bearing, state as such.  [1780.21(b)(1)(B)/1784.14(b)(1)(B)]   

As previously discussed, the yield of bedrock and unconsolidated materials in this area are minimal.  The 
high clay content of the unconsolidated material typically prevents its use as a residential water supply.  
The unconsolidated aquifer in this area does not meet the Class I potable resource groundwater criteria, 
which is defined as groundwater 10 feet or more below the surface and within 1) the minimum setback 
zone of a well serving as a potable water supply, 2) unconsolidated sand or gravel 5 feet or more in 
thickness, 3) sandstone which is 10 feet or more in thickness or fractured carbonate with is 15 feet or more 
in thickness, or 4) any geologic material with sustained groundwater yield of 150 gallons per day (from a 
12-inch borehole) or with a hydraulic conductivity of 10-4 cm/sec.  With regard to requirement 1, Part 4.4.2 
shows that there are existing residential wells that indicate the unconsolidated aquifer in this region often 
exceeds Class I standards and is unsuitable for a potable water supply.  With regard to requirement 2, the 
soil borings that were collected prior to Cell 5 Phase 1 construction showed the unconsolidated material is 
primarily clay, with only one boring (B-20) with a sand lens greater than 5 feet thick identified within the 
permit area.  Surrounding borings, including B-20A which was drilled immediately west indicate that the 
sand was laterally and vertically isolated.  With regard to requirement 3, well logs within this area indicate 
the underlying bedrock is primarily low permeability shales and cemented sandstone, with only minor 
intervals of limestone, resulting in insufficient well yield for residential purposes.  There are no known 
underlying bedrock strata that meet the Class I standards.  As a result, the majority of residents rely upon 
the local municipal water supply.  Lastly, with regard to requirement 4, Part 4.5.4 shows that the average 
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hydraulic conductivity of the shallow wells onsite is 5.95×10-5 cm/s and is not sufficiently permeable for 
the Class I criteria.       

The groundwater table within the unconsolidated material is typically very shallow, ranging from 2 - 6 feet 
below the surface at these well locations.  The wells surrounding the surface effects area demonstrate a 
seasonal fluctuation, with a higher water table during winter months and lower water table during the 
summer months.  This is a typical of shallow groundwater in this area, reflecting the higher precipitation 
during winter months and higher evaporation during summer months.  Water level elevation statistics for 
the water year were compiled and are presented in Attachment 4.4.3.3.1.  The majority of wells show 
approximately 2-3 feet of seasonal fluctuation.  Over the previous ten years, well W3-12 has shows the 
highest seasonal fluctuations, averaging 4.87 feet each year, while well W3-15 shows the lowest seasonal 
fluctuations, averaging 2.10 feet each year.  In the 2020 water year, Well W3-08R had the highest seasonal 
fluctuation of 4.3 feet.  The magnitude of annual fluctuations is influenced by many factors, including the 
permeability of the shallow unconsolidated materials, the seasonal climatic patterns, and depth to the static 
water level.  The shallow groundwater table in this area makes it more likely that the seasonal climate will 
have a greater influence on the water table.  Water contained with the vadose zone and shallow saturated 
zone will respond to prolonged periods of net evapotranspiration through a loss of soil moisture and a 
lowering in the water table.  Additionally, the relatively thin unsaturated zone allows percolation from 
individual precipitation events to reach the water table and raise the water table elevation.         

Baseline studies for Permit 426 indicated that the water level elevation ranged from 501.8 to 523.21 feet 
AMSL and the groundwater flow direction was primarily to the west-northwest towards Plum Creek.  The 
2020 water year showed a maximum water level of 531 feet MSL at well W3-16, located at the 
northeastern corner of the facility, and a minimum water level of 488 feet MSL at well W3-11, located in 
the northwest corner of the property.  The 2020 water year water levels are still consistent with the baseline 
groundwater flow direction (See Attachment 4.4.3.3.2 Potentiometric Surface Map).  

 

4.5  Groundwater Monitoring Program. [1780.21(i)/1784.14(h)] 

4.5.1.  Describe in detail a proposed monitoring plan based upon the PHC that will measure the amount and 
duration of any changes to the groundwater system resulting from the mining operation. 

The proposed groundwater monitoring plan shall describe how the collected groundwater monitoring data 
will be used to determine if impacts are occurring and what steps will be taken by the operator. 

Provide a Sampling and Analysis Plan (SAP) that includes the methods/steps of well sampling, well 
analysis and data reporting as an attachment to this application part. 

Parameters to be monitored are given in Table 4.5.1 Monitoring shall be on a quarterly basis unless 
otherwise approved by the Department, with reports due within one month of the end of each quarter as 
follows: 

 Scheduled Period From – To Report Due 
 1st Quarter Jan. 1 – Mar. 31 May 1 
 2nd Quarter Apr. 1 – Jun. 30 Aug 1 
 3rd Quarter Jul. 1 – Sept. 30 Nov 1 

 4th Quarter Oct. 1 – Dec. 31 Feb 1 
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Where approved, annual monitoring shall be conducted during the 2nd quarter only; semi-annual monitoring 
shall occur during the 2nd and 4th quarters only.   

NOTE: At a minimum, background data collection shall occur on a bi-monthly (every two months) basis 
over the course of one year (12 consecutive months). Groundwater monitoring shall continue throughout 
the permitting process at the same frequency at which background data collection occurred. 

Monitoring wells W3-08R, W3-11, W3-12, W3-13, W3-14, W3-15, and W3-16, were installed through the 
base of the unconsolidated layer into the upper weathered bedrock interval.  Most of these wells are located 
along the immediate boundaries of Permit 426: well W3-13 south-east, W3-15 south-west, W3-12 west-
central, W3-14 north-west, W3-11 north-east.  Additionally, well W3-08R is located 370 east of the 
northeastern corner of Permit 426 and well W3-16 is located at the northeastern corner of Cell 3, Permit 
225, approximately 4,200 feet from Permit 426.  Supplemental baseline groundwater data was also 
collected at monitoring wells GWM-8/W3-08 and GWM-10/W3-10, which were associated with Gateway 
Mine Permit 225. Both GWM-8/W3-08 and GWM-10/W3-10 were plugged and abandoned to enable 
construction of the embankment of Cell 5.  
 
The established monitoring network allows for the observation of any changes to the groundwater quality 
and quantity along the three exposed sides of the impoundment.  The groundwater monitoring network was 
designed to intercept any potential water migrating from the permit boundary and allow for the observation 
of any changes to the groundwater quantity and quality.   
 
Baseline groundwater quality samples were collected at monitoring wells W3-08R, W3-11, W3-12, W3-13, 
W3-14, W3-15, and W3-16.  Supplemental groundwater quality data from monitoring wells GWM-8/W3-
08 and GWM-10/W3-10, which were originally associated with Gateway Mine Permit 225, has also been 
provided.  Existing monitoring wells locations are shown on Map 4SF. All existing monitoring wells (W3-
08R, W3-11, W3-12, W3-13, W3-14, W3-15, W3-16) are screened across the unconsolidated material and 
upper weathered bedrock. Well construction details are provided in Table 4.5.2 and Attachment 4.2.2.1.  
Sample parameters collected during the baseline period included static water elevation, pH, Acidity, 
Alkalinity, Iron (total), Iron (dissolved), Manganese (total), Manganese (dissolved), Total Dissolved Solids, 
Hardness, Chloride, Sulfates, Aluminum, Antimony, Arsenic, Barium, Beryllium, Boron, Cadmium, 
Chromium, Cobalt, Copper, Cyanide, Fluoride, Lead, Mercury, Molybdenum, Phenols, Nickel, Selenium, 
Silver, Thallium, Vanadium and Zinc (See Table 4.5.1).  The aforementioned monitoring wells will 
continue to be monitored quarterly for the same parameters during mining.   
 
Groundwater samples will be collected by experienced personnel using standard industry practices. 
Sampling procedures will include taking a water level measurement prior to sampling, lowering a 
submersible pump or bailer into the well and then purging the well prior to sampling to ensure the sample 
collected is representative of the groundwater present in the water bearing strata. The samples will be 
collected into polyethylene containers, preservatives added as necessary, and placed into a cooler for 
transportation. Samples are either dropped off at the lab, shipped to the lab, or are picked up at Peabody’s 
office by the lab, and are processed and analyzed by methods approved and listed in 40 CFR Part 136.  
Additional detail regarding the groundwater Sampling and Analysis Plan (SAP) is provided in Attachment 
4.5.1.   
 
 

4.5.2  Provide a comprehensive list of ALL existing, proposed and plugged/destroyed/damaged 
groundwater monitoring wells for the entire facility. Complete Table 4.5.2. [1816.41(c)/1817.41(c)] 

Monitoring wells associated with the SAP are listed in Table 4.5.2. 
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4.5.3  Provide a detailed geologic boring log, well construction diagram and completion information for all 
existing groundwater monitoring wells and/or a diagram of each proposed well. All wells shall be surveyed 
(top of casing, ground elevation and location), shall have unique nomenclature and be clearly identified on 
the Hydrogeologic Map as existing, proposed, abandoned, etc. [1780.22(c)/1784.22(c)]  

NOTE: The Department has created a well construction diagram for use. See Operator Memorandum 2017-
01. 

When wells are no longer needed, the applicant shall request to properly plug and abandon the well. Upon 
receiving approval to drop the well from the Mine’s groundwater monitoring program, the well shall be 
sealed and the Department’s plugging affidavit shall be provided within sixty (60) of the date of approval.  

NOTE: See Operator Memorandum 2015-02. 

See Attachment 4.2.2.1 for the well construction diagram and geologic boring logs of wells GWM-8, 
GWM-10, W3-08R, W3-11, W3-12, W3-13, W3-14, W3-15, and W3-16. 
 
 

4.5.4  Provide the groundwater flow direction based upon the site-specific groundwater monitoring wells 
installed for this application. Hydraulic conductivity data shall be provided in its entirety, for each well. 
The field methodology of the aquifer testing shall be clearly explained (e.g., rising head vs. falling head 
slug testing; pump testing or constant-head testing). The results of the aquifer testing shall be included in 
this section and shall be discussed/explained, including any discrepant information. Groundwater flow 
direction may also be shown on the Potentiometric Map required in Part 4.4.3 above. 
[1780.21(b)(1)(B)/1784.14(b)(1)(B)]  

Slug tests are a method for determining hydraulic conductivity of the aquifer material in the immediate 
vicinity of the well bore.  The test involves adding or removing a known volume of water to a well bore 
and measuring the aquifer response, typically with a piezometer.  Slug tests were conducted on the wells 
installed around the perimeter of Cell 5 and results are shown in Table 4.5.4 below.  The slug tests were 
conducted under both “rising head” and “falling head” conditions.  In a rising head test, a known volume of 
water is evacuated from the well and the recovery or rising of the water table is measured.  In a falling head 
test, a known volume is added to (or displaced from) the well and the lowering or falling of the water table 
is measured.  The tests were analyzed using the Bouwer Rice Slug-Test Method, which was developed for 
application to unconfined aquifers.  The hydraulic head is plotted on a semilogarithmic axis as a function of 
time.  The hydraulic conductivity is determined by fitting a straight line to the early-time data.  Details of 
the slug test results are provided in Attachment 4.5.4.   

TABLE 4.5.4: MONITORING WELL SLUG TEST RESULTS 
 

Well Slug Test Type Solution Method Hydraulic Conductivity 
(cm/s) 

GWM-8 Rising Bouwer-Rice 1.76×10-4 

GWM-10 Rising Bouwer-Rice 2.17×10-5 

W3-11 Rising Bouwer-Rice 1.72×10-5 

W3-12 Rising Bouwer-Rice 8.31×10-6 

W3-13 Rising Bouwer-Rice 3.49×10-5 

W3-16 Falling Bouwer-Rice 9.97×10-5 

https://www.dnr.illinois.gov/mines/LRD/Documents/BrgCmltnRpt.pdf
https://www.dnr.illinois.gov/mines/LRD/Memorandum/Memo1701.pdf
https://www.dnr.illinois.gov/mines/LRD/Memorandum/Memo1701.pdf
https://www.dnr.illinois.gov/mines/LRD/Documents/PluggingAffidavit.2015.docx
https://www.dnr.illinois.gov/mines/LRD/Memorandum/Memo1502.pdf
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Rising Bouwer-Rice 9.80×10-5 

Average -- 9.89×10-5 

Overall Average     5.95×10-5 

 
 
 

4.5.5  Discuss any reported problems of maintenance with groundwater quantity and quality which have 
occurred at the private wells and springs identified in 4.4.1 above or in the installed groundwater 
monitoring wells noted in 4.5 above. [1780.21(h)/1784.14(g)] 

The protective casing on monitoring Well W3-12 was hit by a tractor sometime during the second quarter 
of 2013. Minor damage occurred to the protective casing and PVC stickup. Once fixed the wells top of 
casing was resurveyed in early June.  Table 4.5.2 notes both the surveyed TOC elevation before and after 
the well was damaged. 
 
 

4.5.6  Will this operation have any discharges to, or pump water from, abandoned underground mines? 

  YES    NO 

If YES, submit a detailed discussion of the quality and quantity of the extracted water and a detailed plan to 
discharge water into the abandoned mine workings. [1816.41(i)/1817/41(h)] 

 

4.6  Surface Water Information.  

4.6.1  Provide the name, location, ownership, and description of all surface water bodies, lakes, streams, 
impoundments, and springs within and adjacent to the proposed permit area(s).  The adjacent area shall be 
one-half mile from the proposed permit area. Provide the location of any discharge or drainage into any 
surface water bodies listed above on the Hydrogeologic Map. Complete Table 4.6.1. 
[1780.21(b)(2)/1784.14(b)(2); 1779.24(g)/1783.24(g); 1779.25(a)(7)/1783.25(a)(7)]  

The locations of all known surface water bodies are depicted on Map 4SF.  The proposed permit area is 
located in the headwaters of Plum Creek watershed and is drained by two unnamed tributaries to Plum 
Creek. Runoff from the northern half of the permit is conveyed to Plum Creek via an unnamed tributary, 
herein designated as the “North Tributary”, that converges with Plum Creek approximately 0.4 miles 
northwest of the permit area. Runoff from the outslopes of Cell 5 in the northern portion of Cell 5 will 
report to NPDES outfall 012, which discharges to the North Tributary.  Drainage from the southern half of 
the permit area reports to Plum Creek via a second unnamed tributary, herein designated as the “South 
Tributary”, that converges with Plum Creek further downstream, approximately 0.9 miles northwest of the 
permit boundary. Runoff from the Cell 5 outslopes in the southern portion of the permit area are routed 
through NPDES outfall 011 to the South Tributary.  Plum Creek flows to the west-southwest where it 
eventually joins the Kaskaskia River approximately 15 miles west of the permit boundary.  
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A total of 9 surface impoundments were identified within and adjacent to the proposed permit area (see 
Table 4.6.1 and Map 4SF). No springs were identified as being present within or adjacent to the permit area 
in the water user’s survey or during the Wetland and Stream delineation (Attachment 4.6.1). 

 

4.6.2  Provide for surface water bodies identified in 4.6.1. above, information on surface water quality and 
quantity sufficient to demonstrate seasonal variation and water usage. Surface water bodies that may be 
impacted by the proposed mining operation shall be clearly identified in the narrative and on the 
Hydrogeologic Map. Complete Table 4.6.2.  [1780.21(b)(2)/1784.14(b)(2)]  

 
RECEIVING STREAM HYDROLOGY SUMMARY  
 
The highest mean monthly stream flow in southern Illinois occurs from March through May, in response to 
spring rains. The highest peak flow occurs in July in response to thunderstorms. The proposed permit falls 
within the headwaters of Plum Creek watershed and is drained by two unnamed tributaries to Plum Creek. 
The North Tributary subwatershed is approximately 175.7 acres at surface water sampling location 16SW-
11.  The South Tributary subwatershed is approximately 213.3 acres at surface water sampling location 
16SW-12.  At the confluence of the South Tributary with Plum Creek, located approximately one mile 
downstream, the total watershed areas increase significantly to 1043.9 acres for Plum Creek and 338.8 
acres for the South Tributary.  These streams currently receive runoff from the outslopes of Cell 3 and Cell 
5.  The outslopes makeup only 12.0% of the South Tributary watershed and 5.8% of the North Tributary 
watershed.  At final reclamation, following capping and crowning of the refuse disposal area, this will 
increase to 14.7% of the North Tributary and 25.9% of the South Tributary.  The Plum Creek watershed, 
HUC 0714020407, totals 89.7 square miles.  The refuse disposal area makes up 0.2% of the Plum Creek 
watershed at the initiation of the proposed operations and will increase to 0.5% at final reclamation.     
 
Table 4.6.2.1 below summarizes the receiving stream hydrology characteristics at the initiation of the 
proposed operation. Estimates of 7-day, 10-year low flow (7Q10) for the receiving streams suggest flow is 
poorly sustained in the unnamed tributaries to Plum Creek, a result characteristic of streams with small 
drainage areas located in stream headwaters. Stream assessments conducted on the tributaries within the 
amendment area indicate that flow is generally intermittent in the North Tributary and ephemeral in the 
South Tributary (see Attachment 4.6.1). This is in agreement with the low discharge (0.0 – 1.0 ft3/sec) 
observed at the applicant stream monitoring sites (Table 4.6.2.2 and Table 4.6.3). The poorly sustained 
flow is attributed to the minimal presence of surficial aquifers and the low yields of water bearing 
sediments in the physiographic region.  
 
TABLE 4.6.2.1: STREAM WATERSHED & HYDROLOGIC CHARACTERISTICS   
 

Receiving 
Stream 

Hydrologic Characteristics 

Watershed 
Area* 

(ac.) 

Headwater 
Elev. 
(ft.) 

Outlet 
Elev. 
(ft.) 

Fall 
(ft.) 

Length 
(mi.) 

Gradient 
(ft./mi.) 

Qa
*** 

(CFS) 
7Q10

*** 
(CFS) 

Flow Class 

Plum Creek 57536 543 359 184 33 5.58 72.8 0.018 Perennial 
Unnamed Trib. 
to Plum Creek 

 

175.7 482 521 39 0.83 33.9 0.5 0.00 Intermittent**** 

Unnamed Trib. 
to Plum Creek 

 

213.3 471 543 72 1.35 53.3 0.5 0.00 Ephemeral**** 

CFS  : cubic feet per second 
* : Watershed measured from point of confluence with receiving stream (USGS StreamStats) 
** : Percent of current permit acreage within the receiving stream watershed 
*** : 7Q10 calculated from Fitzgerald et al., 1983 (USGS 82-858) 
**** : Flow class determined by Wetland Services utilizing Rosgen’s Stream Classification System for stream segments within 

the permit area.  See Attachment 4.6.1 
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TABLE 4.6.2.2: RECEIVING STREAM FLOW DATA 
 

Stream Name Monitoring Site Min. Flow (cfs) Max. Flow (cfs) 

North Tributary to Plum Creek  
(west permit boundary) 16SW-6 0.0 1.0 

North Tributary to Plum Creek  
(downstream of permit boundary) 16SW-11 0.0 0.5 

South Tributary to Plum Creek  
(west permit boundary) 16SW-8 0.0 0.70 

South Tributary to Plum Creek 
(west permit boundary) 21SW-9 0.0 0.4 

South Tributary to Plum Creek 
(west permit boundary)Creek 21SW-10 0.0 0.4 

South Tributary to Plum Creek 
(downstream of permit boundary) 16SW-12 0.0 0.9 

 
RECEIVING STREAM WATER QUALITY SUMMARY 
 
The surface water features within the permit and adjacent area are within the Kaskaskia watershed, which 
has surface water quality that can be highly variable. Surface water quality within this watershed is 
significantly influenced by natural processes such as seasonal climate patterns, including the magnitude, 
duration, and frequency of precipitation, seasonal growth and decomposition of vegetation and algae, 
freeze / thaw cycles, antecedent soil moisture, dissolution of minerals within soils and bedrock, 
groundwater quality and baseflow contributions, and many others.  There are also many anthropogenic 
influences within the Kaskaskia River watershed that contribute to water quality including agriculture, 
urban runoff, wastewater treatment plants, and industries such as oil and gas production and coal mining.  
USGS tabulated water quality from a number of sites, including sites both upstream and downstream of 
mining and oil and gas facilities as well as sites within the mainstem of the Kaskaskia River (Fitzgerald et 
al 1983).  Regional water quality ranges for several major ions are shown in Table 4.6.2.3, demonstrating 
the wide range of water quality that can be found within the Kaskaskia River Watershed.   
 
TABLE 4.6.2.3: REGIONAL SURFACE WATER QUALITY 
 

Parameter Minimum Maximum Mean 
pH 6.2 9.1 7.66 

TSS (mg/L) 7.00 1,490 -- 
TDS (mg/L) 37.7 5664 431 

Alkalinity (mg/L) 0.00 410 145 
Acidity (mg/L) 0.00 -7 -- 

Sulfates (mg/L) 12.00 3,500 
 

221 
Total Iron (mg/L) 0.00 54 2.5 

Total Manganese (mg/L) 0.01 6.4 0.49 
Chloride (mg/L) -- -- -- 

Mean Discharge (ft3/sec)1 6.05 3,689 696 
1: Gauging station drainage areas range from 8.05-5,181 (mi2) (mean: 833 mi2).  
 
Baseline water quality for the surface water bodies within the permit and adjacent area is presented in Table 
4.6.2.  Sites 15W-5 and 15W-6 are ponds / shallow wetlands located north of Cell 3.  These sites show an 
overall alkaline water with low dissolved solids content, typical of headwater streams.  The sites are 
somewhat elevated in total metals, but this is likely due to the iron and manganese contained in suspended 
sediments that is accounted for with the total and total recoverable analytic methods.  The metals contained 
in suspended sediments are part of the mineral framework of the soil and rock particles and are typically 
not bioavailable to aquatic life.  Site 21W-6, which is located on the northern side of the Spartan Mine also 
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demonstrated net alkaline water, although the pH was slightly depressed at 6.43 standard units.  Total 
dissolved standards and sulfate are slightly elevated above the regional mean values, likely the result of 
runoff from the Spartan Mine refuse pile.    
 
Table 4.6.3 summarizes seasonal ranges of water quality based on monitoring conducted by the applicant. 
Baseline samples at sites 16SW-6, 16SW-8, 21SW-9, and 21SW-10 were collected as part of the Permit 
426 application.  Sites 16SW-8, 21SW-9, and 21SW-10 are located in the uppermost headwaters of the 
South Tributary to Plum Creek and site 16SW-6 is located in the uppermost headwaters of the North 
Tributary to Plum Creek.  Due to the limited flow at these locations, these sites have been removed from 
the surface water sampling plan and are not actively monitored.  The sites typically exhibit low flows 
during the winter and early spring when groundwater levels and precipitation is high, but quickly show no 
flow beginning in late spring and extending through fall.  Water quality is net alkaline with alkalinity 
greatly exceeding acidity, and pH levels above neutral.  Mean dissolved solids at these sites ranges from 
543 mg/L to 315 mg/, comparable to the regional mean TDS.  Mean sulfate and chloride concentrations are 
low, displaying ranges of 38 – 166 mg/L and 28 – 64 mg/L respectively, and are in compliance with aquatic 
life water quality standards.  Suspended solids is low overall, averaging less than 24 mg/L at all sites, 
although individual sample events did show concentrations as high as 69 mg/L.  This is still far lower than 
the concentrations seen regionally, and likely underestimates potential concentrations of suspended 
sediment in this area that is dominated by row-crop agriculture.  Total iron concentrations are again slightly 
elevated averaging 2.11 mg/L across these sites, due to the naturally occurring metals contained in soil 
particles, while total manganese remains low, averaging 0.16 mg/L.  The alkaline nature of the water also 
indicates that these metals concentrations are not the result of acid generation and subsequent dissolution of 
metals from soils and unconsolidated sediments.     
 
Stream sampling sites 16SW-11 and 16SW-12 are located on the North and South Tributary to Plum Creek, 
respectively.  These sites were also monitored for baseline under Permit 426 but continue to be actively 
monitored under the current surface water monitoring plan.  The streams exhibit higher flows than the 
upstream sites, but still regularly have no flow during late summer and fall.  These sites also exhibit net 
alkaline water quality but display a a slightly higher TDS than the headwater stream sites and the regional 
average TDS presented above.  The ranges of mean sulfate and chloride concentrations are 176 – 219 mg/L 
and 37 – 134 mg/L, again in compliance with water quality standards for aquatic life.  Total suspended 
solids concentrations average 9 and 11 mg/L at 16SW-11 and 16SW-12, respectively, and are comparable 
to the regional minimum although concentrations of individual flow events have been as high as 73 and 37 
mg/L.  Total iron concentrations are similar to the baseline at the headwater sites, with average 
concentrations of 0.42 and 1.14 mg/L at sites 16SW-11 and 16SW-12 respectively, lower than the regional 
mean.  Manganese concentrations are low, in compliance with the general use and aquatic life water quality 
standards.    
 
Seasonal fluctuations in surface water quality and quantity occur primarily in response to seasonal 
variations in precipitation and in the ratio of runoff to base flow. Base flow generally exhibits greater 
mineralization; whereas increased runoff from precipitation will normally exhibit elevated suspended 
solids.  Similarly, dissolved solids concentrations are often inversely proportional to flow, with decreased 
dissolved solids concentrations in spring when precipitation runoff is high and increased dissolved solids 
concentrations in fall when evapotranspiration is dominant and water in ephemeral and intermittent streams 
is pooled or stagnant.  The quarterly sampling results of these stream sites does not exhibit clear seasonal 
fluctuations.  The quarterly data also does not show any prevalent long-term trends in TDS, Sulfate, or 
Chloride within the stream.  TSS and total metals concentrations are episodic, as a result of being driven by 
precipitation events and subsequent runoff.     
 
 

4.6.3  Surface Water Monitoring Program. [1780.21(j)/1784.14(i)]  

Describe in detail a proposed monitoring plan based upon the PHC that will measure the amount and 
duration of any changes to the surface water system resulting from the mining operation. Table 4.6.3.1 shall 
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be filled out with all current and proposed surface water monitoring points. For surface mines, upstream 
and downstream quality and quantity monitoring will be required throughout the life of the mine. 
Parameters to be monitored are given in Table 4.6.3.4 Surface water monitoring shall be on a quarterly 
basis with reports due within one month of the end of each quarter as follows: 

Scheduled Period From - To Report Due 
1st Quarter Jan. 1 – Mar. 31 May 1 
2nd Quarter Apr. 1 – Jun. 30 Aug 1 
3rd Quarter Jul. 1 – Sept. 30 Nov 1 
4th Quarter Oct. 1 – Dec. 31 Feb 1 

Provide a Sampling and Analysis Plan (SAP) that includes the methods/steps of in-stream sampling, data 
analysis and data reporting as an attachment to this application part. 

Where approved, annual monitoring shall be conducted during the 2nd quarter only; semi-annual monitoring 
shall occur during the 2nd and 4th quarters only. 

NOTE: At a minimum, background data collection shall occur on a bi-monthly (every two months) basis 
over the course of one year (12 consecutive months).  Surface water monitoring shall continue throughout 
the permitting process at the same frequency background data collection occurred. 

4.6.3.1  Water quality descriptions shall include, at a minimum, baseline information as follows 
[1780.21(b)(2)(A)/1784.14(b)(2)(A)]: 

pH, total dissolved solids, total suspended solids, alkalinity, acidity, sulfate, total iron, total 
manganese, and chloride.  Complete Table 4.6.3   

 
4.6.3.2  Water quantity description shall include base information on seasonal flow rates. 
[1780.21(b)(2)(B)/1784.14(b)(2)(B)] 

No surface water samples shall be collected from pooled (non-flowing) water. When no-flow 
conditions are observed, the applicant shall note the no-flow and include the “no-flow” notation on 
reports submitted to the Department. 

 

4.6.3.3  The proposed surface monitoring plan shall describe how the collected surface monitoring 
data will be used to determine if impacts are occurring and what steps will be taken by the 
operator. [1780.21(j)(2)/1784.14(i)(2)] 

 
4.6.3.4  At a minimum, surface water shall be sampled/analyzed for: pH, total dissolved solids, 
total suspended solids, alkalinity, acid, sulfate, iron, manganese and flow (cfs). 
[1780.21(j)/1784.14(i)] 

BASELINE MONITORING:  
 
Baseline surface water monitoring for the receiving streams was conducted as part of the Permit 
426 application.  In Permit 426, points were established in the two unnamed tributaries to the 
Plum Creek that drain the proposed permit area. Surface water monitoring point’s 16SW-6 and 
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16SW-11 are located in the North Tributary to Plum Creek, with 16SW-6 located along the 
western edge of the permit boundary and 16SW-11 located further downstream near the tributaries 
confluence with Plum Creek. 21SW-9, 21SW-10, 16SW-8, and 16SW-12 are located in the South 
Tributary to Plum Creek, with 21SW-9 and 21SW-10, and 16SW-8 located along the western 
boundary of the permit and 16SW-12 located further downstream (see Map 4). The surface water 
baseline monitoring network was designed to characterize the seasonal quality and quantity of 
existing streams in the vicinity of the permit area. Sites were selected to be representative of the 
same pre-mining land uses (primarily agricultural fields, farmsteads and residences and 
woodlands) that are located within the proposed permit boundary and that would be likely to 
exhibit flow, thereby documenting any seasonal variations. Note that due to the ephemeral nature 
of the South Tributary, and the finite number of flow events observed, sample points 21SW-9 and 
21SW-10 were dropped after approximately one year of sampling. The ephemeral nature of the 
two Tributaries is further evidenced by the limited number of flow events observed at downstream 
sample points 16SW-11 and 16SW-12.  Baseline parameters included discharge rate, pH, Acidity, 
Alkalinity, Iron (total), Manganese (total), Chloride, Sulfate, Total Dissolved Solids (TDS), and 
Total Suspended Solids (TSS). Analytical data for the surface water monitoring sites is provided 
in Table 4.6.3.  
 
DURING MINING AND RECLAMATION MONITORING:  
 
Surface water monitoring point’s 16SW-11 and 16SW-12, formerly baseline monitoring points, 
will continue to be utilized as a compliance monitoring locations.  The points will be monitored 
quarterly during mining and reclamation parameters until their watersheds are eligible for Phase-II 
bond release, then semi-annually through Phase-III bond release, or earlier if approved by the 
appropriate regulatory authorities.  During mining and reclamation, monitoring parameters include 
discharge rate, pH, Acidity, Alkalinity, Iron (total), Manganese (total), Chloride, Sulfate, TDS, 
and TSS.  Sampling and analytical methods will meet industry practice and the standards of the 
Department of Natural Resources’ Land Reclamation Division pursuant to applicable codes.  Lab 
results will be available at the mine site and submitted quarterly to Office of Mines and Minerals.  
Surface water monitoring points 16SW-6, 16SW-8, 21SW-9, and 21SW-10 were sampled to 
adequately establish areal baseline seasonal water quality and quantity characteristics for the 
permit area and are not be incorporated into the during mining and reclamation surface water 
monitoring plan. 
 
SAMPLING AND ANALYSIS PLAN 
 
The surface water locations outlined above will be sampled in accordance with the sampling 
procedures outlined in the surface water Sampling and Analysis Plan (Attachment 4.6.3).  The 
laboratory results are submitted to the internal water quality database via Electronic Data 
Deliverable (EDD) files.  The data is then reported in accordance with the quarterly sampling and 
reporting schedule outlined above.  NPDES outfalls are monitored nine times quarterly.  In the 
event of an exceedance of NPDES effluent limits, it is identified upon receipt of the laboratory 
report.  Options for prevention of further discharge or treatment of effluent are evaluated at that 
time.    
 
 

4.6.4  Locate all surface water monitoring points on the Hydrogeologic Map and fill out Table 4.6.3. 
[1779.25(a)(2)/1783.25(a)(2)] 

Map 4SF identifies all surface water monitoring points, including those baseline monitoring locations that 
are no longer monitoring under the active SAP. 

 



23 | P a g e  P a r t  4  
C r e a t e d :  9 / 1 5 / 1 7  
R e v i s e d :  1 / 1 0 / 1 9  

 

4.6.5  For carbon recovery operations surface water quality of the existing discharge point or of the 
impounded water if no discharge point exists shall be provided, utilizing the parameters in Part 4.6.3.1 
above. [1780.21(b)(2)/1784.14(b)(2)] 

Gateway Mine is not a carbon recovery operation. 

 

4.7  NPDES Monitoring Program. [1780.21(j)(2)(B)/1784.14(i)(2)(B)]  

4.7.1  Has an NPDES permit been applied for? 

  YES    NO 

4.7.2  Has an NPDES permit been obtained? 

  YES    NO 

If YES, give the permit number, the date issued, the expiration date, and the number of discharge points 
monitored.  If additional discharge points are proposed by this application, list discharge numbers.  Locate 
on the Hydrogeologic Map and number all discharge points of the proposed permit area. Complete 
Schedule A for all existing and proposed NPDES Outfalls for the facility. Provide the longitude and 
latitude coordinates, in decimal degrees, for each outfall. [1779.25(a)(2)/1783.25(a)(2)] 

NPDES Permit No.: IL0062189 
Issue Date: May 27, 2015 
Effective Date: May 27, 2015 
Expiration Date: April 30, 2020 
Renewal Submitted: October 24, 2019 
Discharge Points Monitored: 001, 002, 003, 007, 008, 011, 012, 009 (unconstructed), and 010 
(unconstructed) 
 
Schedule A forms are provided.   
 
 

4.7.3  In accordance with 35 Ill. Adm. Code 406.101(b), is the applicant requesting that monitoring and 
reporting be on the basis of grab samples? 

  YES    NO 

If NO, explain. 

 

4.7.4  Are NPDES reports to be submitted to satisfy the reporting requirements? [1780.21(j)/1784.14(i)] 

  YES    NO 

If YES, provide the NPDES monitoring program including sampling method, sampling frequency and 
parameters to be analyzed.  If not, submit a proposed monitoring and reporting program.  Discharge 
information sheet is given in Schedule A and /or form 2C or 2D.  Schedule A should be completed for all 
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proposed and existing discharge points.  An estimate of the expected discharge concentration for each listed 
parameter must be indicated (or marked n/a) and a basis for that estimation provided. 

Schedule A forms are provided.   
 
 

4.7.5  Give a brief description of the surface water sampling and flow measurement equipment which will 
be used to monitor the discharges. [1780.21(j)(2)(B)/1784.14(i)(2)(B)] 

The surface water Sampling and Analysis Plan (Attachment 4.6.3) outlines the surface water sampling and 
flow measuring equipment that is used to monitor NPDES discharges. 

 

4.7.6  Is this proposed mining area covered by existing Illinois EPA (IEPA) Subtitle D permits? 
[1780.21(j)(2)(B)/1784.14(i)(2)(B)] 

  YES    NO 

If YES,  

4.7.6.1  List the permit number(s). 

Construction authorization 8161-00 to replace Subtitle D permits: 
2002-MW-6440-1 
2006-MD-7331 
2008-MW-0146 
2010-MO-9362 
2012-MD-6235 
2014-MO-4343 
2014-MO-4344 
2014-MO-4345 
 
 

4.7.6.2  Do the proposed mining boundaries exactly coincide with IEPA permitted boundaries? 

  YES    NO 

If NO, delineate the IEPA Subtitle D permitted boundaries on the Hydrogeologic map. 
[1779.24(l)/1783.24(l)] 

 

- FOR IEPA PURPOSES ONLY –  
- IN COMPLIANCE WITH A JOINT NPDES/SMCRA PERMIT APPLICATION - 

4.7.7  To allow the IEPA to complete the necessary Antidegradation Analysis required for public notice of 
the NDPES Permit for this proposed operation, provide, as an attachment to this application, the following: 

4.7.7.1  A detailed discharge alternative analysis which discusses alternatives to the outfall 
proposed in this application. 
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The existing outfalls authorized by NPDES permit IL0062189 will contain all runoff from the area 
of the proposed operation.  No new outfalls are being planned for construction as a result of the 
operations proposed in this application.   

 
4.7.7.2  A detailed treatment alternative analysis which includes at a minimum, a discussion of 
each of the following:  

- Filtration 
- Reverse Osmosis 
- Bioremediation 
- Coagulation (chemical) Precipitation 
- Ion Exchange 
- Cost Effective Sulfate Removal (CESR) Process 
- Supervac [35 Ill. Adm. Code 302.105] 

The existing outfalls authorized by NPDES permit IL0062189 will contain all runoff from the area 
of the proposed operation.  No new outfalls are being planned for construction as a result of the 
operations proposed in this application.  The existing alternatives analysis is still applicable to the 
proposed operation described in this application. 

 

- FOR IEPA PURPOSES ONLY –  
- IN COMPLIANCE WITH A JOINT NPDES/SMCRA PERMIT APPLICATION - 

4.7.8  To demonstrate that dissolved contaminants are minimized in runoff from the proposed refuse 
disposal area, Best Management Practices (BMP’s) as specified in the June 2007 SIU Study, “Identification 
and Assessment of Best Management Practices in Illinois Mining Operations to Minimize Sulfate and 
Chloride Discharges” shall be implemented. Identify and discuss each BMP to be implemented from the 
cited study in an attachment to this application. [35 Ill. Adm. Code 406.204, 406.205, 406.206, 406.207 
and 406.208] 

The operation implements several BMPs specifically aimed at improving water quality and other BMPs 
that have the secondary effect of improving water quality.  A subset of these BMPs are effective at 
minimizing concentrations of sulfate and chloride specifically.  These BMPs include coarse refuse 
management practices, fine refuse management practices, utilization of alkaline soil amendments, 
minimization of long-term end dump storage areas,  

Coarse refuse management practices: Coarse refuse is to be laid down and compacted in 24-inch lifts.  This 
minimizes the exposure and oxidation of the refuse material, which prevents the generation of acid salts.  
The site also avoids the use of long-term end dump storage areas.  Utilization of long-term storage areas 
prior to compaction or rehandling is avoided to the extent possible.  This practice not only increases sulfate 
and chloride generation, but it typically requires unnecessary rehandling of material.  The operation utilizes 
direct placement and contemporaneous compaction of fresh coarse refuse material to the extent possible.  
Alkaline amendments are also utilized as approved under the existing Subtitle D permits.  Alkaline 
amendment with water treatment plant lime sludge was a common practice during reclamation of Cells 1, 
2, and 3.  Alkaline amendments are incorporated into the coarse refuse where it is the approved final cover.  
Areas which may receive alkaline amendments include, but are not limited to, coarse refuse cover of Cell 3 
and the exterior embankment of Cell 5 Phase 2. 

https://icci.org/reports/DEV05-8Chugh.pdf
https://icci.org/reports/DEV05-8Chugh.pdf
https://icci.org/reports/DEV05-8Chugh.pdf


26 | P a g e  P a r t  4  
C r e a t e d :  9 / 1 5 / 1 7  
R e v i s e d :  1 / 1 0 / 1 9  

 

Fine refuse management practices: The operation will maintain water cover over the fine refuse within Cell 
5 Phase 2 to the extent practicable.  This minimizes the oxidation of the refuse material and associated 
sulfate and chloride generation.  When coarser grained slurry material creates a deltaic buildup of materials 
exposed to air, the operation will evaluate alternative slurry discharge locations.     

 

4.8  Protection of Hydrologic Balance.  The delineation of the Cumulative Impact Area (CIA) for groundwater and 
surface water shall be included in the Probable Hydrologic Consequences (PHC). The surface and groundwater 
CIA(s) shall be depicted on a CIA map(s). The applicant shall describe the rationale for selecting the surface and 
groundwater CIA(s), concentrating on the relationship between the surface and groundwater regimes. The CIA 
discussion must also include consideration of aquifers in use by area residents, public water supplies, and proximity 
of existing mining areas which can increase impacts on the surface and groundwater areas of influence. A discussion 
of historic mining areas may be included where known existing water quality issues exist. 

The applicant shall provide a narrative determination of the PHC of the operations on the proposed permit, shadow 
area and adjacent areas with respect to the hydrologic regime and water quality and quantity in surface and 
groundwater systems under all seasonal conditions based on the baseline information provided in Sections 4.4, 4.5 
(Groundwater) and 4.6, 4.7 (Surface Water). [1780.21(f)(1)/1784.14(e)(1)] 

POTENTIAL SURFACE WATER CUMULATIVE IMPACT AREA (SCIA)  
 
The potential surface water cumulative impact area (SCIA) for the proposed surface effects permit area is 
encompassed within the Plum Creek watershed. The SCIA incorporates portions of two unnamed tributaries to Plum 
Creek, the “North Tributary” and the “South Tributary”. The SCIA was established using a watershed-based 
approach and includes all drainage from the proposed permit area and currently active Gateway refuse disposal 
operation that falls within the Plum Creek watershed. No other active coal mining operations are known to be 
present within the Plum Creek watershed. Topographic and surface water drainage divides, both existing streams 
and man-made drainage ditches, were utilized to establish the boundaries of the SCIA. Note that the drainage ditch 
that runs parallel to Jean Road directs the water west/southwest, around the northern boundary of the existing 
Gateway operation towards sediment basin SB012B and SB012A before discharging to the North Tributary. The 
SCIA outlet points were established downstream of the permit at the two tributaries confluence with Plum Creek, 
the first stream of significant size downstream of the permit. There are several small tributaries that drain into both 
the North Tributary and the South Tributary.  However, these tributaries were deemed insignificant due to their 
small drainage areas, their ephemeral nature, and the absence of an upstream discharge to the tributary.  
 
The applicant estimates that the total areal extent of the SCIA is about 357.81 acres, or 0.56 square miles, at final 
reclamation (see Attachment 4.8, Supplemental CIA Map).  During operation, the SCIA is smaller since the water 
internal to the impoundments is maintained within the preparation plant’s closed system and only the outer 
embankment contributes runoff to Plum Creek.  This proposed SCIA is small in scope relative to the size (< 1%) of 
the Plum Creek watershed (approximately 89.5 square miles at final reclamation). Hydrologic impact and interaction 
resulting from the mining operations proposed herein should be both temporary and limited in scope within the 
SCIA. During operation of the impoundment, all water within the impoundment will be recycled to the preparation 
plant and should not leave the closed loop of the refuse cell-preparation plant circuit. Only rainfall draining off the 
out-slopes of the Cell 5 impoundment will leave the permit area after passing through professionally designed 
sediment basins. The greatest impact should occur during active operations and should be temporary because of the 
finite life of the impoundment. Impact that may occur after mining and reclamation operations are completed should 
be limited in scope because of the hydrologic protections that will be utilized at the site. The cell will be capped with 
an engineered cover and all surface areas on the top and sides of the embankment will be vegetated and will limit 
erosion and sediment contributions from runoff. Surface water will be passed through professionally designed 
sediment basins to further limit any suspended solids contributions. The compacted liner and compacted clay cap 
will reduce the potential for groundwater impacts in the near and long-term and will further limit any potential 
impacts to the tributaries from baseflow contributions. 
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POTENTIAL GROUNDWATER CUMULATIVE IMPACT AREA (GCIA) 
   
This permit application is for construction and operation of a coal refuse disposal structure and does not include 
mining of coal within the proposed permit area. The permit included excavation of subsoil but there was no 
disturbance of the bedrock. The applicant estimates that any potential impact to groundwater will be limited to the 
shallow, Quaternary unconsolidated interval within the permit boundary. The upper bedrock units consist primarily 
of a low permeable shale (hydraulic conductivity: 10-7 to 10-11 cm/sec (Freeze and Cherry, 1979)) that inhibits 
vertical groundwater movement. A compacted clay liner with a permeability of 1X 10-7 cm/sec separates the interior 
of the impoundment under Cell 5 and prevents infiltration and recharge of water from within the impoundment to 
the underlying water table. Additionally, the local unconsolidated interval exhibits high clay content and low 
permeability, also reducing groundwater migration.  
 
The potential groundwater cumulative impact area (GCIA) of the proposed permit area falls within the headwaters 
of the Plum Creek watershed. The GCIA was established using a watershed-based approach and encompasses the 
proposed permit area and the currently active Gateway refuse disposal area that is located within the Plum Creek 
Watershed. The watershed-based approach was chosen because groundwater flow in the unconsolidated zone 
typically parallels surface topography with recharge areas located in the topographic highs and discharge areas 
located in topographic lows were the groundwater table intersects the ground surface. The water level survey 
conducted at the sites monitoring wells indicates that groundwater mimics the surface topography and flows from 
the topographic high in the east-southeast toward the topographic low in the north-northwest (see Attachment 
4.2.2.3).  
 
The applicant estimates that the total areal extent of the GCIA is 284.0 acres, or 0.44 square miles (see Attachment 
4.8, Supplemental CIA Map). The proposed refuse cell raise GCIA will be limited to the surface effects area because 
of the compacted clay liner underlying Cell 5prevents infiltration and recharge of water from within the 
impoundment to the underlying water table. The installation of a compacted engineered cover to the impoundment 
upon final reclamation will further reduce the potential for groundwater impacts in the long-term and will improve 
upon the currently approved plan for Cell 4.  Likewise, the current Gateway Mine GCIA mirrors the extent of its 
existing surface effects area within the Plum Creek watershed. As noted above, hydrologic impact should generally 
be limited to the shallow, Quaternary unconsolidated interval within the watershed. Magnitude of impact within the 
GCIA should be further limited because locally the unconsolidated interval exhibits high clay content, and poor 
permeability. Sand lenses encountered in the southern half of the permit area were discontinuous and were removed 
and backfilled with clay when encountered during the liner instillation at the base of the impoundment; therefore the 
applicant believes they are to be of no consequence to the mining activity. 

Hydrologic impact and interaction resulting from the project proposed herein should be both temporary and 
relatively limited in scope within the GCIA. The greatest impact should occur during active operations and should 
be temporary because of the finite life of the project, the hydrologic protections proposed (both the liner and 
engineered cover), and the low permeability of the bedrock and unconsolidated material. Impacts that may occur 
after mining and reclamation operations are completed should be limited because of the small aerial extent of the 
proposed project, the hydrologic protections proposed, and the infrequent utilization of the limited local 
groundwater resource. 

 

The determination of PHC shall include findings on the following: 

4.8.1  Will the proposed coal mining and reclamation operations have adverse impacts to the hydrologic 
balance? [1780.21(f)(3)(A)/1784.14(e)(3)(A)] 

  YES    NO 

Explain: 
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Effects normally associated with surface disturbance include slight increases in base flow in adjacent 
receiving streams, slight decreases in mean runoff and peak flow in local receiving streams proximal to 
disturbed areas, temporary lengthening of watershed response time to precipitation events, changed 
relationships between surface and groundwater divides, and impacts to water quality. Such effects should 
remain limited to disturbed and the immediately adjacent areas. 
 
Because large-scale overburden displacement is not proposed, impact to the hydrologic balance resulting 
from the operations described herein should be negligible. Sediment basin installation should attenuate any 
hydrologic impact associated with disturbance of the proposed surface effects area. The NPDES permit 
effluent limits and the surface water and groundwater Sampling and Analysis Plans provide a 
comprehensive sampling, analysis, and reporting schema to validate that adverse impacts to the hydrologic 
balance will not occur.  During construction of the refuse impoundment a temporary lowering of the water 
table in the unconsolidated zone likely occurred. However, this was limited to the initial period of liner and 
embankment construction and limited in lateral extent due to the low hydraulic conductivity of the 
surrounding unconsolidated material, with hydraulic conductivity of surrounding wells averaging 10-5 
cm/sec. The current pollutant controls in place and the final reclamation plans also provide significant 
protection against impacts to the hydrologic balance.  The liner beneath the embankment and impoundment 
interior was constructed of compacted clay (minimum 4-foot composite thickness) to a permeability of no 
more than 10-7 cm/sec which restricts water from both exiting and entering the impoundment. The 
engineered cap, which will cover Cell 5 and Cell 4, provides a barrier against infiltration and subsequent 
mineralization within the refuse materials.    
 
 

4.8.2  Are acid forming or toxic forming materials (AFM) present that could result in contamination of 
surface and/or groundwater supplies?  This shall include the handling and placement of AFM in the 
overburden during mining and reclamation of for surface mining and during construction of all shaft and 
slopes for underground mining.  [1780.21(f)(3)(B)/1784.14(e)(3)(B)] 

  YES    NO 

Explain: 

Planned operations include the construction of the Phase 2 embankment on an existing impoundment.  This 
will involve raising the outer embankment to increase the capacity of the fine coal refuse disposal site.  
Slurry from the preparation plant is pumped into the impoundment and allowed to settle.  Decant water is 
pumped back to the preparation plant to complete the cycle.  The process water is contained in a closed 
loop system and is treated as necessary to maintain the proper alkalinity.  In the event a discharge is 
necessary, additional alkalinity treatment occurs prior to discharge from NPDES Outfall 008.    
 
The clay liner beneath the embankment and impoundment interior (minimum four-foot composite 
thickness) was compacted and has a permeability no greater than 1×10-7cm/sec. This prevents migration of 
water from within the impoundment into the local groundwater.  The existing clay subsoil was utilized for 
both the embankment and clay liner and was compacted to 95% standard Proctor dry density and then 
tested to ensure the required density upon completion. The groundwater protection will be further enhanced 
at final reclamation when the engineered cover (minimum 24-inch composite thickness) compacted to a 
minimum permeability of 1×10-7 cm/sec is installed to prevent infiltration into the impoundment.  This 
engineered cover is currently approved for Cell 5 Phase 1.  The same engineered cover is proposed for Cell 
5 Phase 2.  This incorporates the engineered cover over both Cell 5 and Cell 4.  The engineered cover will 
provide greater protection to the hydrologic balance than the currently approved cover plan for Cell 4.  
Further details of the compaction procedures and quality control methods for both the liner and designed 
cover were originally provided in Permit 426 Attachment III.2.D.1.b and are included hereto in Attachment 
9.4.1.   
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Runoff from the proposed operations area, which will include the out-slope embankments only, will be 
routed through professionally designed sediment basins and all outfalls will be subject to NPDES permit 
limitations. Management of these outfalls, including neutralization and/or treatment with approved, 
industry-standard water treatment chemicals when warranted, should reduce frequency, magnitude, and 
duration of off-site impact.  In addition, the sediment basins and ditches that hold or convey contact runoff 
from the Cell 5 refuse disposal area were lined with a compacted clay liner. The liner beneath the sediment 
basins will be comprised of twelve inches of compacted in-situ material overlain by three successive 
twelve-inch lifts compacted to a minimum permeability of 1x10-7 cm/sec.  Drainage ditches receiving 
refuse contact water have a liner comprised of eight inches of compacted in-situ material overlain by three 
successive eight-inch lifts compacted to a minimum permeability of 1x10-7 cm/sec.  Additional construction 
specifications and quality control measures were originally provided in Permit 426 Attachment III.2.D.1.b 
and are described here in Attachment 9.4.1.  
 
Once the slurry storage volume within Cell 5 Phase 2 has been completely utilized and the engineered 
cover completed and revegetated, potential impact from acid- or toxic-forming materials will be attenuated 
or eliminated. Capping the potentially acid- or toxic-forming materials with the engineered cover 
(minimum 24-inch composite thickness) overlain by a 27-inch layer of non-compacted rooting media and a 
9-inch layer of protective cover topsoil will minimize exposure of the refuse materials to infiltration and 
atmospheric oxygen. This is the primary method of preventing the formation of acid mine drainage.   
 
POTENTIAL ACID-FORMING MATERIALS 
 
Materials used on the Phase 1 external embankment (out slope) was compacted coarse refuse material 
covered by 4-feet of material suitable for revegetation.  An exterior A compacted clay liner was constructed 
at the base of the impoundment as well as beneath the embankment. The compaction of this clay liner and 
above grade clay embankment to a permeability of no greater than 1×10-7cm/sec restricts the migration of 
water that has contacted refuse material within the impoundment into the local groundwater.   
 
Phase 2 construction will utilize coarse refuse material to construct the outer embankment.  The coarse 
refuse will be spread and compacted in 12-inch lifts.  The material is placed to use the heavy equipment 
travel as the means of compaction.  Additional compaction equipment will be used only as necessary.  The 
outer embankment will maintain the compaction level of 1×10-7cm/sec, minimizing infiltration and 
subsequent acid generation.  The refuse material will be placed and compacted contemporaneously, 
preventing buildup of acid salts on the refuse material.  An outer berm will be utilized to maintain runoff 
from the top of the embankment within the closed-loop preparation plant circuit.  Lastly, a minimum of two 
feet of soil will be placed, seeded, and mulched as soon as practicable after exposure.  
 
Acid-base accounting analysis was conducted on both the coarse and fine coal refuse.  Results of these 
analysis were presented in Table 4.3.3.1, Table 4.3.3.2, and Attachment 4.3.3.2.   
 
 

4.8.3  Will the proposed surface coal mining and reclamation operations result in contamination, 
diminution or interruption of an underground or surface source of water within the proposed permit, 
shadow or adjacent areas which is used for legitimate purposes?  [1780.21(f)(3)(C)/1784.14(e)(3)(D)] 

  YES    NO 

Explain: 

Potential contamination, diminution, or interruption of any surface source of water is unlikely due to its 
limited use and the pollutant prevention measures in place.  First, there is limited use of the groundwater 
and surface water in this area.  The unconsolidated and bedrock materials within and adjacent to the permit 
area have low permeability and are typically unable to supply groundwater volumes sufficient support 
residential or agricultural water supply needs.  There is no known usage of the surface water adjacent to the 
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permitted area.  Additionally, several pollutant minimization and control measures are in place to prevent 
offsite impacts.  Sediment basins are designed and constructed to meet regulatory requirements and are 
monitored and reported in accordance with the NPDES permit.  These measures minimize potential for 
impacts to surface water.  Potential impacts to groundwater are minimized through the construction of the 
compacted clay liner beneath the existing Cell 5 Phase 1 area and all associated surface water control 
structures and sediment basins.  Further, the underlying undisturbed materials are also low permeability, 
creating a natural barrier to groundwater migration offsite.   
 
In the event the proposed operations result in a substantiated case of contamination, diminution, or 
interruption of a surface water or groundwater source within or directly contiguous to the subject permit 
site, the applicant will develop or utilize an alternative water source as replacement for the disrupted 
source, including providing an interim source between water loss and replacement.  Alternative sources of 
water include but are not limited to the following:  
 
1. Surface water impoundments. 
2. Local municipal or rural water supplies. 
3. Construction of replacement well(s) to formations suitable for water withdrawal and use. 
4. Treatment of water to attain usable quality. 
5. Haulage of water. 
6.  Other. 
 
 
 

4.8.4  Explain what impact(s) to surface water and groundwater the proposed coal mining and reclamation 
operations may have on, including but not limited to, the following parameters: 

- Sediment yield from the disturbed area; [1780.21(f)(3)(D)(i)/1784.14(e)(3)(C)(i)] 
- Acidity; [1780.21(f)(3)(D)(ii)/1784.14(e)(3)(C)(ii)]  
- Total suspended solids; [1780.21(f)(3)(D)(ii)/1784.14(e)(C)(ii)] 
- Total dissolved solids; [1780.21(f)(3)(D)(ii)/1784.14(e)(C)(ii)] 
-  Flooding or stream flow alterations; [1780.21(f)(3)(D)(iii)/1784.14(e)(3)(C)(iii)] 
- Availability of surface and groundwater. [1780.21(f)(3)(D)(iv)/1784.14(e)(3)(C)(iv)] 

IMPACTS TO SURFACE WATER 
 
Construction of Cell 5 Phase 2 will not disturb any additional area outside of the current surface effects 
area.  The surface effects area is located solely within Plum Creek watershed and constitutes less than 0.2% 
of the total watershed. The minimal surface area associated with Cell 5 Phase 2 is expected to have no 
measurable impact on the overall discharge rate and quality of Plum Creek.  Runoff from disturbed areas is 
all routed through sediment basins with NPDES outfalls to ensure suitable discharge quality to the 
receiving streams.  The NPDES requirements of Permit IL0062189 are more stringent than the Federal 
Effluent Limitation Guidelines for Coal Mining and ensure protection of the designated uses of the 
receiving stream.  The sediment basins that discharge to Plum Creek are Outfalls 011 and 012, which 
receive runoff from the outslopes of the Cell 5 embankment.     
 
The proposed Cell 5 Phase 2 will have negligible impacts to the water quality of Plum Creek.  The 
sediment yield of the receiving stream will be reduced overall.  The adjacent area is dominated by 
agricultural land uses, which are susceptible to significant soil erosion.  The potential suspended sediment 
levels of streams in this type of environment are shown in Table 4.6.2.3.  The design and construction 
requirements of sediment basins and the technology based effluent limits for suspended sediment that are 
applied will lead to a a significant reduction in the suspended sediment and settleable solids concentrations 
immediately downstream of these outfalls.  Schedule A contains the five-year average concentration at 
these outfalls, demonstrating compliance with the NPDES effluent limits and falling at the lower end of the 
range shown in Table 4.6.2.3.  The acidity is expected to remain at baseline levels, again ensured by 
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NPDES effluent limitations requiring that alkalinity levels be greater than acidity in all discharges.  The 
outfalls that discharge to Plum Creek have minimal potential for acidity generation.  Several controls are in 
place to ensure that acidic runoff is maintained and treated within the preparation plant’s closed loop 
system.  The Phase 1 construction of the embankment consisted of a clay exterior that had no potential for 
acidity generation.  The Phase 2 construction will utilize coarse refuse throughout the embankment.  
However, constructed berms will be utilized to control runoff from the exposed areas and will maintain this 
runoff within the preparation plant’s closed loop system.  Five-year average acidity concentrations show 
net-alkaline conditions at all outfalls.  TDS generation is typically a result of oxidation of the refuse 
materials and subsequent mineral dissolution.  Because runoff that is discharged to Plum Creek will not be 
in prolonged contact with refuse materials, mineral dissolution will be minimized and TDS concentrations 
are expected to be low.  Although TDS is not regularly analyzed for these outfalls, two primary 
components, sulfate and chloride, show five-year averages in compliance with water quality standards of 
the receiving streams (Schedule A).  Additionally, the maximum concentrations observed at these outfalls 
over the previous five year period is in compliance with the water quality standards for sulfate and chloride.  
Overall, the pollutant control measures that are in place and the best management practices that are 
implemented to control water quality will be sufficient to protect the existing uses of the received stream.  
In the event that addition controls or treatment is needed, chemical treatment can be used as allowed by the 
NPDES permit.  
 
The sediment basins that are utilized are also expected to have negligible effect on runoff quantity to Plum 
Creek.  The sediment basins are constructed to the regulatory requirements for treatment and storage 
volume.  This will decrease the magnitude of peak flows and will prolong the discharge of baseflow to 
downstream reaches.  Overall, these changes will likely be beneficial to aquatic life and aquatic habitat 
downstream of the site.  At the scale of the Plum Creek watershed however, the potential changes to 
downstream flow rates and volumes will be insignificant.  Chemical treatment of water will be conducted 
when warranted. Sediment yield is addressed in detail in the sediment basin design documentation. 
 
Seasonal variations in surface water quality under post-mining conditions are estimated in Table 4.8.4.1. 
 
TABLE 4.8.4.1: ESTIMATED POST-MINING SURFACE WATER QUALITY 
 

Parameter Range 
pH 6.5 - 9.0 
Acidity (mg/l) <10 
Alkalinity (mg/l) 0 – 334 
TDS (mg/l) 150 – 1500 
Total Fe (mg/l) 0.5 – 6.0 
Total Mn (mg/l) 0.5 – 4.0 
Chloride (mg/l) 50 – 500 
Sulfate (mg/l) 100 – 1,500 

 
These ranges are based upon USGS Water Resources Investigations Report 82-858, on archival data 
acquired by the applicant, and in consideration of NPDES effluent limits and state water quality standards.  
Effluent quality statistics over the previous 5-year period are provided in Attachment 4.8.4.1 and 
demonstrate consistent and continued compliance with effluent limits. Surface water use downstream of the 
permit area should remain unaffected by the proposed operation. 
 
IMPACTS TO GROUNDWATER 
 
The area adjacent and within the proposed permit area is sparsely populated. One resident located within ½ 
mile of the permit boundary reported using the groundwater within the surficial Quaternary aged 
unconsolidated material for their domestic supply. Shallow wells located in close proximity to the permit 
boundary may have experienced a slight decrease in water level or dewatering during the initial phase of 
construction. However, these conditions should have been short-lived and the water level in a state of 
equilibrium now that the clay liner and outer slopes are complete. Any temporary lowering of the water 
table would have been limited in lateral extent due to the low hydraulic conductivity of the unconsolidated 
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materials in the area (mean: 10-5 cm/sec). Limited impacts to groundwater quantity were observed during 
the construction phase of the site previous slurry impoundments, even for groundwater users in close 
proximity to the project areas. Water quality should not be impacted because the clay liner will restrict the 
process water from migrating outside of the impoundment. Because of the low yields, as evidenced by 
measured hydraulic conductivity on the order of 10-5 cm/sec within the local unconsolidated material, and 
the observed manganese concentrations in excess of Class I standards as well as the numerous residential 
wells within ½ mile of the adjacent operations that have historically shown water quality in excess of Class 
I and Class II standards (Attachment 4.4.2.2); classification of the sites unconsolidated zone groundwater 
should be considered no better than Class II (General Resource Groundwater). Water quality in the 
unconsolidated zone groundwater after capping and fully reclaiming the proposed refuse impoundment is 
estimated to be near the average noted in Table 4.8.4.2. 
 
The estimates within Table 4.8.4.2 below are based on USGS Water Resource Investigations Report 82-
858, unpublished analysis of groundwater from the Illinois Basin, and local baseline water quality data. No 
water wells within ½ mile of the proposed operation were identified as being screened within the bedrock. 
Regardless, there should be no impacts to groundwater quality or quantity within the bedrock as the 
proposed activities does not include disturbance to the bedrock material. Deep aquifers are primarily 
recharged off site and should be isolated from downward migration of potential pollutants by thick 
sequences of clay, shale, and siltstone units that exhibit low porosity and permeability. 
 
TABLE 4.8.4.2: ESTIMATED POST RECLAMATION GROUNDWATER QUALITY 
 

PARAMETER ESTIMATED AVERAGE* 

pH 6.5 – 9.0 
acidity (mg/l) <1 
alkalinity (mg/l) 400 
TDS (mg/l) 1250 
chloride (mg/L) 200 
sulfate (mg/l) 400 
total Fe (mg/l) ≤5 
total Mn (mg/l) ≤2 

 
 
 

4.8.5  If this application is for a Significant Permit Revision, the applicant shall describe any relevant 
updates to the PHC originally provided under Part 4.8. [1774.13] 

 

4.8.6  If the PHC determination indicates that the proposed mining operation may proximately result in the 
contamination, diminution, or interruption of an underground or surface water source within the proposed 
permit area, shadow area or adjacent areas used for domestic, agricultural, industrial or other legitimate use, 
the application shall provide information on water availability and alternative water sources.  The 
alternative water source information shall address the suitability of the alternative water source for existing 
pre-mining and approved post-mining land uses. [1780.21(e)/1784.14(b)(3)] 

NOTE: Provide a narrative summary of Parts 4.8.1 through 4.8.6 utilizing the data and information 
provided and gathered for Part 4 of this application. [1780.21/1784.14]  

In the event the proposed operations result in a substantiated case of contamination, diminution, or 
interruption of a surface water or groundwater source within or directly contiguous to the subject permit 
site, the applicant will develop or utilize an alternative water source as replacement for the disrupted 
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source, including providing an interim source between water loss and replacement.  Alternative sources of 
water include but are not limited to the following:  
 
1. Surface water impoundments. 
2. Local municipal or rural water supplies. 
3. Construction of replacement well(s) to formations suitable for water withdrawal and use. 
4. Treatment of water to attain usable quality. 
5. Haulage of water. 
6.  Other. 
 
 

4.9  Preventative and Remedial Measures Plan. For proposed surface mining, provide a plan, as an attachment to 
this application, including maps and descriptions, for meeting the relevant requirements of Sections 1816.41 through 
1816.43. Discussion of preventative and remedial measures shall be included. [1780.21(h)] 

For proposed underground mining, provide a plan, including maps and descriptions, for meeting the relevant 
requirements of Sections 1817.41 through 1817.43. Discussion of preventative and remedial measures shall be 
included. [1784.14(g)] 

Each plan shall address the following:  

- The specific local hydrologic conditions  
- The steps to be taken during mining and reclamation through final bond release to minimize 

disturbance to the hydrologic balance within the permit and adjacent areas 
- The steps to be taken to prevent material damage outside the permit area 
- The steps to be taken to meet the applicable Federal and State water quality laws and regulations 
- The steps to be taken to protect the rights of present water users and replacement, if necessary 
- The measures to prevent acid or toxic drainage 
- The measures to prevent additional contributions of suspended solids to stream flow to the extent 

possible using the best technology currently available 
- The measures to be taken to provide for water treatment facilities when necessary 
- The measures to be taken to provide to control drainage 
- The measures to be taken to restore approximate pre-mining recharge capacity 
- The measures to be taken to address any potential adverse hydrologic consequences identified in 

the PHC determination. 

The preventative and remedial measures plan is included as Attachment 4.9. 

 
 

4.10  Liners. Construction details and specifications, as well as a Quality Assurance/Quality Control (QA/QC) Plan 
for the proposed compacted clay liners shall be provided, as an attachment to this application, if a compacted clay 
liner is proposed for this operation. The QA/QC Plan should include, at a minimum:  

- The loose soil thickness of each lift 
- The methodology for replacing soft areas encountered during construction 
- Frequency of permeability testing, and 
- Means of protecting the constructed liner from damage. 
- The location of all compacted clay liners throughout the proposed permit area. 
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If a geosynthetic liner is proposed in lieu of a compacted clay liner, provide an appropriate, relevant QA/QC Plan to 
ensure proper installation and maintenance of the geosynthetic liner is achieved. [1816.41/1817.41] 

Cell 5 Phase 1 included construction of a liner beneath the refuse area as well as the ditches and sediment basins 
that received drainage from the refuse area.  The quality assurance and quality control plan of the compaction 
procedures and quality control methods for the underlying liner were originally provided in Permit 426 
Attachment III.2.D.1.b and are described here in Attachment 9.4.1.  Cell 5 Phase 2 includes expansion of the Cell 
5 area over Cell 4 and a portion of Cell 3.  The enhanced cap that was approved as part of Cell 5 Phase 1 is being 
extended over the entire Cell 5 impounded area.  This provides additional protections to the Cell 4 and exterior of 
Cell 3 that are not currently in the approved permit.  The quality assurance / quality control plan for the previously 
approved enhanced cover for Cell 5 was also provided originally in Permit 426 Attachment III.2.D.1.b and is 
included here in Attachment 9.4.1.  

 

 

4.11  Coal Combustion Materials.  Provide a discussion of any existing or proposed operation to disposal of Coal 
Combustion Waste (CCW) or to beneficially use Coal Combustion By-products (CCB) within the proposed permit 
area as described in this application. Include a discussion of how the CCW/CCB materials may interact and/or 
impact the groundwater and surface waters in and around the proposed permit, shadow (if applicable) and adjacent 
areas. A surface water and groundwater monitoring plan shall also be provided. [415 ILCS 5/3.135; 415 ILCS 
5/3.140] 

NOTE: Also, see Part 15 of this application. 

Onsite usage of coal combustion materials is in accordance with Subtitle D Permits 2008-MW-0146 and 2002-MW-
6440-1.  This application does not propose any new uses of coal combustion materials.  

 
 

http://ilga.gov/legislation/ilcs/documents/041500050K3.135.htm
http://www.ilga.gov/legislation/ilcs/documents/041500050K3.140.htm
http://www.ilga.gov/legislation/ilcs/documents/041500050K3.140.htm
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‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐

Drillhole             Northing    Easting    Surf.Elv. Density  Type Quality

16892C               550534.6 645905.5 499.5 80 1 1  1  

‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐

Description STATE=IL

MINE=0275

CNTY=157

DRILLER=BH

DRILL_DATE=10/26/1991

DRILL_EQUIP=ROT

‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐

 Strata        Bed      Depth  Elevation Thick.  Key    Attributes     

‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐

Clay UNC 0 499.5 41.2 N  DESC1=CL 

Shale            PL       41.2 458.3 3.8 N  DESC1=GRY, DESC2=SFT 

Sandstone            PL       45 454.5 5.6 N  DESC1=GRY 

Shale            PL       50.6 448.9 2.2 N  DESC1=SDY, DESC2=Limestone, DESC3=STK 

Shale            PL       52.8 446.7 11.4 N  DESC1=GRY 

Limestone PL       64.2 435.3 11.2 N 

Shale            BFLU     75.4 424.1 8.5 N  DESC1=GRY, DESC2=SFT 

Limestone BFLU     83.9 415.6 1 N 

Shale            BFL      84.9 414.6 4.7 N  DESC1=GRY, DESC2=Limestone, DESC3=NOD 

Shale            BFL      89.6 409.9 0.5 N  DESC1=DRK 

Limestone BFL      90.1 409.4 3.6 N 

Shale            BL       93.7 405.8 8.5 N  DESC1=DRK, DESC2=HRD 

Shale            BL       102.2 397.3 1.4 N  DESC1=DRK, DESC2=Limestone 

Limestone BL       103.6 395.9 6 N 

Shale            AS       109.6 389.9 1.9 N  DESC1=DRK 

Coal 6 111.5 388 7.4 Y 

Fire Clay 6FC      118.9 380.6 1.1 N 

Shale            HGL      120 379.5 2.7 N  DESC1=DRK, DESC2=Limestone, DESC3=NOD 

Limestone HGL      122.7 376.8 4.8 N  DESC1=Shale, DESC2=BDD 

Shale            HGL      127.5 372 0.8 N  DESC1=GRY 

Limestone HGL      128.3 371.2 2.7 N  DESC1=Shale, DESC2=BDD 

Shale            131 368.5 2.7 N  DESC1=GRY, DESC2=LC 

Sandstone            133.7 365.8 3.4 N 

Shale            137.1 362.4 3.9 N  DESC1=GRY 

‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐
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‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐

Drillhole             Northing    Easting    Surf.Elv. Density  Type Quality

DH‐1                 547045 649700 542.5 80 0 5  5  

‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐

Description STATE=IL

MINE=0178

CNTY=157

DRILL_DATE=03/14/1950

‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐

 Strata        Bed      Depth  Elevation Thick.  Key    Attributes     

‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐

SO_UNC        UNC      0 542.5 49 N  DESC1=CL 

Limestone            8 49 493.5 0.83 N 

ST            8 49.83 492.67 2.67 N  DESC1=SFT 

Coal 8 52.5 490 1 Y 

FC            PL       53.5 489 8.5 N 

Shale            PL       62 480.5 16 N  DESC1=GRN 

Limestone            PL       78 464.5 0.5 N 

Shale            PL       78.5 464 6.5 N  DESC1=DRK, DESC2=Limestone, DESC3=BND 

Shale            PL       85 457.5 3.5 N  DESC1=SDY 

Shale            PL       88.5 454 67.5 N  DESC1=DRK 

Shale            PL       156 386.5 22.17 N  DESC1=DRK, DESC2=ST 

Sandstone            PL       178.17 364.33 1 N 

Shale            PL       179.17 363.33 0.33 N  DESC1=DRK 

Shale            PL       179.5 363 4.5 N  DESC1=SFT 

Sandstone            PL       184 358.5 9 N  DESC1=Limestone 

Shale            PL       193 349.5 12 N 

Limestone      PL       205 337.5 11 N 

Shale            7 216 326.5 1.42 N 

Coal 7 217.42 325.08 1 Y 

Fire Clay BFLU     218.42 324.08 8.58 N 

Limestone   BFLU     227 315.5 3.5 N 

Shale            BFL      230.5 312 5.58 N  DESC1=Limestone, DESC2=BND 

Limestone   BFL      236.08 306.42 3.09 N 

Black Shale AS       239.17 303.33 4.83 N  DESC1=BLK 

Shale            AS       244 298.5 2.5 N  DESC1=Limestone, DESC2=BND 

Black Shale AS       246.5 296 2.5 N  DESC1=BLK 

Black Shale AS       249 293.5 4.83 N  DESC1=BLK 

Lost Core ENS      253.83 288.67 3.09 N 

Coal 6 256.92 285.58 7.67 Y 

Fire Clay 6FC      264.59 277.91 1.58 N 

‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐
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‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐

Drillhole             Northing    Easting    Surf.Elv. Density  Type Quality

DH‐2                 551546 649390 516.48 80 0 5  5  

‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐

Description STATE=IL

MINE=0178

CNTY=157

DRILL_DATE=03/14/1950

‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐

 Strata        Bed      Depth  Elevation Thick.  Key    Attributes     

‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐

Clay UNC      0 516.48 18 N  DESC1=SD, DESC2=GV 

Clay UNC      18 498.48 12 N 

Limestone            PL       30 486.48 0.08 N 

Shale            PL       30.08 486.4 27.92 N  DESC1=LGT, DESC2=GRY 

Shale            PL       58 458.48 25.5 N  DESC1=HRD 

Limestone            PL       83.5 432.98 0.17 N 

Shale            PL       83.67 432.81 20.5 N  DESC1=DRK 

Shale            PL       104.17 412.31 4.33 N  DESC1=GRY 

Shale            PL       108.5 407.98 5.5 N  DESC1=DRK, DESC2=ST 

Sandstone            PL       114 402.48 9.5 N  DESC1=Limestone 

Shale            PL       123.5 392.98 11.92 N  DESC1=BND 

Limestone_PL         PL       135.42 381.06 9.83 N 

Black Shale 7 145.25 371.23 2.42 N  DESC1=BLK 

Coal 7 147.67 368.81 1.66 Y 

Fire Clay BFLU     149.33 367.15 6.67 N 

Limestone            BFLU     156 360.48 3.17 N 

Limestone            BFL      159.17 357.31 3.83 N  DESC1=Shale 

Limestone            BFL      163 353.48 3.17 N 

Shale            CL       166.17 350.31 4.16 N  DESC1=DRK 

Limestone            CL       170.33 346.15 1.84 N 

Shale            BL       172.17 344.31 1.58 N  DESC1=HRD 

Limestone            BL       173.75 342.73 8.25 N 

Black Shale AS       182 334.48 3.17 N  DESC1=BLK 

Coal 6 185.17 331.31 6.5 Y 

Fire Clay 6FC      191.67 324.81 1.33 N 

‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐
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‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐

Drillhole             Northing    Easting    Surf.Elv. Density  Type Quality

DH‐21                549879 647823 514.27 80 0 5  5  

‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐

Description STATE=IL

MINE=0178

CNTY=157

DRILL_DATE=12/01/1965

‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐

 Strata        Bed      Depth  Elevation Thick.  Key    Attributes     

‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐

Clay UNC      0 514.27 23.33 N 

Shale            LONL     23.33 490.94 11.17 N  DESC1=SFT, DESC2=GV 

Shale            LONL     34.5 479.77 82.17 N  DESC1=MED, DESC2=HRD, DESC3=GRY 

Limestone LONL     116.67 397.6 4.33 N  DESC1=HRD 

Shale_LONL       LONL     121 393.27 1.83 N  DESC1=GRY, DESC2=LMY 

Limestone LONL     122.83 391.44 0.83 N  DESC1=HRD 

Shale            PL       123.66 390.61 11.83 N  DESC1=GRY, DESC2=LMY 

Limestone PL       135.49 378.78 9.5 N  DESC1=HRD 

Shale            7 144.99 369.28 1.5 N  DESC1=DRK, DESC2=GRY 

Shale            7 146.49 367.78 3.17 N  DESC1=GRY 

Coal 7 149.66 364.61 2.33 Y 

Fire Clay BFLU     151.99 362.28 3.25 N  DESC1=GRY 

Shale            BFLU     155.24 359.03 3.08 N  DESC1=GRY, DESC2=LMY 

Limestone BFLU     158.32 355.95 2.5 N  DESC1=HRD 

Shale            BFL      160.82 353.45 6.5 N  DESC1=GRY, DESC2=LMY 

Limestone BFL      167.32 346.95 2.33 N  DESC1=HRD, DESC2=GRY 

Shale            CL       169.65 344.62 4.33 N  DESC1=SFT, DESC2=DRK, DESC3=GRY 

Limestone CL       173.98 340.29 3 N  DESC1=HRD 

Coal JS       176.98 337.29 0.33 Y 

Shale            BL       177.31 336.96 0.92 N  DESC1=SFT 

Limestone BL       178.23 336.04 3.25 N  DESC1=HRD, DESC2=DRK, DESC3=GRY 

Shale            AS       181.48 332.79 0.67 N  DESC1=SFT, DESC2=GRY 

Slate AS       182.15 332.12 1.67 N  DESC1=HRD, DESC2=BLK 

Shale ENS      183.82 330.45 2 N  DESC1=GRY 

Coal 6 185.82 328.45 7 Y 

Fire Clay 6FC      192.82 321.45 1.17 N 

‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐
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‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐

Drillhole             Northing    Easting    Surf.Elv. Density  Type Quality

DHCELL5              549572.1 648196.5 512.93 80 1 1  1  

‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐

Description STATE=IL

MINE=0173

CNTY=157

DRILLER=JOS

DRILL_DATE=07/20/2011

DRILL_EQUIP=ROTA

DRILL_CO=MAG

‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐

 Strata        Bed      Depth  Elevation Thick.  Key    Attributes     

‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐

Clay UNC      0 512.93 18 N  DESC1=SLY, DESC2=SDY, DESC3=TAN 

Silt UNC      18 494.93 8 N  DESC1=WIT, DESC2=GV, DESC3=RBRN 

Sandstone            PL       26 486.93 10 N 

Shale            PL       36 476.93 38 N 

Shale            PL       74 438.93 2 N 

Shale            PL       76 436.93 17 N 

Shale            PL       93 419.93 5 N 

Shale            PL       98 414.93 16 N 

Claystone            PL       114 398.93 2 N 

Claystone            PL       116 396.93 13 N  DESC1=LMY, DESC2=SDY, DESC3=MGY 

Claystone            PL       129 383.93 12 N 

Claystone            PL       141 371.93 3 N  DESC1=LMY, DESC2=SDY, DESC3=MGY 

Limestone PL       144 368.93 8 N 

Fire Clay 7 152 360.93 1 N 

Black Shale 7 153 359.93 2 N 

Coal 7 155 357.93 2.7 Y 

Claystone            BFLU     157.7 355.23 6.3 N 

Claystone            BFLU     164 348.93 2 N  DESC1=LMY, DESC2=SDY, DESC3=MGY 

Limestone BFLU     166 346.93 1 N 

Claystone            BFL      167 345.93 7 N  DESC1=LMY, DESC2=SDY, DESC3=MGY 

Limestone BFL      174 338.93 2.8 N 

Shale            CL       176.8 336.13 4.4 N 

Limestone CL       181.2 331.73 2 N 

Shale            BL       183.2 329.73 2.1 N 

SandstoneH           BL       185.3 327.63 1.7 N  DESC1=LMY, DESC2=MAS, DESC3=MGY 

Limestone BL       187 325.93 6.2 N 

Black Shale AS       193.2 319.73 2.6 N 

Coal 6 195.8 317.13 6.8 Y 

Claystone            6FC      202.6 310.33 0.1 N 

Claystone            6FC      202.7 310.23 1.2 N  DESC1=LMY 

Limestone HGL      203.9 309.03 3.6 N 

Claystone            207.5 305.43 3.4 N  DESC1=LMY, DESC2=SDY, DESC3=MGY 

Limestone            210.9 302.03 1.8 N 

‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐
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‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐

Drillhole             Northing    Easting    Surf.Elv.  Density  Type Quality

GWN‐04E              554542.7 656854.9 561.13 82 1 1  1  

‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐

Description STATE=IL

MINE=0173

CNTY=157

DRILLER=JOE

DRILL_DATE=03/23/2010

DRILL_EQUIP=60B

DRILL_CO=MAG

‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐

 Strata        Bed      Depth   Elevation  Thick.  Key    Attributes     

‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐

Clay     UNC      0 561.13 12 N  DESC1=SLY, DESC2=SDY, DESC3=TAN, DESC4=BUF 

Clay     PL       12 549.13 2 N  DESC1=RED, DESC2=BRN, DESC3=FIN 

Clay     PL       14 547.13 3 N  DESC1=SDY, DESC2=RED, DESC3=BRN 

Clay     PL       17 544.13 3 N 

Shale PL       20 541.13 1.5 N  DESC1=MED, DESC2=GRY, DESC3=SS, DESC4=STK 

Shale PL       21.5 539.63 4.1 N  DESC1=SDY, DESC2=MED, DESC3=GRY, DESC4=SS, DESC5=STK 

Shale PL       25.6 535.53 3 N  DESC1=SDY, DESC2=ITB, DESC3=MED, DESC4=GRY 

Shale PL       28.6 532.53 25.4 N  DESC1=SDY, DESC2=MED, DESC3=GRY 

Shale PL       54 507.13 2 N 

Shale PL       56 505.13 32.3 N  DESC1=SDY, DESC2=MED, DESC3=GRY 

Shale PL       88.3 472.83 4.8 N  DESC1=SDY, DESC2=MED, DESC3=GRY, DESC4=SI, DESC5=NOD 

Shale PL       93.1 468.03 0.7 N  DESC1=LMY, DESC2=SDY, DESC3=SH, DESC4=WIT, DESC5=FOS 

Shale PL       93.8 467.33 3.2 N  DESC1=DGY 

De Graff Coal PL       97 464.13 1 N 

Claystone PL       98 463.13 2.6 N  DESC1=SDY, DESC2=MGY 

Claystone PL       100.6 460.53 8.5 N  DESC1=LMY, DESC2=SDY 

Shale PL       109.1 452.03 1.4 N  DESC1=SDY, DESC2=MGY, DESC3=SI, DESC4=NOD 

Shale PL       110.5 450.63 8.8 N  DESC1=SDY, DESC2=MGY 

Shale PL       119.3 441.83 6.2 N  DESC1=SDY, DESC2=MGY, DESC3=WIT, DESC4=SS, DESC5=STK 

Shale PL       125.5 435.63 4.4 N  DESC1=SDY, DESC2=MGY, DESC3=SS, DESC4=LIME, DESC5=NOD 

Shale PL       129.9 431.23 0.5 N  DESC1=SHY, DESC2=MGY, DESC3=FOS 

Shale PL       130.4 430.73 62 N  DESC1=SDY, DESC2=MGY 

Shale PL       192.4 368.73 11.5 N  DESC1=SDY, DESC2=MGY, DESC3=WIT, DESC4=SI, DESC5=NOD 

Shale PL       203.9 357.23 0.5 N  DESC1=LMY, DESC2=SDY, DESC3=DGY, DESC4=WIT, DESC5=FOS 

Claystone PL       204.4 356.73 0.5 N  DESC1=MGY, DESC2=WIT, DESC3=SH, DESC4=STK 

Claystone PL       204.9 356.23 1.4 N  DESC1=MGY 

Claystone PL       206.3 354.83 3.6 N  DESC1=LMY, DESC2=SDY, DESC3=MGY, DESC4=LIME, DESC5=NOD 

Claystone PL       209.9 351.23 4.2 N  DESC1=SDY, DESC2=MGY 

Claystone PL       214.1 347.03 0.3 N  DESC1=SDY 

Underclay PL       214.4 346.73 3.1 N  DESC1=MGY 

Claystone PL       217.5 343.63 3.3 N  DESC1=RED, DESC2=BRN 

Claystone PL       220.8 340.33 2.5 N  DESC1=LMY, DESC2=SDY 

Claystone PL       223.3 337.83 4.5 N  DESC1=LMY, DESC2=SDY, DESC3=MGY, DESC4=LIME, DESC5=NOD 

Sandy Shale PL       227.8 333.33 1.9 N  DESC1=SH, DESC2=ITB, DESC3=MGY 

Shale PL       229.7 331.43 3.3 N  DESC1=LMY, DESC2=SDY, DESC3=MGY, DESC4=LIME, DESC5=NOD 

Shale PL       233 328.13 0.5 N  DESC1=SDY, DESC2=DGY, DESC3=WIT, DESC4=SS, DESC5=STK 

Claystone PL       233.5 327.63 6.8 N  DESC1=SDY, DESC2=MGY 

Limestone_PL PL       240.3 320.83 10 N 

Claystone 7 250.3 310.83 0.5 N  DESC1=SDY, DESC2=MGY 

Claystone 7 250.8 310.33 1.3 N  DESC1=DGY 

Coal 7 7 252.1 309.03 1.3 Y 

Shale BL       253.4 307.73 1.7 N  DESC1=SDY, DESC2=MGY 

Claystone BL       255.1 306.03 7.4 N  DESC1=LMY, DESC2=SDY, DESC3=MGY, DESC4=LIME, DESC5=NOD 

Limestone  BL       262.5 298.63 4 N  DESC1=CL, DESC2=BND 

Claystone BL       266.5 294.63 3.8 N  DESC1=LMY, DESC2=SS, DESC3=MGY, DESC4=LIME, DESC5=NOD 

Limestone BL       270.3 290.83 1.7 N  DESC1=SHY 

Shale BL       272 289.13 0.5 N  DESC1=LMY, DESC2=SDY, DESC3=MGY 

Limestone BL       272.5 288.63 1.5 N 

Claystone BL       274 287.13 0.6 N  DESC1=SDY, DESC2=MGY 

Shale BL       274.6 286.53 3.5 N  DESC1=SDY, DESC2=DGY 

Shale BL       278.1 283.03 0.7 N  DESC1=SDY, DESC2=DGY, DESC3=FOS 

Limestone BL       278.8 282.33 1.2 N  DESC1=SHY, DESC2=WIT, DESC3=FOS 

Shale BL       280 281.13 7.7 N  DESC1=SDY, DESC2=DGY, DESC3=WIT, DESC4=FOS 

Shale BL       287.7 273.43 4.7 N  DESC1=LMY, DESC2=SDY, DESC3=MGY, DESC4=WIT, DESC5=FOS 

Shale 6 292.4 268.73 0.1 N  DESC1=SDY, DESC2=DGY, DESC3=WIT, DESC4=CO, DESC5=STK 

Coal 6 6 292.5 268.63 6.8 Y 

Underclay 6FC      299.3 261.83 1.6 N  DESC1=MGY 

Claystone 300.9 260.23 0.4 N  DESC1=LMY, DESC2=SDY, DESC3=MGY, DESC4=LIME, DESC5=NOD 

Limestone 301.3 259.83 5.5 N 

‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐

Attachment 4.2.2.1 
Revised 04/21/2021

Page 63 of 63



B-20B-17

B-14

W3-13

B-26

B-30

B-23

B-11

B-6

TD. 27.5'

B-2

W3-11

TD. 34.0'

480

490

500

510

520

530

540

480

490

500

510

520

530

540

0 100 200 300 400 500 600 700 800 900 1000 1100 1200 1300 1400 1500 1600 1700 1800 1900 2000 2100 2200 2300 2400 2500 2600 2700 2800 2900 3000 3100 3200 3300 3400 3500 3600 3700 3800 3900 4000 4100 4200 4300 4400 4500 4600

B-13

B-12

W3-12

480

490

500

510

520

530

540

540

0 100 200 300 400 500 600 700 800 900 1000 1100 1200 1300 1400 1500 1600 1700 1800 1900 2000

B-12R

490

500

510

520

530

550

480

470

2100

TD. 27.5'

TD. 28'

TD. 44'

TD. 54'

TD. 49.5'

TD. 29.5'

TD. 24.5'

TD. 22'

TD. 27.5'

TD. 34.5'

TD. 34'

B-14

TD. 44'

TD. 30'

RANDOLPH COUNTY, ILLINOIS
T.4 S. - R. 5 W. SECS. 16, 21

DESCRIPTION:

QUADRANGLE:

MINE NAME:

DEM

SHOWN BELOW

426

DATE:

SCALE:

DRAWN BY:

PERMIT NO.: GATEWAY MINE

04/21/2021

(HYDROGEOLOGIC INFORMATION)

UNCONSOLIDATED CROSS-SECTION
A-A' & B-B'

G:\DWG\GATEWAY\REFUSE EXPANSION PERMIT 426\SOIL BORINGS LOCATIONS DRAFT 20210304.DWG

TOPSOIL

SILTY CLAY

PEABODY COULTERVILLE MINING, LLC.

Evansville, Indiana

SANDY CLAY

SAND

SAND WITH GRAVEL

COULTERVILLE, TILDEN 7.5 MIN USGS QUADRANGLES

CLAYEY SAND

ATTACHMENT 4.2.2.2.

SHALE

CLAY

WEATHERED SHALE

Horizontal Scale: 1"=100'
Vertical Scale: 1"=10'

560

470

550

560

470

470

TD. 24.5'

A A'

B B'



0 300' 600' 900'

SCALE:

DATE:

DRAWN BY:

1" = 300'

JSB

GENERAL INFORMATION

PERMIT NO.: GATEWAY MINE

COULTERVILLE, TILDEN 7.5 MIN. QUADRANGLESQUADRANGLE:

DESCRIPTION:

MINE NAME:#426

REVISED  04-21-2021

ROADS

LAKE OR POND W/ID. NUMBER

STREAMS

RANDOLPH COUNTY, ILLINOIS 
T.4 S.-R.5 W. SEC'S: 16, 21





Coulterville, Illinois
PEABODY COULTERVILLE MINING LLC.



INFORMATION
HYDROGEOLOGIC

TD-14'
G-1

SW-6
STREAM SAMPLE POINT

RESIDENTIAL WELL

MONITORING WELL
26 MW-2

PERMIT #53 SURFACE EFFECTS BOUNDARY

PERMIT #51 SURFACE EFFECTS BOUNDARY

PERMIT #426 REFUSE PERMIT BOUNDARY

PERMIT #416 SURFACE EFFECTS BOUNDARY

PERMIT #225 SURFACE EFFECTS BOUNDARY

PERMIT #205 SURFACE EFFECTS BOUNDARY

PERMIT #160 SURFACE EFFECTS BOUNDARY

SW-6
INACTIVE STREAM SAMPLE POINT

POTENTIOMETRIC SURFACE CONTOUR

Z
E

I
G

L
E

R
 
M

I
N

E
 
R

D
.

WILSON RD.

TYLER RD.

SARAH RD.

22

TD - 22.1'

TD - 14.6'

SLURRY CELL NO. 4

GW103

GW101

TD - 22.4'
GW100

P
E

R
M

I
T

 
5

3

P

E

R

M

I

T

 

5

3

PERMIT 53

PERMIT 53

PERMIT 225

PERMIT 160

P
E

R
M

I
T

 
1

6
0

PERMIT 160

P

E

R

M

I

T

 

1

6

0

PERMIT 160

PERMIT

160

5

1

5

5

1

0

5

0

5

5

0

0

5

2

0

4

9

5

4

9

0

SB 011
CELL "B"

S
B

 011
C

E
LL "A

"

SB 012

SB 012
CELL "B"

CELL "A"





W3-09

W3-15

W3-11 TD - 27.5'
TD - 34.0'

W3-13

W3-14

W3-08R

TD - 23.5'

TD - 30.0'

TD - 27.0

W3-08

TD - 23.5'

W3-12

TD - 27.0'

TD - 33.0'

W3-10

AutoCAD SHX Text
G:\DWG\GATEWAY\REFUSE EXPANSION PERMIT 426\MAP 4SF DRAFT 20210304.DWG

AutoCAD SHX Text
21W-1

AutoCAD SHX Text
490

AutoCAD SHX Text
480

AutoCAD SHX Text
480

AutoCAD SHX Text
490

AutoCAD SHX Text
510

AutoCAD SHX Text
510

AutoCAD SHX Text
520

AutoCAD SHX Text
520

AutoCAD SHX Text
520

AutoCAD SHX Text
530

AutoCAD SHX Text
540

AutoCAD SHX Text
560

AutoCAD SHX Text
570

AutoCAD SHX Text
580

AutoCAD SHX Text
590

AutoCAD SHX Text
590

AutoCAD SHX Text
580

AutoCAD SHX Text
590

AutoCAD SHX Text
570

AutoCAD SHX Text
580

AutoCAD SHX Text
590

AutoCAD SHX Text
590

AutoCAD SHX Text
590

AutoCAD SHX Text
590

AutoCAD SHX Text
580

AutoCAD SHX Text
570

AutoCAD SHX Text
580

AutoCAD SHX Text
590

AutoCAD SHX Text
590

AutoCAD SHX Text
590

AutoCAD SHX Text
580

AutoCAD SHX Text
590

AutoCAD SHX Text
590

AutoCAD SHX Text
580

AutoCAD SHX Text
590

AutoCAD SHX Text
590

AutoCAD SHX Text
580

AutoCAD SHX Text
580

AutoCAD SHX Text
590

AutoCAD SHX Text
590

AutoCAD SHX Text
590

AutoCAD SHX Text
590

AutoCAD SHX Text
580

AutoCAD SHX Text
590

AutoCAD SHX Text
580

AutoCAD SHX Text
570

AutoCAD SHX Text
560

AutoCAD SHX Text
540

AutoCAD SHX Text
530

AutoCAD SHX Text
530

AutoCAD SHX Text
530

AutoCAD SHX Text
520

AutoCAD SHX Text
520

AutoCAD SHX Text
520

AutoCAD SHX Text
510

AutoCAD SHX Text
510

AutoCAD SHX Text
490

AutoCAD SHX Text
490

AutoCAD SHX Text
480

AutoCAD SHX Text
490

AutoCAD SHX Text
490

AutoCAD SHX Text
490

AutoCAD SHX Text
490

AutoCAD SHX Text
490

AutoCAD SHX Text
490

AutoCAD SHX Text
510

AutoCAD SHX Text
510

AutoCAD SHX Text
510

AutoCAD SHX Text
520

AutoCAD SHX Text
590

AutoCAD SHX Text
590

AutoCAD SHX Text
580

AutoCAD SHX Text
570

AutoCAD SHX Text
560

AutoCAD SHX Text
540

AutoCAD SHX Text
530

AutoCAD SHX Text
520

AutoCAD SHX Text
560

AutoCAD SHX Text
570

AutoCAD SHX Text
580

AutoCAD SHX Text
590

AutoCAD SHX Text
590

AutoCAD SHX Text
590

AutoCAD SHX Text
590

AutoCAD SHX Text
590

AutoCAD SHX Text
580

AutoCAD SHX Text
570

AutoCAD SHX Text
580

AutoCAD SHX Text
590

AutoCAD SHX Text
590

AutoCAD SHX Text
590

AutoCAD SHX Text
590

AutoCAD SHX Text
590

AutoCAD SHX Text
580

AutoCAD SHX Text
520

AutoCAD SHX Text
530

AutoCAD SHX Text
540

AutoCAD SHX Text
530

AutoCAD SHX Text
540

AutoCAD SHX Text
540

AutoCAD SHX Text
560

AutoCAD SHX Text
510

AutoCAD SHX Text
520

AutoCAD SHX Text
530

AutoCAD SHX Text
540

AutoCAD SHX Text
540

AutoCAD SHX Text
510

AutoCAD SHX Text
510

AutoCAD SHX Text
490

AutoCAD SHX Text
490

AutoCAD SHX Text
510

AutoCAD SHX Text
510

AutoCAD SHX Text
510

AutoCAD SHX Text
510

AutoCAD SHX Text
510

AutoCAD SHX Text
510

AutoCAD SHX Text
510

AutoCAD SHX Text
510

AutoCAD SHX Text
520

AutoCAD SHX Text
530

AutoCAD SHX Text
540

AutoCAD SHX Text
540

AutoCAD SHX Text
560

AutoCAD SHX Text
570

AutoCAD SHX Text
580

AutoCAD SHX Text
590

AutoCAD SHX Text
590

AutoCAD SHX Text
580

AutoCAD SHX Text
590

AutoCAD SHX Text
590

AutoCAD SHX Text
580

AutoCAD SHX Text
500

AutoCAD SHX Text
500

AutoCAD SHX Text
550

AutoCAD SHX Text
550

AutoCAD SHX Text
500

AutoCAD SHX Text
500

AutoCAD SHX Text
500

AutoCAD SHX Text
500

AutoCAD SHX Text
500

AutoCAD SHX Text
500

AutoCAD SHX Text
550

AutoCAD SHX Text
500

AutoCAD SHX Text
500

AutoCAD SHX Text
500

AutoCAD SHX Text
500

AutoCAD SHX Text
500

AutoCAD SHX Text
500

AutoCAD SHX Text
500

AutoCAD SHX Text
500

AutoCAD SHX Text
500

AutoCAD SHX Text
500

AutoCAD SHX Text
550

AutoCAD SHX Text
500

AutoCAD SHX Text
550

AutoCAD SHX Text
600

AutoCAD SHX Text
600

AutoCAD SHX Text
600

AutoCAD SHX Text
550

AutoCAD SHX Text
500

AutoCAD SHX Text
500

AutoCAD SHX Text
500

AutoCAD SHX Text
600

AutoCAD SHX Text
600

AutoCAD SHX Text
550

AutoCAD SHX Text
550

AutoCAD SHX Text
500

AutoCAD SHX Text
500

AutoCAD SHX Text
550

AutoCAD SHX Text
550

AutoCAD SHX Text
550

AutoCAD SHX Text
550

AutoCAD SHX Text
550

AutoCAD SHX Text
600

AutoCAD SHX Text
600

AutoCAD SHX Text
550

AutoCAD SHX Text
550

AutoCAD SHX Text
550

AutoCAD SHX Text
550

AutoCAD SHX Text
550

AutoCAD SHX Text
550

AutoCAD SHX Text
550

AutoCAD SHX Text
510

AutoCAD SHX Text
510

AutoCAD SHX Text
520

AutoCAD SHX Text
530

AutoCAD SHX Text
520

AutoCAD SHX Text
540

AutoCAD SHX Text
540

AutoCAD SHX Text
540

AutoCAD SHX Text
560

AutoCAD SHX Text
570

AutoCAD SHX Text
580

AutoCAD SHX Text
570

AutoCAD SHX Text
570

AutoCAD SHX Text
590

AutoCAD SHX Text
580

AutoCAD SHX Text
580

AutoCAD SHX Text
590

AutoCAD SHX Text
590

AutoCAD SHX Text
590

AutoCAD SHX Text
610

AutoCAD SHX Text
620

AutoCAD SHX Text
620

AutoCAD SHX Text
610

AutoCAD SHX Text
540

AutoCAD SHX Text
560

AutoCAD SHX Text
570

AutoCAD SHX Text
580

AutoCAD SHX Text
590

AutoCAD SHX Text
590

AutoCAD SHX Text
540

AutoCAD SHX Text
560

AutoCAD SHX Text
570

AutoCAD SHX Text
580

AutoCAD SHX Text
590

AutoCAD SHX Text
590

AutoCAD SHX Text
610

AutoCAD SHX Text
610

AutoCAD SHX Text
620

AutoCAD SHX Text
630

AutoCAD SHX Text
620

AutoCAD SHX Text
620

AutoCAD SHX Text
610

AutoCAD SHX Text
590

AutoCAD SHX Text
590

AutoCAD SHX Text
590

AutoCAD SHX Text
610

AutoCAD SHX Text
620

AutoCAD SHX Text
590

AutoCAD SHX Text
590

AutoCAD SHX Text
580

AutoCAD SHX Text
570

AutoCAD SHX Text
540

AutoCAD SHX Text
560

AutoCAD SHX Text
540

AutoCAD SHX Text
540

AutoCAD SHX Text
560

AutoCAD SHX Text
540

AutoCAD SHX Text
530

AutoCAD SHX Text
520

AutoCAD SHX Text
510

AutoCAD SHX Text
510

AutoCAD SHX Text
510

AutoCAD SHX Text
510

AutoCAD SHX Text
510

AutoCAD SHX Text
520

AutoCAD SHX Text
520

AutoCAD SHX Text
520

AutoCAD SHX Text
520

AutoCAD SHX Text
520

AutoCAD SHX Text
530

AutoCAD SHX Text
540

AutoCAD SHX Text
540

AutoCAD SHX Text
530

AutoCAD SHX Text
540

AutoCAD SHX Text
540

AutoCAD SHX Text
540

AutoCAD SHX Text
540

AutoCAD SHX Text
570

AutoCAD SHX Text
560

AutoCAD SHX Text
570

AutoCAD SHX Text
580

AutoCAD SHX Text
590

AutoCAD SHX Text
570

AutoCAD SHX Text
580

AutoCAD SHX Text
570

AutoCAD SHX Text
580

AutoCAD SHX Text
560

AutoCAD SHX Text
560

AutoCAD SHX Text
560

AutoCAD SHX Text
580

AutoCAD SHX Text
540

AutoCAD SHX Text
530

AutoCAD SHX Text
560

AutoCAD SHX Text
560

AutoCAD SHX Text
560

AutoCAD SHX Text
560

AutoCAD SHX Text
540

AutoCAD SHX Text
560

AutoCAD SHX Text
570

AutoCAD SHX Text
530

AutoCAD SHX Text
540

AutoCAD SHX Text
560

AutoCAD SHX Text
530

AutoCAD SHX Text
540

AutoCAD SHX Text
540

AutoCAD SHX Text
540

AutoCAD SHX Text
540

AutoCAD SHX Text
530

AutoCAD SHX Text
520

AutoCAD SHX Text
520

AutoCAD SHX Text
520

AutoCAD SHX Text
520

AutoCAD SHX Text
530

AutoCAD SHX Text
540

AutoCAD SHX Text
540

AutoCAD SHX Text
530

AutoCAD SHX Text
520

AutoCAD SHX Text
530

AutoCAD SHX Text
540

AutoCAD SHX Text
520

AutoCAD SHX Text
520

AutoCAD SHX Text
530

AutoCAD SHX Text
530

AutoCAD SHX Text
530

AutoCAD SHX Text
530

AutoCAD SHX Text
520

AutoCAD SHX Text
520

AutoCAD SHX Text
520

AutoCAD SHX Text
520

AutoCAD SHX Text
530

AutoCAD SHX Text
520

AutoCAD SHX Text
520

AutoCAD SHX Text
520

AutoCAD SHX Text
520

AutoCAD SHX Text
520

AutoCAD SHX Text
520

AutoCAD SHX Text
520

AutoCAD SHX Text
530

AutoCAD SHX Text
540

AutoCAD SHX Text
530

AutoCAD SHX Text
540

AutoCAD SHX Text
530

AutoCAD SHX Text
530

AutoCAD SHX Text
520

AutoCAD SHX Text
530

AutoCAD SHX Text
540

AutoCAD SHX Text
530

AutoCAD SHX Text
540

AutoCAD SHX Text
530

AutoCAD SHX Text
530

AutoCAD SHX Text
520

AutoCAD SHX Text
520

AutoCAD SHX Text
520

AutoCAD SHX Text
520

AutoCAD SHX Text
520

AutoCAD SHX Text
520

AutoCAD SHX Text
520

AutoCAD SHX Text
550

AutoCAD SHX Text
550

AutoCAD SHX Text
N:546000

AutoCAD SHX Text
N:551600

AutoCAD SHX Text
E:650800

AutoCAD SHX Text
N:550403

AutoCAD SHX Text
E:647173

AutoCAD SHX Text
NORTH TRIBUTARY

AutoCAD SHX Text
PLUM CREEK

AutoCAD SHX Text
UNNAMED

AutoCAD SHX Text
22W-5

AutoCAD SHX Text
22W-6

AutoCAD SHX Text
22W-7



 
OVERBURDEN CORE ACID BASE ANALYSIS 
  

GWN-04E 

Description 
Top 

Depth (ft) 

Bot. 
Depth     

(ft) 

Thick.      
(ft) 

Tons CaCO3 Equiv. Per 1000 tons Material 

NNP = NP - AP Weighted NNP 

Amt Needed 
Amt 

Excess Amt Needed 
Amt 

Excess 

shale 20 21.5 1.5 -7.5   -11.25   

shale 21.5 23.55 2.05   24.06   49.32 

shale 23.55 25.6 2.05   39.34   80.65 

shale 25.6 28.6 3   29.37   88.11 

shale 28.6 31.7 3.1   24.5   75.95 

shale 31.7 34.8 3.1   26.76   82.96 

shale 34.8 37.9 3.1   23.22   71.98 

shale 37.9 40.95 3.05   23.04   70.27 

shale 40.95 44 3.05   28.83   87.93 

shale 44 47.3 3.3   24.12   79.60 

shale 47.3 50.6 3.3   26.97   89.00 

shale 50.6 56 5.4   21.59   116.59 

shale 56 59.23 3.23   23.46   75.78 

shale 59.23 62.46 3.23   20.49   66.18 

shale 62.46 65.69 3.23   15.17   49.00 

shale 65.69 68.92 3.23   14.11   45.58 

shale 68.92 72.15 3.23   19.05   61.53 

shale 72.15 75.38 3.23   26.97   87.11 

shale 75.38 78.61 3.23   26.15   84.46 

shale 78.61 81.84 3.23   28.6   92.38 

shale 81.84 85.07 3.23   24.62   79.52 

shale 85.07 88.3 3.23   27.21   87.89 

shale 88.3 90.7 2.4   38.32   91.97 

shale 90.7 93.1 2.4   31.79   76.30 

shale 93.1 93.8 0.7   139.91   97.94 

shale 93.8 97 3.2 -82.83   -265.06   
De Graff 
Coal 97 98 1 -54.21   -54.21   

claystone 98 100.6 2.6   8.77   22.80 

claystone 100.6 103.4 2.8   18.38   51.46 

claystone 103.4 106.2 2.8   11.83   33.12 

claystone 106.2 109.1 2.9   13.87   40.22 

shale 109.1 112.5 3.4   21.91   74.49 

shale 112.5 115.9 3.4   8   27.20 

shale 115.9 119.3 3.4   24.33   82.72 

shale 119.3 122.4 3.1   42.55   131.91 

shale 122.4 125.5 3.1   90.63   280.95 

shale 125.5 127.7 2.2   10.36   22.79 

shale 127.7 129.9 2.2   22.48   49.46 

shale 129.9 130.4 0.5   322.52   161.26 

shale 130.4 133.5 3.1   12.09   37.48 

shale 133.5 136.6 3.1   24.72   76.63 

shale 136.6 139.7 3.1   20.3   62.93 

shale 139.7 142.8 3.1   20.85   64.64 
Table continues following page 
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OVERBURDEN CORE ACID BASE ANALYSIS (Continued) 
 

GWN-04E 

Description 
Top 

Depth (ft) 

Bot. 
Depth     

(ft) 

Thick.      
(ft) 

Tons CaCO3 Equiv. Per 1000 tons Material 

NNP = NP - AP Weighted NNP 

Amt Needed 
Amt 

Excess Amt Needed 
Amt 

Excess 

shale 142.8 145.9 3.1   11.42   35.40 

shale 145.9 149 3.1   21.55   66.81 

shale 149 152.1 3.1   28.12   87.17 

shale 152.1 155.2 3.1   11.66   36.15 

shale 155.2 158.3 3.1   0.63   1.95 

shale 158.3 161.4 3.1   2.64   8.18 

shale 161.4 164.5 3.1   15.51   48.08 

shale 164.5 167.6 3.1   22.75   70.53 

shale 167.6 170.7 3.1   13.94   43.21 

shale 170.7 173.8 3.1   20.88   64.73 

shale 173.8 176.9 3.1   17.75   55.03 

shale 176.9 180 3.1   22.97   71.21 

shale 180 183.1 3.1   15.84   49.10 

shale 183.1 186.2 3.1   22.06   68.39 

shale 186.2 189.3 3.1   31.41   97.37 

shale 189.3 192.4 3.1   31.78   98.52 

shale 192.4 195.2 2.8   18.46   51.69 

shale 195.2 198.1 2.9   13.06   37.87 

shale 198.1 201 2.9   36.19   104.95 

shale 201 203.9 2.9   30.83   89.41 

shale 203.9 204.4 0.5   115.17   57.59 

claystone 204.4 204.9 0.5   269.01   134.51 

claystone 204.9 206.3 1.4   11.1   15.54 

claystone 206.3 209.9 3.6   187.79   676.04 

claystone 209.9 212.2 2.3   44.13   101.50 

claystone 212.2 214.4 2.2   41.9   92.18 

underclay 214.4 217.5 3.1   6.75   20.93 

claystone 217.5 220.8 3.3   66   217.80 

claystone 220.8 223.3 2.5   60.43   151.08 

claystone 223.3 225.5 2.2   19.39   42.66 

claystone 225.5 227.8 2.3   40.01   92.02 

sandy shale 227.8 229.7 1.9   48.86   92.83 

shale 229.7 233 3.3   16.35   53.96 

shale 233 233.5 0.5   65.67   32.84 

claystone 233.5 236.9 3.4   4.72   16.05 

shale 236.9 240.3 3.4   0.35   1.19 

limestone 240.3 243.6 3.3   811.73   2678.71 

limestone 243.6 246.9 3.3   829.6   2737.68 

limestone 246.9 250.3 3.4   895.18   3043.61 

claystone 250.3 250.8 0.5   134.21   67.11 

claystone 250.8 252.1 1.3   13.09   17.02 

Coal-7 252.1 253.4 1.3 -126.69   -164.70   

shale 253.4 255.1 1.7 -8.9   -15.13   

claystone 255.1 257.5 2.4   226.03   542.47 

claystone 257.5 260 2.5   130.46   326.15 
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OVERBURDEN CORE ACID BASE ANALYSIS (Continued) 
 

GWN-04E 

Description 
Top 

Depth (ft) 

Bot. 
Depth     

(ft) 

Thick.      
(ft) 

Tons CaCO3 Equiv. Per 1000 tons Material 

NNP = NP - AP Weighted NNP 

Amt 
Needed 

Amt 
Excess Amt Needed 

Amt 
Excess 

claystone 260 262.5 2.5   18.34   45.85 

limestone 262.5 264.5 2   433.68   867.36 

limestone 264.5 266.5 2   649.49   1298.98 

claystone 266.5 270.3 3.8   731.8   2780.84 

limestone 270.3 272 1.7   418.74   711.86 

shale 272 272.5 0.5   346.17   173.09 

limestone 272.5 274 1.5   845.84   1268.76 

claystone 274 274.6 0.6   341.45   204.87 

shale 274.6 278.1 3.5 -96.32 -337.12   

shale 278.1 278.8 0.7   344.14   240.90 

limestone 278.8 280 1.2   868.01   1041.61 

shale 280 282.5 2.5   346.39   865.98 

shale 282.5 285.1 2.6   407.17   1058.64 

shale 285.1 287.7 2.6   204.5   531.70 

shale 287.7 289.8 2.1   411.67   864.51 

shale 289.8 292.5 2.7   446.03   1204.28 

Coal-6 292.5 299.3 6.8*   0.47*     

underclay 299.3 300.9 1.6   35.75   57.20 

shale 300.9 301.3 5.9   448.07   2643.61 

                

    Total 280 -376.45 13125.86 -847.46 31365.27 
Note 
*Coal-6 not included in NNP calculations because it will be mined and removed. 
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OVERBURDEN CORE PROVENANCE SUMMARY 

 

Core No. Sample Collector Collection Date Analytical Laboratory Lab Report Date 
Collection 

Method 

GWN-04E Magnum Drilling 03-23-10 Standard Labs, Freeburg, IL 06-11-10 rotary core 

 

SAMPLE ANALYTICAL METHODS 
 

Parameter Analytical Method 

paste pH EPA-600/2-78-054 3.2.2 
total sulfur ASTM D4239C 
pyritic sulfur ASTM D2492 
potential acidity 

EPA-600/2-78-054 1.3.1 
net neutralization 
neutralization potential EPA-600/2-78-054 3.2.3 
moisture at saturation EPA-600/2-78-054 3.2.18 
TDS EPA-600/2-78-054 3.2.18 mod 
calcium 

EPA-600/2-78-054 3.2.19 
magnesium 
sodium 
SAR 
iron 

EPA-600/2-78-054 3.2.19 mod manganese 
aluminum 
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pH, Field Acidity
Alkalinity as 
CaCO3, @ 

pH 4.5

Total 
Dissolved 

Solids, Lab
Sulfates Chloride Hardness Iron Iron Manganese Manganese

N N N N N N N T D T D
S.U. MG/L MG/L MG/L MG/L MG/L MG/L MG/L MG/L MG/L MG/L

Average 506.93 7.35 -296 372 1,044 313 75 442 3.71 0.11 0.33 0.09
Maximum 509.23 9.50 1 428 1,310 503 107 568 62.40 3.78 1.69 0.69
Minimum 503.43 6.70 -358 284 760 81 29 350 0.14 0.01 0.03 0.00
St. Dev. 1.56 0.41 61 33 119 86 14 45 9.76 0.58 0.29 0.14
Count 43 43 43 43 43 43 43 42 43 43 43 43
Average 507.84 7.01 -219 294 687 204 38 361 3.10 0.19 0.18 0.09
Maximum 512.99 7.60 1 452 1,230 403 70 721 10.60 1.99 1.03 0.59
Minimum 503.14 6.34 -384 95 156 7 5 88 0.25 0.01 0.02 0.00
St. Dev. 2.44 0.29 104 112 316 122 19 175 2.56 0.43 0.18 0.12
Count 42 42 42 42 42 42 42 41 42 42 42 42
Average 522.18 7.13 -361 529 824 180 19 579 30.37 0.23 1.18 0.28
Maximum 524.61 7.60 118 802 975 242 74 3,300 734.00 1.18 30.00 1.03
Minimum 518.81 6.52 -504 484 690 145 7 439 0.22 0.01 0.04 0.02
St. Dev. 1.59 0.22 111 50 83 24 20 441 120.76 0.39 4.65 0.26
Count 42 41 42 42 42 42 42 41 42 42 42 42
Average 489.06 7.21 -233 268 860 87 242 446 0.69 0.02 0.04 0.04
Maximum 490.78 7.48 -144 282 1,085 99 284 496 2.20 0.15 0.10 0.10
Minimum 487.28 6.87 -247 184 735 70 72 406 0.26 0.01 0.01 0.00
St. Dev. 1.19 0.18 23 22 70 9 48 23 0.45 0.04 0.03 0.03
Count 17 19 18 18 18 18 18 18 18 18 18 18
Average 520.19 7.25 -269 323 562 109 32 356 1.15 0.01 0.16 0.11
Maximum 521.31 7.65 -158 340 715 119 50 385 3.20 0.02 0.49 0.46
Minimum 518.21 6.95 -295 312 430 99 22 332 0.25 0.01 0.03 0.00
St. Dev. 0.98 0.20 33 8 57 6 9 15 0.73 0.00 0.14 0.13
Count 16 17 17 17 17 17 17 17 17 17 17 17
Average 529.66 7.29 -236 305 640 180 7 247 2.24 0.12 0.19 0.14
Maximum 531.31 7.62 -164 400 1,195 242 57 451 13.00 0.74 0.39 0.31
Minimum 527.99 6.80 -343 272 530 131 4 197 0.01 0.01 0.00 0.01
St. Dev. 1.04 0.25 36 30 128 25 10 49 2.57 0.22 0.09 0.08
Count 23 23 25 25 25 25 25 25 25 25 25 25
Average 511.50 7.33 -347 396 1,142 310 169 458 0.85 0.01 0.05 0.04
Maximum 514.97 7.54 -307 416 1,295 384 222 506 2.21 0.05 0.20 0.18
Minimum 508.77 7.07 -371 361 1,045 282 131 404 0.36 0.01 0.02 0.00
St. Dev. 2.18 0.14 24 19 69 24 29 27 0.53 0.01 0.05 0.04
Count 17 18 18 18 18 18 18 18 18 18 18 18
Average 503.60 7.21 -325 397 728 165 56 466 5.40 0.04 0.35 0.04
Maximum 505.80 8.00 -159 450 885 240 72 697 55.20 0.33 1.20 0.22
Minimum 501.10 6.20 -376 215 205 20 4 100 0.08 0.01 0.02 0.00
St. Dev. 1.41 0.39 46 46 132 41 14 92 10.59 0.08 0.27 0.05
Count 25 24 31 31 31 31 31 31 31 27 31 27

Acidity / Alkalinity Major Ions Metals

Location Date Range Statistics Water Level 
Elevation

Water Level 
Range

(Max - Min)

Location Information

W311 11/30/11 - 11/09/20

W312 11/30/11 - 11/09/20

W313 11/30/11 - 11/09/20

W314 09/07/16 - 11/09/20

W38R 09/07/16 - 11/09/20

W315 09/07/16 - 11/09/20

W316 05/15/15 - 11/10/20

WEGWM-10 11/28/06 - 04/22/15

6.20

4.70

5.80

9.85

5.80

3.50

3.10

3.32
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pH, Field Acidity
Alkalinity as 
CaCO3, @ 

pH 4.5

Total 
Dissolved 

Solids, Lab
Sulfates Chloride Hardness Iron Iron Manganese Manganese

N N N N N N N T D T D
S.U. MG/L MG/L MG/L MG/L MG/L MG/L MG/L MG/L MG/L MG/L

Acidity / Alkalinity Major Ions Metals

Location Date Range Statistics Water Level 
Elevation

Water Level 
Range

(Max - Min)

Location Information

Average 516.18 7.16 -271 409 1,057 265 231 792 49.79 0.01 3.45 0.01
Maximum 520.07 8.06 27 6,680 3,010 642 581 6,500 1,035.00 0.06 62.20 0.03
Minimum 509.90 6.34 -4,020 184 480 130 24 226 0.00 0.01 0.00 0.00
St. Dev. 2.20 0.36 540 945 545 148 181 1,059 164.62 0.01 10.06 0.01
Count 42 39 53 47 58 56 58 58 58 27 52 32

WEGWM-8 08/31/93 - 04/22/15 10.17
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Table 2: Table showing residential wells that exceed Class I water quality standards in the vicinity of Gateway Mine.  Exceedances of Class 1 standards are shown in 
blue.  Exceedances of both Class 1 and Class 2 are shown in red.   

Residential 
Well Description Sample 

Date 

Total 
Dissolved 

Solids 
Acidity Alkalinity Chloride Hardness Iron Manganese pH Sulfates 

Water 
Level 
Depth 

(mg/L) (mg/L) (mg/L) (mg/L) (mg/L) (mg/L) (mg/L) (S.U.) (mg/L) (ft.) 

Mulholland 
 SE 1/4 of SE 1/4 of Sec. 3, T. 4S, 
R. 5W.  Approximately 1.7 miles 
north of the permit boundary. 

03/14/1973 3153 -- 474 40.0 2020 0.00 -- -- -- -- 

Zeigler Coal 
3-01

860' West and 770' south of 
center of Sec. 22, T. 4S, R. 5W 06/17/1982 1399 77 410 18.0 1143 1.20 0.62 7.10 580 12.00 

Kingsten / 
Miller 

Elmer Kingsten.  East 1/2 of the 
SE 1/4 of Section 26, T. 4S, R. 5W 

06/18/1982 2329 93 369 122.0 1874 0.16 0.14 7.00 950 24.00 

01/30/2012 1690 -290 342 36.2 1010 0.77 0.13 6.95 821 -- 

Knope Located approximately 0.4 miles 
east of the permit boundary.  

11/13/1975 3271 636 95.0 1225 6.30 -- -- -- -- 

01/18/2012 3100 -356 570 84.4 1281 0.11 0.03 7.45 1510 

133  23W1  Associated with Permit 416 well 
inventory.  Not located on map. 09/15/2011 1166 <1 90 12.3 160 0.69 0.82 7.52 21 -- 

383  21GW1  Associated with Permit 416 well 
inventory.  Not located on map. 10/06/2011 1472 <1 401 178.0 1000 0.02 0.06 6.85 468 16.00 

241  25W13  Associated with Permit 416 well 
inventory.  Not located on map. 09/15/2011 112 10 42 1.6 90 0.57 0.54 7.72 1 -- 

356  19W1  Associated with Permit 416 well 
inventory.  Not located on map. 09/15/2011 60 <1 54 2.4 130 1.40 1.03 7.23 4 -- 

49  11W1  Associated with Permit 416 well 
inventory.  Not located on map. 09/15/2011 230 -18 54 6.7 51 0.26 0.76 7.25 13 -- 

492  31W2  Associated with Permit 416 well 
inventory.  Not located on map. 09/15/2011 20 <1 59 3.9 140 0.21 0.48 7.66 9 -- 

525  5GW6  Associated with Permit 416 well 
inventory.  Not located on map. 10/06/2011 854 <1 400 43.6 195 23.60 3.14 7.86 281 9.00 

636 2GW2A  Associated with Permit 416 well 
inventory.  Not located on map. 10/06/2011 152 19 50 11.6 94 0.02 0.14 6.11 44 7.00 

663  1W9  Associated with Permit 416 well 
inventory.  Not located on map. 09/15/2011 295 -75 100 12.2 115 0.55 0.16 7.97 34 -- 
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2011 Water 
Year

2012 Water 
Year

2013 Water 
Year

2014 Water 
Year

2015 Water 
Year

2016 Water 
Year

2017 Water 
Year

2018 Water 
Year

2019 Water 
Year

2020 Water 
Year

Start Date 10/1/2010 10/1/2011 10/1/2012 10/1/2013 10/1/2014 10/1/2015 10/1/2016 10/1/2017 10/1/2018 10/1/2019
End Date 9/30/2011 9/30/2012 9/30/2013 9/30/2014 9/30/2015 9/30/2016 9/30/2017 9/30/2018 9/30/2019 9/30/2020

Max -- 509.2 509.0 508.8 508.3 507.6 506.3 506.8 507.3 508.2
Min -- 503.9 503.4 505.2 505.5 506.1 505.1 504.5 505.6 505.8
Δ -- 5.3 5.6 3.6 2.8 1.5 1.2 2.3 1.7 2.4

Max -- 513.0 511.5 509.8 510.1 509.0 506.9 508.3 509.3 508.7
Min -- 503.6 503.1 503.5 505.0 504.8 505.0 504.9 506.5 506.3
Δ -- 9.4 8.3 6.3 5.1 4.2 1.9 3.4 2.8 2.4

Max -- 524.2 523.2 521.9 522.8 521.9 522.2 523.5 524.5 524.6
Min -- 520.7 519.2 518.8 519.9 520.2 520.4 521.2 523.9 524.1
Δ -- 3.5 4.0 3.1 2.9 1.7 1.9 2.3 0.6 0.5

Max -- -- -- -- -- -- 490.0 490.2 490.3 490.8
Min -- -- -- -- -- -- 487.3 487.9 488.0 488.2
Δ -- -- -- -- -- -- 2.7 2.3 2.3 2.6

Max -- -- -- -- -- -- 521.2 521.1 520.9 521.3
Min -- -- -- -- -- -- 518.8 518.2 519.6 519.5
Δ -- -- -- -- -- -- 2.4 2.9 1.3 1.8

Max -- -- -- -- -- -- 530.6 530.1 530.8 531.0
Min -- -- -- -- -- -- 528.5 528.0 528.3 529.1
Δ -- -- -- -- -- -- 2.2 2.1 2.5 1.9

Max -- -- -- -- -- -- 510.4 513.5 514.5 515.0
Min -- -- -- -- -- -- 509.0 508.8 511.1 510.7
Δ -- -- -- -- -- -- 1.4 4.7 3.4 4.3

Max 505.6 504.4 505.4 504.9 504.4 -- -- -- -- --
Min 501.1 501.6 502.6 501.8 501.9 -- -- -- -- --
Δ 4.5 2.8 2.8 3.1 2.5 -- -- -- -- --

Max 518.9 517.5 518.6 518.9 516.4 -- -- -- -- --
Min 515.4 514.1 513.3 513.7 514.9 -- -- -- -- --
Δ 3.5 3.4 5.3 5.2 1.5 -- -- -- -- --

Average 4.00 4.88 5.21 4.25 2.96 2.48 1.95 2.86 2.09 2.27
Max 4.50 9.40 8.35 6.25 5.10 4.23 2.70 4.70 3.40 4.30
Min 3.50 2.80 2.80 3.10 1.50 1.50 1.20 2.15 0.60 0.50

Minimum 
Annual 

Fluctuation

Maximum 
Annual 

Fluctuation

Average 
Annual 

Fluctuation

3.85 5.30 1.50

2.80 3.10 2.50

2.18 2.50 1.90

3.45 4.70 1.40

WEGWM-8

Well

W38R

WEGWM-10

W311

W312

W313

W314

W315

W316

1.205.602.93

4.87 9.40 1.90

2.27 4.00 0.50

2.47 2.70 2.30

2.10 2.90 1.30
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GROUNDWATER SAMPLING METHODS 
This section describes the general procedures and methodologies used when conducting groundwater 
sampling.   

1.0 GROUNDWATER LEVEL MEASUREMENTS 
The depth to the water (DTW) level will be measured within the monitoring well before any purging 
and sampling. Groundwater level measurements can provide information on lateral and vertical head 
distribution and hydraulic gradients within individual aquifers and between aquifers in layered aquifer 
systems. Long-term groundwater level measurement provides information on the temporal trends in 
groundwater levels (and therefore flow direction and rates) due to the effects of drought, high rainfall 
events, and groundwater pumping. The depth to water and the total depth of each monitoring well are 
also used to determine the volume of groundwater to be removed from the monitoring well as part of 
the purging activity. Groundwater level elevations will be calculated from water levels relative to top of 
casing elevations. The top of casing elevation relative to mean sea level will be measured by a 
surveyor.  

1.1 MEASURING DEPTH TO WATER TABLE 
The depth to the water level (DTW) in the monitoring well is also referred to as depth to 
groundwater or static water level (SWL), if the water level has not been altered from pumping. 
Depth to the water table will be measured and recorded before every groundwater sampling 
event.  Upon arrival, the well cap should be removed allowing the barometric pressure to equilibrate 
within the well. The water level will then be measured in hundredths of feet with an electronic water 
level indicator. The water level indicator consists of a probe that detects the presence of a 
conductive liquid between its two electrodes and is powered by a standard 9 volt battery. When 
contact is made with water, the circuit is closed, sending a signal back to the reel which activates 
a buzzer and or light. The water level is then determined by taking a reading directly from the 
tape, at the surveyor mark on the top of the well casing. If no mark is present, mark a location 
with a metal file or indelible marker on the north side of the casing for future reference. The depth 
to water level from the ground surface can be determined by subtracting the well casing stickup 
(length of well casing extending above the surface of the ground) from the water level measured 
from the top of the monitoring well casing.  

Procedure 

1. Remove well cap allowing barometric pressure to equilibrate within the well. 
2. Measure the water level by lowering the indicator into the well. 
3. Record the water level measurement in hundredths of a foot from the surveyor mark at the 

top of the casing. 
a. If no mark is present, mark the location with a metal file or marker on the north side of 

the well casing. 
4. Calculate and record water level elevation either by: 

a. Subtracting the water level measured from the top of casing from the previously 
determined top of casing elevation. 

b. Subtracting the water level measured from the top of casing from the previously 
determined ground surface elevation, then adding the well casing stickup height from 
ground surface.   

 
 
 
2.0 PURGING  
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Prior to collecting a sample the monitoring well will be purged, either by pump or bailer, of one to three 
well volumes ensuring water from the formation is sampled (USGS, 2006; Knobel, 2006). The volume of 
water present in the well casing (gallons) can be calculated using the following formula: 

 
V= 0.04d2h  

Where V = volume of water in the well (gal) 
  d = diameter of well (in) 
  h = column of water, well total depth – water level (ft) 

 
Note: the units for the diameter of the monitoring well are in inches and the height of the column of water 
are in feet. Do not change the units, the built in conversion factor accommodates this variation.  

 
Procedure 

1. Measure the inner diameter of the bore casing in inches. 
2. Measure the total depth of the monitoring well in feet, or obtain this from the relevant 

database or owner. 
3. Measure the depth to water level in feet (see section 1.1). 
4. Calculate the length of the water column (well total depth – water level). 
5. Calculate the volume of water using the formula above.  

2.1 Purging using a bailer 
A bailer is a simple mechanical device that can be used to draw water from the monitoring well. It 
consists of a length of tubing (polyethylene, polyvinyl chloride, Teflon®, stainless steel, etc.) with 
a one-way check valve at the bottom. When the bailer is lowered into the well casing below the 
water level, it fills with water. The check valve closes once the bailer containing the water sample 
is lifted to the surface. Bailers come in various lengths and widths therefore it is required to 
determine the total volume of water each bailer can remove. The bailers volume in gallons can be 
calculated using the same equation used to calculate the volume of water in a well casing above 
by substituting the length of the bailer in feet for the height of the column of water in the well 
casing and the inner diameter of the bailer in inches for the inner diameter of the well casing (see 
Section 2.0). The volume of water in the well (gal) is then divided by the volume of water removed 
in each bail (gal) to determine the number of bails required to remove the one to three well 
volumes.  

Procedure 
 

1. Lower the bailer into the water trying not to cause excessive splashing which may result in 
disturbance of the sediment at the base of the water column.  

a. Similarly also avoid hitting the bailer on the bottom of the well.  
2.  Withdraw the bailer smoothly, limiting excessive splashing.  
3.  Use a bucket of known volume to record the volume of water being discharged or 

calculate the volume removed based on the size of the bailer.  
4.  Remove the calculated volume of water (see Section 2.0). 
 

2.2 Purging using a pump 
A wide range of groundwater pumps employing different operating methods, available on the 
market. There are pneumatic pumps that require a compressed air/gas source, electric pumps 
that require 240 volt AC or 12–24 volt DC, and mechanical pumps, which use linkages to provide 
the lift mechanism. The pump used will depend on the cost of the equipment, depth of the 
monitoring well screen interval, the depth of the water table, diameter of the monitoring well 
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casing, amount of water to be evacuated.  Regardless of the type of pump used, the pump will be 
deployed by slowly lowering the head of the pump to within the screen interval of the monitoring 
well. The pump will then be turned on, the pumping rate estimated by recording the time required 
to fill a known volume (ex: half gallon bottle), and the time to purge the one to three well volumes 
will be calculated by dividing the water volume required to be purged by the average pumping 
rate.  

 
Procedure 

1. Lower the pump slowly to within the monitoring well screen interval taking care not to hit 
the base of the well, which can stir up particulate matter.  

2. After starting the pump, attempt to achieve the highest flow rate possible without causing 
the monitoring well to stop yielding. 

3. Estimate the flow rate by recording the time required to fill a known volume, converting 
units into gallons. 

4. Determine the time required to purge the one to three well volumes by dividing the water   
volume required to be purged by the average pumping rate.  

5. Pump for calculated length of time needed to remove the one to three well volumes of 
water.  

 
 
3.0 SAMPLING MONITORING WELLS 
     Monitoring well samples will be collected using either a bailer or pump.  

3.1 Bailing 
Equipment will consist of a bailer with the appropriate length of bailer twine. Care should be taken 
to lower the bailer slowly into the water limiting disturbance to the water column that can result in 
sediment being re-suspended in the water column from a plunger effect. In addition, care should 
also be taken to not let the base of the bailer hit the bottom of well which also can result in re-
suspension of sediment at the bottom of the well.     
  

  Procedure 
 

1. Upon completion of purging the well, lower the bailer slowly and gently into the water 
column of the well until it is submerged. Do not allow the bailer to come into contact with 
the bottom of the well. 

2. Slowly remove the bailer from the water column. 
3. Carefully remove the water sample, pouring it from the bailer into a prepared sample 

container. 
4. Repeat steps 1-3 until all sample containers are filled to within at least one inch of the top 

of the sample container. 
 

3.2 Pumping 
Equipment will consist of a pump selected based on cost of the equipment, depth of the monitoring 
well screen interval, the depth of the water table, diameter of the monitoring well casing, amount of 
water to be evacuated. The pump should be deployed slowly to within the monitoring well screen 
interval. Changes in the depth of pump within the well column should be avoided as it can disturb 
sediment settled within the well casing. The water sample should be collected immediately after 
completion of the purging.   

Procedure 

1. Upon completion of purging the well, the groundwater sample should be collected into a 
prepared sample bottle.  

2. Fill all sample containers to within at least one inch of the top of the sample container.  
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3.3 Low Yielding Wells 
In some instances the monitoring wells may be installed in very low yielding materials resulting in 
rapid drawdown and complete dewatering. If this occurs wait for sufficient water level recovery, 
~75% of pre-purging water level or within 24 hours, before collecting the sample. In all instances the 
sample should be collected within 24 hours of the initial purging event.    

 
 
4.0 FIELD PARAMETERS 

Using the multi-parameter water quality sensor (EUTECH Instruments PTTester 35 or equivalent), in 
accordance with the user’s manual, measure field pH, total dissolved solids (TDS), and temperature 
(oC) from groundwater collected at the same time as the analyte samples. The field measurements 
should be taken immediately after collection to ensure their accuracy.  

Procedure 

1. Calibrate the multi-parameter water quality sensor prior to each sampling event, if it’s a single 
day event, or each morning of a multiple day sampling event.  Use 3-point calibration process 
(ph of 4.0, 7.0, 10.0).  See manual for calibration procedure. 

2. Purge the well of the required number of well volumes 
3. For parameters that do not require filtering: 

a. Lower pumping rate 
b. Fill appropriate container with raw (unfiltered) water   

4. For parameters that require filtering:  
a. Lower pumping rate  
b. Attach in-line 0.45 µm to the pump tubing 
c. Hold filter upright (discharge up) while filter is saturating 
d. Fill appropriate container 

5. Collect one additional bottle or beaker of water to conduct field measurement.  
6. Immediately after collection, place the multi-parameter water quality sensor into water and 

begin measuring. 
7. Allow values to stabilize and record the measurements on the field sheet and chain of custody.    

 
5.0 SAMPLE PREPARATION 

The sample water will be collected into appropriately labeled bottles based on the sites required analyses. 
The necessary samples will then be preserved before being placed on ice and cooled to approximately 4o 
C. The samples will then either be picked up by a courier or delivered to the laboratory following chain-of-
custody procedures. A list of commonly sampled parameters, preservation requirements, and maximum 
laboratory holding times are provided in the table below.  A list of laboratory sample classifications, 
analytes, required sample volumes, bottle types, and required preservative are provided in the attached 
tables.   

 
Parameters Preservative Temp Max Holding Time 

Metals*, Hardness HNO3  to pH <2 ≤ 6 °C 6 months 
Phenol, Nitrate-N, Phosphorous, 

Total Organic Carbon H2SO4   to pH <2 ≤ 6 °C 28 days 

Cyanide NaOH  to pH >10 ≤ 6 °C 14 days 

Sulfide NaOH w/ ZnAc to pH >9 ≤ 6 °C 7 days 

Acidity, Alkalinity - ≤ 6 °C 14 days 

Sulfate - ≤ 6 °C 28 days 
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Total Suspended Solids,           
Total Dissolved Solids - ≤ 6 °C 7 days 

Low level Mercury Lab Preserves ≤ 6 °C 48 hrs** 
              Note: 
              * Dissolved Metals Require Field Filtration 
                **Time to transport to laboratory 

6.0 CHAIN OF CUSTODY 
The Chain of Custody (COC) is a written legal document used to track the transfer of a sample from 
person to person. It is utilized to guarantee the identity and integrity of a sample from collection 
through reporting of the test result. Thus the COC is formatted to record field information, laboratory 
information, and the people who handle each individual sample. A COC is created for each sampling 
event and is typically a one page document. An individualized COC has been created for each of the 
Midwest mines and includes applicable facility codes, sample location codes, and Peabody sample 
location identification numbers.  Additionally, required field parameters, lab parameters, bottle types, 
and preservatives are included in the box located on the bottom right corner. The COC contains fields 
to enter calibration information for the multi parameter field water quality meter, the sample date/time, 
and all relevant field measurements (ph, TDS, Temp, etc). The COC also contains several signatory 
lines for the relinquishment of custody of the samples and for the receipt of custody of the samples.   

Procedure 
Fill out the appropriate monitoring well COC prior to submittal of samples to the laboratory. Note that 
because of variation between state regulatory agency monitoring requirements not all column 
headers are relevant to every sample type. Where applicable the specific state, or states (IL, IN, KY), 
requiring the parameter is identified.    

1. pH and TDS/Conductivity Meter Calibrated Row 
a. Sample Date and Time 

i. Enter the date and time the meter was calibrated. 
ii. Note: The meter must be calibrated prior to collecting any samples. 

2. Sample Location Row 
a. Sample Date and Time  

i. Enter the date and time of sample collection. 
b. Grab  

i. This column denotes the sample collection methodology and is utilized to 
denote that a sample was collected.  

ii. If a sample was collected mark an “x” in the cell, if sample was not collected 
leave the cell blank.  

c.  # Containers  
i. This column identifies the number of bottles that are shipped/delivered to the 

lab. This cell is utilized by the laboratory to ensure the receipt of all samples.   
1. Mark the number of sample bottles collected at each sample location 

that will be shipped to the lab for analysis.  
d. SWL  

i. Record the measured depth to water from the specified measurement point, 
top of well casing (toc).  

ii. Note: Make sure measurement point used for the measurement matches the 
measurement point identified on the COC.  

e. pH 
i. Record the field measured pH in the cell. 

f. Temp  
i. Record the field measured Temperature in the cell. 

g. TDS  
i. Record the measured field TDS in this cell 
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h. Top of Casing Elevation 
i. Top of well casing measurement point elevation 

1. Used to calculate the measured static water level elevation if 
measurement was taken from TOC.  

i. Surface Elevation  
i. Ground surface elevation at well measurement point 

1. Used to calculate the measured static water level elevation if 
measurement was taken from ground surface measurement point.  

j. Total Depth  
i. Total depth of well.  

1. Reference point is typically from ground surface.  
k. Static Water Elevation  

i. Static water level elevation. Calculated by subtracting measured water level 
from reference point (i.e. top of well casing) from reference point elevation 
(i.e. top of casing elevation).  

l. Sample Type 
i. The required sample type for the sample location is identified in this column 

1. Details of the required field measurements, number of bottles to 
collect, type and size of bottle to use, the necessary preservative, 
and the laboratory analysis required are found in the bottom right 
corner of the COC.    

m. Comments  
i. Any relevant comments should be included here.  
ii. Note: In some instances the screened interval and well stickup (well casing 

extending above ground surface) are provided here.  
n. Gray Cells  

i. Do not record or mark anything in these cells. This acts as a reminder that 
the subject sample point does not require this information.   

o. Signature Row 
i.  Relinquished by 

1. Sign, date, and time the COC upon relinquishing the samples to the 
laboratory technician, laboratory courier, or Peabody personnel.  

ii. Received by 
1. The laboratory technician, laboratory currier, or Peabody personnel 

must sign, date, and time these cells upon receipt of the samples.   
Note 
1. Details of the required field parameters, lab parameters, and bottles for the sample 

types are noted on the bottom right corner of the COC.  
2. Make sure measured units match units listed on the COC 
3. No erroneous information may be erased from the COC. Errors must be lined out with 

a single dash, initialed, and the correction written in.  
4. Review the COC for accuracy prior to relinquishing it.   
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AQTESOLV for Windows Gateway Mine GWM-8 Rising

Data Set:  K:\AQTESOLV\Slug tests\Gateway GWM-8 Rising.aqt
Title:  Gateway Mine GWM-8 Rising
Date:  04/04/14
Time:  15:18:54

PROJECT INFORMATION

Company:  Peabody Coulterville Mining  
Location:  Coulterville, IL
Test Date:  3/20/2012

AQUIFER DATA

Saturated Thickness:  23.84 ft
Anisotropy Ratio (Kz/Kr):  1.

SLUG TEST WELL DATA

Test Well:  GWM-8

X Location:  0. ft
Y Location:  0. ft

Initial Displacement:  9.63 ft
Static Water Column Height:  23.84 ft
Casing Radius:  0.1667 ft
Well Radius:  0.4167 ft
Well Skin Radius:  0.4167 ft
Screen Length:  15. ft
Total Well Penetration Depth:  27.5 ft

No. of Observations:  26

Observation Data
Time (sec) Displacement (ft) Time (sec) Displacement (ft)

0. 9.63 210. 6.29
30. 8.97 225. 6.1
45. 8.75 240. 5.94
60. 8.49 255. 5.75
75. 8.19 270. 5.59
90. 7.97 285. 5.45

105. 7.72 300. 5.28
120. 7.5 450. 4.02
135. 7.28 600. 3.07
150. 7.07 750. 2.38
165. 6.86 900. 1.87
180. 6.67 1200. 1.16
195. 6.46 1500. 0.78

SOLUTION

Slug Test
Aquifer Model:  Unconfined
Solution Method:  Bouwer-Rice
ln(Re/rw):  3.099

VISUAL ESTIMATION RESULTS

Estimated Parameters

Parameter Estimate
K 0.000176 cm/sec
y0 9.576 ft

T = K*b = 0.1279 cm²/sec

04/04/14 1 15:18:54

Attachment 4.5.4 
Revised 04/21/2021

1 of 23



0. 400. 800. 1.2E+3 1.6E+3 2.0E+3
0.01

0.1

1.

Time (sec)

H
/H

o 
(f

t/f
t)

GATEWAY MINE GWM-8 RISING

Data Set:  K:\AQTESOLV\Slug tests\Gateway GWM-8 Rising.aqt
Date:  04/04/14 Time:  15:18:06

PROJECT INFORMATION

Company:  Peabody Coulterville Mining  
Location:  Coulterville, IL
Test Date:  3/20/2012

AQUIFER DATA

Saturated Thickness:  23.84 ft Anisotropy Ratio (Kz/Kr):  1.

WELL DATA (GWM-8)

Initial Displacement:  9.63 ft Static Water Column Height:  23.84 ft
Total Well Penetration Depth:  27.5 ft Screen Length:  15. ft
Casing Radius:  0.1667 ft Well Radius:  0.4167 ft

SOLUTION

Aquifer Model:  Unconfined Solution Method:  Bouwer-Rice

K  = 0.000176 cm/sec y0 = 9.576 ft

Attachment 4.5.4 
Revised 04/21/2021
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AQTESOLV for Windows Gateway Mine GWM-8 Rising

The Error Log identifies errors detected in your data set.
Choose this view when you see the "Check Errors" indicator on the status bar.

No errors detected in data set.

Tips for Analyzing Aquifer Tests with AQTESOLV for Windows
1.  Enter Test Data

Choose options from the Edit menu to enter or modify test data.
2.  Perform Diagnostic Analyses (Optional)

Choose diagnostic flow plot and derivative plot options from the View menu.
3.  Perform Curve Matching or Prediction

Choose the Solution or Toolbox options from the Match menu to perform forward solution analyses (prediction).
Choose the Automatic, Visual or Toolbox options from the Match menu to perform curve matching.

4.  Analysis of Residuals (Optional)
Choose residual plot and diagnostic report options from View menu to evaluate automatic curve fit.

5.  Reporting
Choose Format option from View menu to customize appearance of plots and reports.
Choose Print Preview and Print options from File menu to obtain hardcopy output.

Data Set Summary
Slug Test
Total no. of observations:  26
Range of time readings in obs. well(s):  0 to 1500 sec
Range of displacement readings in obs. well(s):  0.78 to 9.63 ft

04/04/14 1 15:21:06
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AQTESOLV for Windows Gateway Mine GWM-10 Rising

Data Set:  K:\AQTESOLV\Slug tests\Gateway GWM-10 Rising.aqt
Title:  Gateway Mine GWM-10 Rising
Date:  04/04/14
Time:  15:24:48

PROJECT INFORMATION

Company:  Peabody Coulterville Mining  
Location:  Coulterville, IL
Test Date:  3/20/2012

AQUIFER DATA

Saturated Thickness:  25.19 ft
Anisotropy Ratio (Kz/Kr):  1.

SLUG TEST WELL DATA

Test Well:  GWM-10

X Location:  0. ft
Y Location:  0. ft

Initial Displacement:  11.74 ft
Static Water Column Height:  25.19 ft
Casing Radius:  0.08333 ft
Well Radius:  0.3333 ft
Well Skin Radius:  0.3333 ft
Screen Length:  20. ft
Total Well Penetration Depth:  27. ft

No. of Observations:  30

Observation Data
Time (sec) Displacement (ft) Time (sec) Displacement (ft)

0. 11.74 225. 8.78
15. 11.49 240. 8.64
30. 11.25 255. 8.5
45. 11.04 270. 8.35
60. 10.79 285. 8.22
75. 10.59 300. 8.11
90. 10.37 360. 7.64

105. 10.18 420. 7.15
120. 9.99 480. 6.75
135. 9.79 540. 6.35
150. 9.61 606. 5.73
165. 9.41 900. 3.23
180. 9.27 1200. 2.12
195. 9.09 1500. 1.74
210. 8.94 1800. 1.52

SOLUTION

Slug Test
Aquifer Model:  Unconfined
Solution Method:  Bouwer-Rice
ln(Re/rw):  3.332

VISUAL ESTIMATION RESULTS

Estimated Parameters

Parameter Estimate
K 2.173E-5 cm/sec
y0 11.73 ft

T = K*b = 0.01668 cm²/sec

04/04/14 1 15:24:48

Attachment 4.5.4 
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GATEWAY MINE GWM-10 RISING

Data Set:  K:\AQTESOLV\Slug tests\Gateway GWM-10 Rising.aqt
Date:  04/04/14 Time:  15:24:17

PROJECT INFORMATION

Company:  Peabody Coulterville Mining  
Location:  Coulterville, IL
Test Date:  3/20/2012

AQUIFER DATA

Saturated Thickness:  25.19 ft Anisotropy Ratio (Kz/Kr):  1.

WELL DATA (GWM-10)

Initial Displacement:  11.74 ft Static Water Column Height:  25.19 ft
Total Well Penetration Depth:  27. ft Screen Length:  20. ft
Casing Radius:  0.08333 ft Well Radius:  0.3333 ft

SOLUTION

Aquifer Model:  Unconfined Solution Method:  Bouwer-Rice

K  = 2.173E-5 cm/sec y0 = 11.73 ft

Attachment 4.5.4 
Revised 04/21/2021
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AQTESOLV for Windows Gateway Mine GWM-10 Rising

The Error Log identifies errors detected in your data set.
Choose this view when you see the "Check Errors" indicator on the status bar.

No errors detected in data set.

Tips for Analyzing Aquifer Tests with AQTESOLV for Windows
1.  Enter Test Data

Choose options from the Edit menu to enter or modify test data.
2.  Perform Diagnostic Analyses (Optional)

Choose diagnostic flow plot and derivative plot options from the View menu.
3.  Perform Curve Matching or Prediction

Choose the Solution or Toolbox options from the Match menu to perform forward solution analyses (prediction).
Choose the Automatic, Visual or Toolbox options from the Match menu to perform curve matching.

4.  Analysis of Residuals (Optional)
Choose residual plot and diagnostic report options from View menu to evaluate automatic curve fit.

5.  Reporting
Choose Format option from View menu to customize appearance of plots and reports.
Choose Print Preview and Print options from File menu to obtain hardcopy output.

Data Set Summary
Slug Test
Total no. of observations:  30
Range of time readings in obs. well(s):  0 to 1800 sec
Range of displacement readings in obs. well(s):  1.52 to 11.74 ft

04/04/14 1 15:25:19

Attachment 4.5.4 
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AQTESOLV for Windows Gateway Mine W3-11 Rising Head 

Data Set:  K:\AQTESOLV\Slug tests\Gateway W3-11 Rising.aqt
Title:  Gateway Mine W3-11 Rising Head 
Date:  05/03/13
Time:  15:10:06

PROJECT INFORMATION

Company:  Peabody Coulterville Mining
Location:  Coulterville, IL
Test Date:  3/20/2012

AQUIFER DATA

Saturated Thickness:  32.95 ft
Anisotropy Ratio (Kz/Kr):  1.

SLUG TEST WELL DATA

Test Well:  W3-11

X Location:  0. ft
Y Location:  0. ft

Initial Displacement:  13.17 ft
Static Water Column Height:  32.95 ft
Casing Radius:  0.083 ft
Well Radius:  0.333 ft
Well Skin Radius:  0.333 ft
Screen Length:  30. ft
Total Well Penetration Depth:  34. ft

No. of Observations:  35

Observation Data
Time (sec) Displacement (ft) Time (sec) Displacement (ft)

0. 13.17 270. 9.48
15. 12.94 285. 9.29
30. 12.69 300. 9.13
45. 12.39 315. 8.93
60. 12.21 330. 8.75
75. 12.06 345. 8.57
90. 11.87 360. 8.36

105. 11.68 390. 7.94
120. 11.49 420. 7.66
135. 11.27 450. 7.41
150. 11.06 480. 7.24
165. 10.83 540. 6.88
180. 10.63 600. 6.46
195. 10.41 900. 2.73
210. 10.23 1200. 1.49
225. 10.03 1500. 1.02
240. 9.86 1800. 0.79
255. 9.65

SOLUTION

Slug Test
Aquifer Model:  Unconfined
Solution Method:  Bouwer-Rice
ln(Re/rw):  3.542

VISUAL ESTIMATION RESULTS

Estimated Parameters

Parameter Estimate
K 1.718E-5 cm/sec

05/03/13 1 15:10:06

Attachment 4.5.4 
Revised 04/21/2021
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GATEWAY MINE W3-11 RISING HEAD 

Data Set:  K:\AQTESOLV\Slug tests\Gateway W3-11 Rising.aqt
Date:  05/03/13 Time:  15:10:35

PROJECT INFORMATION

Company:  Peabody Coulterville Mining
Location:  Coulterville, IL
Test Date:  3/20/2012

AQUIFER DATA

Saturated Thickness:  32.95 ft Anisotropy Ratio (Kz/Kr):  1.

WELL DATA (W3-11)

Initial Displacement:  13.17 ft Static Water Column Height:  32.95 ft
Total Well Penetration Depth:  34. ft Screen Length:  30. ft
Casing Radius:  0.083 ft Well Radius:  0.333 ft

SOLUTION

Aquifer Model:  Unconfined Solution Method:  Bouwer-Rice

K  = 1.718E-5 cm/sec y0 = 13.61 ft

Attachment 4.5.4 
Revised 04/21/2021
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AQTESOLV for Windows Gateway Mine W3-11 Rising Head 

The Error Log identifies errors detected in your data set.
Choose this view when you see the "Check Errors" indicator on the status bar.

No errors detected in data set.

Tips for Analyzing Aquifer Tests with AQTESOLV for Windows
1.  Enter Test Data

Choose options from the Edit menu to enter or modify test data.
2.  Perform Diagnostic Analyses (Optional)

Choose diagnostic flow plot and derivative plot options from the View menu.
3.  Perform Curve Matching or Prediction

Choose the Solution or Toolbox options from the Match menu to perform forward solution analyses (prediction).
Choose the Automatic, Visual or Toolbox options from the Match menu to perform curve matching.

4.  Analysis of Residuals (Optional)
Choose residual plot and diagnostic report options from View menu to evaluate automatic curve fit.

5.  Reporting
Choose Format option from View menu to customize appearance of plots and reports.
Choose Print Preview and Print options from File menu to obtain hardcopy output.

Data Set Summary
Slug Test
Total no. of observations:  35
Range of time readings in obs. well(s):  0 to 1800 sec
Range of displacement readings in obs. well(s):  0.79 to 13.17 ft

05/03/13 1 15:09:38
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AQTESOLV for Windows Gateway Mine W3-12 Rising

Data Set:  K:\AQTESOLV\Slug tests\Gateway W3-12 Rising.aqt
Title:  Gateway Mine W3-12 Rising
Date:  05/03/13
Time:  15:19:01

PROJECT INFORMATION

Company:  Peabody Coulterville Mining  
Location:  Coulterville, IL
Test Date:  3/20/2012

AQUIFER DATA

Saturated Thickness:  29.66 ft
Anisotropy Ratio (Kz/Kr):  1.

SLUG TEST WELL DATA

Test Well:  W3-12

X Location:  0. ft
Y Location:  0. ft

Initial Displacement:  10.2 ft
Static Water Column Height:  29.66 ft
Casing Radius:  0.083 ft
Well Radius:  0.333 ft
Well Skin Radius:  0.333 ft
Screen Length:  30. ft
Total Well Penetration Depth:  33. ft

No. of Observations:  31

Observation Data
Time (sec) Displacement (ft) Time (sec) Displacement (ft)

0. 10.2 270. 8.39
15. 10.03 285. 8.3
30. 9.94 300. 8.24
45. 9.84 315. 8.14
60. 9.7 330. 8.05
75. 9.57 345. 7.97
90. 9.45 360. 7.91

105. 9.33 420. 7.61
120. 9.26 480. 7.36
135. 9.17 540. 7.09
180. 8.92 600. 6.86
195. 8.82 900. 5.8
210. 8.73 1215. 4.86
225. 8.64 1800. 3.62
240. 8.56 2700. 2.36
255. 8.46

SOLUTION

Slug Test
Aquifer Model:  Unconfined
Solution Method:  Bouwer-Rice
ln(Re/rw):  3.521

VISUAL ESTIMATION RESULTS

Estimated Parameters

Parameter Estimate
K 8.312E-6 cm/sec
y0 10.04 ft

05/03/13 1 15:19:01

Attachment 4.5.4 
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GATEWAY MINE W3-12 RISING

Data Set:  K:\AQTESOLV\Slug tests\Gateway W3-12 Rising.aqt
Date:  05/03/13 Time:  15:19:26

PROJECT INFORMATION

Company:  Peabody Coulterville Mining  
Location:  Coulterville, IL
Test Date:  3/20/2012

AQUIFER DATA

Saturated Thickness:  29.66 ft Anisotropy Ratio (Kz/Kr):  1.

WELL DATA (W3-12)

Initial Displacement:  10.2 ft Static Water Column Height:  29.66 ft
Total Well Penetration Depth:  33. ft Screen Length:  30. ft
Casing Radius:  0.083 ft Well Radius:  0.333 ft

SOLUTION

Aquifer Model:  Unconfined Solution Method:  Bouwer-Rice

K  = 8.312E-6 cm/sec y0 = 10.04 ft

Attachment 4.5.4 
Revised 04/21/2021
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AQTESOLV for Windows Gateway Mine W3-12 Rising

The Error Log identifies errors detected in your data set.
Choose this view when you see the "Check Errors" indicator on the status bar.

No errors detected in data set.

Tips for Analyzing Aquifer Tests with AQTESOLV for Windows
1.  Enter Test Data

Choose options from the Edit menu to enter or modify test data.
2.  Perform Diagnostic Analyses (Optional)

Choose diagnostic flow plot and derivative plot options from the View menu.
3.  Perform Curve Matching or Prediction

Choose the Solution or Toolbox options from the Match menu to perform forward solution analyses (prediction).
Choose the Automatic, Visual or Toolbox options from the Match menu to perform curve matching.

4.  Analysis of Residuals (Optional)
Choose residual plot and diagnostic report options from View menu to evaluate automatic curve fit.

5.  Reporting
Choose Format option from View menu to customize appearance of plots and reports.
Choose Print Preview and Print options from File menu to obtain hardcopy output.

Data Set Summary
Slug Test
Total no. of observations:  31
Range of time readings in obs. well(s):  0 to 2700 sec
Range of displacement readings in obs. well(s):  2.36 to 10.2 ft

05/03/13 1 15:18:38
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AQTESOLV for Windows Gateway Mine W3-13 Rising 

Data Set:  K:\AQTESOLV\Slug tests\Gateway W3-13 Rising.aqt
Title:  Gateway Mine W3-13 Rising 
Date:  05/03/13
Time:  15:20:46

PROJECT INFORMATION

Company:  Peabody Coulterville Mining  
Location:  Coulterville, IL
Test Date:  3/20/2012

AQUIFER DATA

Saturated Thickness:  26.27 ft
Anisotropy Ratio (Kz/Kr):  1.

SLUG TEST WELL DATA

Test Well:  W3-13

X Location:  0. ft
Y Location:  0. ft

Initial Displacement:  9.67 ft
Static Water Column Height:  26.27 ft
Casing Radius:  0.083 ft
Well Radius:  0.333 ft
Well Skin Radius:  0.333 ft
Screen Length:  20. ft
Total Well Penetration Depth:  27. ft

No. of Observations:  39

Observation Data
Time (sec) Displacement (ft) Time (sec) Displacement (ft)

0. 9.67 300. 4.88
15. 9.49 315. 4.34
30. 9.22 330. 4.06
45. 8.96 345. 3.73
60. 8.72 360. 3.46
75. 8.47 375. 3.24
90. 8.26 390. 3.08

105. 8.04 405. 2.95
120. 7.77 420. 2.84
135. 7.56 435. 2.75
150. 7.37 450. 2.71
165. 7.12 465. 2.68
180. 6.89 480. 2.65
195. 6.66 510. 2.6
210. 6.51 600. 2.45
225. 6.29 900. 1.4
240. 6.18 918. 1.37
255. 6.03 1200. 0.94
270. 5.85 1500. 0.72
285. 5.3

SOLUTION

Slug Test
Aquifer Model:  Unconfined
Solution Method:  Bouwer-Rice
ln(Re/rw):  3.333

VISUAL ESTIMATION RESULTS

Estimated Parameters

05/03/13 1 15:20:46
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GATEWAY MINE W3-13 RISING 

Data Set:  K:\AQTESOLV\Slug tests\Gateway W3-13 Rising.aqt
Date:  05/03/13 Time:  15:21:05

PROJECT INFORMATION

Company:  Peabody Coulterville Mining  
Location:  Coulterville, IL
Test Date:  3/20/2012

AQUIFER DATA

Saturated Thickness:  26.27 ft Anisotropy Ratio (Kz/Kr):  1.

WELL DATA (W3-13)

Initial Displacement:  9.67 ft Static Water Column Height:  26.27 ft
Total Well Penetration Depth:  27. ft Screen Length:  20. ft
Casing Radius:  0.083 ft Well Radius:  0.333 ft

SOLUTION

Aquifer Model:  Unconfined Solution Method:  Bouwer-Rice

K  = 3.486E-5 cm/sec y0 = 9.941 ft

Attachment 4.5.4 
Revised 04/21/2021
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AQTESOLV for Windows Gateway Mine W3-13 Rising 

The Error Log identifies errors detected in your data set.
Choose this view when you see the "Check Errors" indicator on the status bar.

No errors detected in data set.

Tips for Analyzing Aquifer Tests with AQTESOLV for Windows
1.  Enter Test Data

Choose options from the Edit menu to enter or modify test data.
2.  Perform Diagnostic Analyses (Optional)

Choose diagnostic flow plot and derivative plot options from the View menu.
3.  Perform Curve Matching or Prediction

Choose the Solution or Toolbox options from the Match menu to perform forward solution analyses (prediction).
Choose the Automatic, Visual or Toolbox options from the Match menu to perform curve matching.

4.  Analysis of Residuals (Optional)
Choose residual plot and diagnostic report options from View menu to evaluate automatic curve fit.

5.  Reporting
Choose Format option from View menu to customize appearance of plots and reports.
Choose Print Preview and Print options from File menu to obtain hardcopy output.

Data Set Summary
Slug Test
Total no. of observations:  39
Range of time readings in obs. well(s):  0 to 1500 sec
Range of displacement readings in obs. well(s):  0.72 to 9.67 ft

05/03/13 1 15:20:29
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AQTESOLV for Windows Gateway Mine W3-16 Falling Head 

Data Set:  K:\AQTESOLV\Slug tests\Gateway W3-16 Falling.aqt
Title:  Gateway Mine W3-16 Falling Head 
Date:  05/18/15
Time:  14:14:18

PROJECT INFORMATION

Company:  Peabody Coulterville Mining
Location:  Coulterville, IL
Test Date:  5/14/2015

AQUIFER DATA

Saturated Thickness:  36.69 ft
Anisotropy Ratio (Kz/Kr):  1.

SLUG TEST WELL DATA

Test Well:  W3-16

X Location:  0. ft
Y Location:  0. ft

Initial Displacement:  1.25 ft
Static Water Column Height:  36.69 ft
Casing Radius:  0.083 ft
Well Radius:  0.333 ft
Well Skin Radius:  0.333 ft
Screen Length:  26. ft
Total Well Penetration Depth:  38. ft

No. of Observations:  49

Observation Data
Time (sec) Displacement (ft) Time (sec) Displacement (ft)

0. 1.25 250. 0.22
10. 1.15 260. 0.21
20. 1.06 270. 0.19
30. 0.98 280. 0.19
40. 0.9 290. 0.17
50. 0.84 300. 0.16
60. 0.78 310. 0.15
70. 0.73 320. 0.15
80. 0.67 330. 0.14
90. 0.63 340. 0.13

100. 0.58 350. 0.12
110. 0.54 360. 0.12
120. 0.51 370. 0.11
130. 0.47 380. 0.11
140. 0.43 390. 0.1
150. 0.41 400. 0.1
160. 0.38 410. 0.1
170. 0.36 420. 0.09
180. 0.34 430. 0.09
190. 0.31 440. 0.09
200. 0.3 450. 0.08
210. 0.28 460. 0.08
220. 0.26 470. 0.08
230. 0.24 480. 0.07
240. 0.23

SOLUTION

Slug Test
Aquifer Model:  Unconfined
Solution Method:  Bouwer-Rice
ln(Re/rw):  3.591

05/18/15 1 14:14:18
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AQTESOLV for Windows Gateway Mine W3-16 Falling Head 

VISUAL ESTIMATION RESULTS

Estimated Parameters

Parameter Estimate
K 9.968E-5 cm/sec
y0 1.15 ft

T = K*b = 0.1115 cm²/sec

05/18/15 2 14:14:18
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GATEWAY MINE W3-16 FALLING HEAD 

Data Set:  K:\AQTESOLV\Slug tests\Gateway W3-16 Falling.aqt
Date:  05/18/15 Time:  14:14:01

PROJECT INFORMATION

Company:  Peabody Coulterville Mining
Location:  Coulterville, IL
Test Date:  5/14/2015

AQUIFER DATA

Saturated Thickness:  36.69 ft Anisotropy Ratio (Kz/Kr):  1.

WELL DATA (W3-16)

Initial Displacement:  1.25 ft Static Water Column Height:  36.69 ft
Total Well Penetration Depth:  38. ft Screen Length:  26. ft
Casing Radius:  0.083 ft Well Radius:  0.333 ft

SOLUTION

Aquifer Model:  Unconfined Solution Method:  Bouwer-Rice

K  = 9.968E-5 cm/sec y0 = 1.15 ft

Attachment 4.5.4 
Revised 04/21/2021
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AQTESOLV for Windows Gateway Mine W3-16 Falling Head 

The Error Log identifies errors detected in your data set.
Choose this view when you see the "Check Errors" indicator on the status bar.

No errors detected in data set.

Tips for Analyzing Aquifer Tests with AQTESOLV for Windows
1.  Enter Test Data

Choose options from the Edit menu to enter or modify test data.
2.  Perform Diagnostic Analyses (Optional)

Choose diagnostic flow plot and derivative plot options from the View menu.
3.  Perform Curve Matching or Prediction

Choose the Solution or Toolbox options from the Match menu to perform forward solution analyses (prediction).
Choose the Automatic, Visual or Toolbox options from the Match menu to perform curve matching.

4.  Analysis of Residuals (Optional)
Choose residual plot and diagnostic report options from View menu to evaluate automatic curve fit.

5.  Reporting
Choose Format option from View menu to customize appearance of plots and reports.
Choose Print Preview and Print options from File menu to obtain hardcopy output.

Data Set Summary
Slug Test
Total no. of observations:  49
Range of time readings in obs. well(s):  0 to 480 sec
Range of displacement readings in obs. well(s):  0.07 to 1.25 ft

05/18/15 1 14:14:32
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AQTESOLV for Windows Gateway Mine W3-16 Rising Head 

Data Set:  K:\AQTESOLV\Slug tests\Gateway W3-16 Rising.aqt
Title:  Gateway Mine W3-16 Rising Head 
Date:  05/18/15
Time:  14:12:47

PROJECT INFORMATION

Company:  Peabody Coulterville Mining
Location:  Coulterville, IL
Test Date:  5/14/2015

AQUIFER DATA

Saturated Thickness:  36.69 ft
Anisotropy Ratio (Kz/Kr):  1.

SLUG TEST WELL DATA

Test Well:  W3-16

X Location:  0. ft
Y Location:  0. ft

Initial Displacement:  1.4 ft
Static Water Column Height:  36.69 ft
Casing Radius:  0.083 ft
Well Radius:  0.333 ft
Well Skin Radius:  0.333 ft
Screen Length:  26. ft
Total Well Penetration Depth:  38. ft

No. of Observations:  47

Observation Data
Time (sec) Displacement (ft) Time (sec) Displacement (ft)

1. 1.4 240. 0.27
10. 1.31 250. 0.26
20. 1.21 260. 0.24
30. 1.12 270. 0.23
40. 1.04 280. 0.21
50. 0.96 290. 0.2
60. 0.89 300. 0.2
70. 0.83 310. 0.18
80. 0.78 320. 0.17
90. 0.72 330. 0.16

100. 0.67 340. 0.15
110. 0.63 350. 0.14
120. 0.58 360. 0.14
130. 0.55 370. 0.13
140. 0.51 380. 0.12
150. 0.48 390. 0.12
160. 0.45 400. 0.11
170. 0.42 410. 0.11
180. 0.39 420. 0.11
190. 0.37 430. 0.1
200. 0.35 440. 0.09
210. 0.32 450. 0.09
220. 0.31 460. 0.09
230. 0.29

SOLUTION

Slug Test
Aquifer Model:  Unconfined
Solution Method:  Bouwer-Rice
ln(Re/rw):  3.591

05/18/15 1 14:12:47
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AQTESOLV for Windows Gateway Mine W3-16 Rising Head 

VISUAL ESTIMATION RESULTS

Estimated Parameters

Parameter Estimate
K 9.804E-5 cm/sec
y0 1.33 ft

T = K*b = 0.1096 cm²/sec

05/18/15 2 14:12:47
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GATEWAY MINE W3-16 RISING HEAD 

Data Set:  K:\AQTESOLV\Slug tests\Gateway W3-16 Rising.aqt
Date:  05/18/15 Time:  14:12:29

PROJECT INFORMATION

Company:  Peabody Coulterville Mining
Location:  Coulterville, IL
Test Date:  5/14/2015

AQUIFER DATA

Saturated Thickness:  36.69 ft Anisotropy Ratio (Kz/Kr):  1.

WELL DATA (W3-16)

Initial Displacement:  1.4 ft Static Water Column Height:  36.69 ft
Total Well Penetration Depth:  38. ft Screen Length:  26. ft
Casing Radius:  0.083 ft Well Radius:  0.333 ft

SOLUTION

Aquifer Model:  Unconfined Solution Method:  Bouwer-Rice

K  = 9.804E-5 cm/sec y0 = 1.33 ft
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AQTESOLV for Windows Gateway Mine W3-16 Rising Head 

The Error Log identifies errors detected in your data set.
Choose this view when you see the "Check Errors" indicator on the status bar.

No errors detected in data set.

Tips for Analyzing Aquifer Tests with AQTESOLV for Windows
1.  Enter Test Data

Choose options from the Edit menu to enter or modify test data.
2.  Perform Diagnostic Analyses (Optional)

Choose diagnostic flow plot and derivative plot options from the View menu.
3.  Perform Curve Matching or Prediction

Choose the Solution or Toolbox options from the Match menu to perform forward solution analyses (prediction).
Choose the Automatic, Visual or Toolbox options from the Match menu to perform curve matching.

4.  Analysis of Residuals (Optional)
Choose residual plot and diagnostic report options from View menu to evaluate automatic curve fit.

5.  Reporting
Choose Format option from View menu to customize appearance of plots and reports.
Choose Print Preview and Print options from File menu to obtain hardcopy output.

Data Set Summary
Slug Test
Total no. of observations:  47
Range of time readings in obs. well(s):  1 to 460 sec
Range of displacement readings in obs. well(s):  0.09 to 1.4 ft

05/18/15 1 14:13:09
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PEABODY ENERGY - MIDWEST 

SAMPLING AND ANALYSIS PLAN 
Surface Water 

Revised: January 2021 
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SURFACE WATER SAMPLING METHODS 
This section describes the general procedures and methodologies used when conducting surface water 
sampling.   

1.0 GRAB SAMPLING METHOD 
Grab sampling involves lowering the sample bottle directly into the water body when collecting the 
sample and is effective for still water (ponds, lakes) and flowing water (streams) sites. The sample 
may be collected from within the water body or from the bank of the water body, provided the 
collector can reach the main flow of the stream or far enough within the still water body to completely 
lower the bottle beneath the water surface. A telescoping rod with a clean sample bottle affixed to it 
may be used to extend the collectors reach. 

1.1 STREAM AND SEDIMENT BASIN OUTFALL SAMPLING 
When sampling stream or sediment basin outfalls an effort will be made to collect the sample 
from within the main flow of the channel. When sampling from within the water body the sample 
bottle will be lowered to just beneath the surface of the water while facing upstream (i.e. stand 
downstream of the sampling point). Care must be taken to avoid collecting particulates re-
suspended as a result of wading into position or bumping the sample bottle on the streambed. 
Under low flow conditions where discharge is to low to safely sample without disturbing the 
streambed sediment, boulders or rocks may be excavated allowing for sample collection from the 
remaining depression. Sufficient time must be allowed for the disturbed sediments to settle before 
sample collection within the newly formed depression. Many of the chemical constituent’s 
analyzed for sorb onto suspended materials, thus collection of re-suspended particles will likely 
result in falsely elevated analyte concentrations.  

Procedure 

1. Obtain bottles to be used at site.
2. Approach sampling site. If required to enter stream for sample, wade into stream

downstream of site in order to not stir up stream bed sediments.
3. While facing upstream remove bottle cap and insert bottle into the main flow of the

channel just below the surface of the water, making sure to avoid surface debris and to fill
the bottle completely.

4. Recap the sample bottle and repeat as necessary until all bottles are filled.

1.2 PONDS AND LAKES 
Surface water body samples may be collected from within the water body or from the bank using 
a telescoping rod with a clean sample bottle affixed to it. When sampling from within the water 
body lower the bottle to just under the surface of the water filling the bottle completely. Care must 
be taken to avoid collecting particulates re-suspended as a result of wading into position or 
bumping the sample bottle on the pond/lake water bottom. Many of the chemical constituent’s 
analyzed for sorb onto suspended materials, thus collection of re-suspended particles will likely 
result in falsely elevated analyte concentrations.   

Procedure 

1. Obtain bottles to be used at site.
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2. Approach sampling site. If required to enter water body for sample, take care not to stir
up sediments on pond/lake bottom.

3. Remove bottle cap and insert bottle into the water body just below the surface of the
water, making sure to avoid surface debris and to fill the bottle completely.

4. Recap the sample bottle and repeat as necessary until all bottles are filled.

2.0 FIELD MEASUREMENTS 
Using the multi-parameter water quality sensor (EUTECH Instruments PTTester 35 or equivalent), in 
accordance with the users manual, measure field pH and temperature at outfalls and field pH, 
temperature, and total dissolved solids (TDS) or Specific Conductivity at stream sites and ponds 
depending on permit requirements. Field measurements from surface water bodies should be made 
insitu at the location of the water quality sample or from an additional sample container if it is not 
possible to safely enter the stream or water body. Temperature of the water can change rapidly 
therefore if it is not possible to measure the field parameters insitu then it is important the 
measurements be made immediately after removal from the water body. Discharge measurement 
procedures for sediment basin outfalls and streams are found below in section 3.0.  

Procedure 

1. Calibrate the multi-parameter water quality sensor prior to each sampling event, if it’s a single
day event, or each morning of a multiple day sampling event (see manual).

2. Collect field measurement of pH, TDS, and temperature by placing meter into the same
channel of flow or from an additional sample bottle immediately after collection.

3. Allow values to stabilize and record the measurements.

3.0 STREAM DISCHARGE 
An estimate of stream discharge must be made during all stream and outfall sampling events. Stream 
discharge can be measured using the float method or by relating the river stage on an installed staff 
gage to a previously determined, location specific, rating curve.  

3.1 FLOAT METHOD 
Discharge is calculated by multiplying the cross-sectional area of the stream by the streams 
velocity at the sampling location. 

Procedure 

1. Measure the width of the channel at the sampling location (in feet).
2. Measure the average depth of the channel at the sampling location (in feet).
3. Measure two points equal distance upstream and downstream of the sample location.
4. Deploy a buoyant object into the stream channel (such as apple core) and record the

time (in seconds) it takes for the object to float the distance measured in number 3.
5. Multiply the stream width (ft), average depth (ft), and velocity (ft/sec)
6. Record value on field sheet and chain of custody.

3.2 RATING CURVE 
A visual observation of the stream stage relative to an installed staff gage is made by 
recording the height of the water level on the staff gage. A rating curve, previously developed 
by measuring stream discharge under various flow regimes, is then used to estimate the 
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current discharge by relating the current gage height water level to the estimated discharge 
determined from the curve.     

Procedure 

1. Locate installed staff gauge.
2. Stretch a measuring tape across the width of the channel, keeping it perpendicular to

flow.
a. Anchor tape to ensure it’s taught.

3. Using a staff and rod establish the reference point on the left bank. The left bank is
the edge of the water when facing downstream.

4. Starting on the left bank measure the depth of the stream channel (ft) at previously
determined increments and any breaks (depth changes) within the channel.
a. Make sure to identifying the location of the left edge of water, the location of the

installed staff gauge, and the location of the right edge of water.
5. Using a wading rod with attached current meter measure the flow velocity at several

intervals across channel (see manufacturers owners manual for operation of meter).
a. If water level is less than 2.5 ft then measure velocity at 60% of the total depth,

when measured from the surface of the water.
b. If water level is greater than 2.5 ft then measure velocity at 20% and 80% of the

total depth, when measured from the surface of the water.
6. At each interval record the distance from left edge of the water, depth of water,

observation depth (0.6 or 0.2 and 0.8) and measured flow.

4.0 SETTLEABLE SOLIDS ANALYSIS 
Settleable solids analysis will be conducted by field personnel and will follow EPA Method 160.5. The 
settleable solids test is the measurement of the volume of solids that will settle to the bottom of an 
Imhoff cone over a one hour time period. The test indicates the volume of solids removed by settling 
in the sedimentation ponds and provides information on how this process is functioning within the 
system. An, unfiltered, one liter sample will be collected from the sampling point following the 
appropriate sampling protocol (see Section 1.0). The analysis should be conducted upon returning to 
the office and must be completed within the 48 hours maximum holding time. A list of the required 
equipment and methods follows:  

Equipment 

1. Imhoff cone
2. Stirring rod
3. Imhoff cone rack
4. Timer
 

Procedure 

1. Fill the Imhoff cone to the one-liter mark with the well mixed sample previously collected.
2. Allow sample to settle in Imhoff cone for 45 minutes
3. Gently stir the sample with the stirring rod to release suspended matter clinging to the sides

of the Imhoff cone.
4. Let sample settle for an additional 15 minutes.
5. At the one hour mark, record the volume of settleable solids (in milliliters) in the Imhoff cone.

Note 
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1. Do not include any floating solids or any voids in the settled solids as settleable 
matter. 

2. The lower limit of reportable concentration is 0.2 ml/l, not 0.4 ml/l. Thus all values over 
0.2 ml/l must be reported as a number, not as <0.4 ml/l. A table of proper reporting 
under varying concentrations follows:  

 
 

 

Measured Value           
ml/l 

Reported Value          
ml/l 

0 – 0.19 <0.2 
0.2 0.2 
0.3 0.3 
0.4 0.4 
0.5 0.5 

 
 

5.0 LOW-LEVEL MERCURY 
Sampling for low-level mercury requires the use of the clean hands/dirty hands method, as 
established by EPA Method 1669, to limit sample contamination. In this method one sampler acting 
as clean hands conducts all operations involving contact with the sample bottle and sample collection 
while the other acting as dirty hands is responsible for the preparation of all activities that do not 
involve direct contact with the sample container. Because of the potential for contamination it is 
recommended that the sampling team collect the sample upwind if possible and avoid (as much as 
possible) airborne particles such as dust, dirt, particulate matter, vapors from automobile exhaust and 
cigarette smoke, and nearby corroded or rusted bridges, pipes, poles, or wires. If sampling near a 
road attempt to sample during low traffic hours. Avoid breathing on the sample. Attempt to sample 
during low traffic hours if near road. Also avoid areas nearby with bare soil that are subject to wind 
erosion. 

 Procedure 
 

1. Samplers must wear talc free gloves.  
2. Dirty Hands removes the sampling kit from the cooler, then opens and holds the outer bag 
3. First collect the field blank. 

a. Clean hands retrieves and removes the field blank bottle and distilled water bottle from 
their inner bags.  

b. Clean hands then fills the field blank container with the deionized water, taking care not 
to overfill it.  

c. Clean hands then closes the field blank bottles lid, returns the bottle to the inner bag, 
reseals the bag, and then inserts the sealed bag into the outer bag being held by dirty 
hands.  

4. Second collect the sample 
a. Clean hands retrieves and removes the sample from its inner bag.  
b. Clean hands then fills the sample container by completely submerging bottle beneath the 

water, then inverting the bottle and capping it underneath the water to limit exposure to 
air.  

c. Clean hands then returns the bottle to the inner bag, reseals the bag, and then inserts the 
sealed bag into the outer bag being held by dirty hands.  

5. Dirty Hands then seals the outer bag, labels it accordingly and inserts it into the cooler.  
6. The lab will preserve samples and filter dissolved species as necessary.  
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7. Samples must be delivered to the lab within 48 hours of collection.  
 
 

6.0 SAMPLE PREPARATION 
The sample water will be collected into appropriately labeled bottles based on the sites required 
analyses. The necessary samples will then be preserved and filtered within 15 minutes of collection, 
before being placed on ice and cooled to approximately 4o C. The samples will then either be picked up 
by a courier or delivered to the laboratory following chain-of-custody procedures. A list of commonly 
sampled parameters, preservation requirements, and maximum laboratory holding times are provided in 
the table below.  A list of laboratory sample classifications, analytes, required sample volumes, bottle 
types, and required preservative are provided in the attached tables.   

 

Parameters Preservative Temp Max Holding 
Time 

Metals*, Hardness HNO3  to pH <2 ≤ 6 °C 6  months 
Phenol, Nitrate-N, Phosphorous, 

Total Organic Carbon H2SO4   to pH <2 ≤ 6 °C 28 days 

Cyanide NaOH  to pH >10 ≤ 6 °C 14 days 

Sulfide NaOH w/ ZnAc to pH >9 ≤ 6 °C 7 days 

Acidity, Alkalinity - ≤ 6 °C 14 days 

Sulfate - ≤ 6 °C 28 days 
Total Suspended Solids,           
Total Dissolved Solids - ≤ 6 °C 7 days 

Low level Mercury Lab Preserves ≤ 6 °C 48 hrs** 
              Note: 
              * Dissolved Metals Require Field Filtration 
                **Time to transport to laboratory 
 

7.0 FIELD OBSERVATIONS 
Field observations will be recorded in either a field notebook or in the comments or notes section of 
the Chain of Custody (COC). Observations will include information about conditions that could impact 
the results of the sampled water quality. These include, but are not limited to, items such as wildlife 
activity, beaver dams, flooding or backwater, and algae. Discharges from the site shall not cause 
excessive foam, a visible film or sheen, or contain any substance in significant enough quantities to 
be unsightly or deleterious or produce color, odor, or other conditions to such a degree as to create a 
nuisance within the receiving waters. An observation of these conditions in the field will be noted.  
 

8.0 CHAIN OF CUSTODY 
The Chain of Custody (COC) is a written legal document used to track the transfer of a sample from 
person to person. It is utilized to guarantee the identity and integrity of a sample from collection 
through reporting of the test result. Thus the COC is formatted to record field information, laboratory 
information, and the people who handle each individual sample. A COC is created for each sampling 
event and is typically a one page document. An individualized COC has been created for each of the 
Midwest mines and includes applicable facility codes, sample location codes, and Peabody sample 
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location identification numbers.  Additionally, required field parameters, lab parameters, bottle types, 
and preservatives are included in the box located on the bottom right corner. The COC contains 
places to enter calibration information for the multi parameter field water quality meter, the sample 
date/time, and all relevant field measurements (ph, TDS, Temp, etc). The COC also contains several 
signatory lines for the relinquishment of custody of the samples and for the receipt of custody of the 
samples.   

Procedure 
 
Fill out the appropriate NPDES outfall or stream sample point COC prior to submittal of samples to 
the laboratory. Note that because of variation between state regulatory agency monitoring 
requirements not all column headers are relevant to every sample type. Where applicable the specific 
sample type (i.e. NPDES outfall or stream) or state (IL, IN, KY) requiring the parameter is identified.    

1. pH and TDS/Conductivity Meter Calibrated Row 
a. Sample Date and Time 

i. Enter the date and time the meter was calibrated. 
ii. Note: The meter must be calibrated prior to collecting any samples. 

2. Sample Location Row 
a. Sample Date and Time  

i. Enter the date and time of sample collection. 
b. Grab  

i. This column denotes the sample collection methodology and is utilized to 
denote that a sample was collected.  

ii. If a sample was collected mark an “x” in the cell, if sample was not collected 
leave the cell blank.  

c.  # Containers  
i. This column identifies the number of bottles that are shipped/delivered to the 

lab. This cell is utilized by the laboratory to ensure the receipt of all samples.   
1. Mark the number of sample bottles collected at each sample location 

that will be shipped to the lab for analysis.  
2. DO NOT record bottles that will not be shipped to the lab (i.e. 

settleable solids which must be analyzed by the sampler). 
d. Flow Condition (NPDES Outfalls Illinois) 

i. Record the flow condition (1 - 4) in this cell. 
ii. Note: If sample is collected under precipitation conditions (i.e. condition 2 or 

3) then the precipitation event statistics (Date ppt event started and ended, 
Rainfall total) must be recorded. Event statistics should be recorded in the 
designated section located in the box on the bottom right corner of the COC.   

e. Flow  
i. Record the measured flow at the outfall of the basin or the stream sampling 

point in the cell. If there is no flow record a zero in the cell.  
ii. Note: Make sure units used for the measurement match the units identified 

on the COC. If not convert units prior to recording the flow in the cell.    
f. pH 

i. Under flowing condition record the field measured pH in the cell. 
ii. Under no flow conditions leave the cell blank.  

g. Temp  
i. Under flowing condition record the field measured Temperature in the cell. 
ii. Under no flow conditions leave the cell blank.  

h. TDS  
i. Under flowing conditions record the measured TDS in this cell 
ii. Under no flow conditions leave the cell blank.  
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i. Settleable Solids (NPDES Outfalls and Stormwater) 
i. If settleable solids are required for the sample type, record the measured 

value in the cell.  
ii. If settleable solids are not required for the sample type, leave the cell blank.   
iii. Note: Signature on COC is verification that the sampler conducted the field 

test following EPA Method 160.5 and affirms the result.  
j. Sample Type 

i. The required sample type for the sample location is identified in this column 
1. Details of the required field measurements, number of bottles to 

collect, type and size of bottle to use, the necessary preservative, 
and the laboratory analysis required are found in the bottom right 
corner of the COC.    

k. Comments  
i. Any relevant comments should be included here. See Section 7 Field 

Observations. 
ii. Note: If an unconstructed comment is included in the cell then a sample date 

and time must be included for the relevant sample row. This documents that 
that outfall was not constructed on that date.  

l. Gray Cells  
i. Do not record or mark anything in these cells. This acts as a reminder that 

the subject sample point does not require this information.   
m. Signature Row 

i.  Relinquished by 
1. Sign, date, and time the COC upon relinquishing the samples to the 

laboratory technician, laboratory courier, or Peabody personnel.  
ii. Received by 

1. The laboratory technician, laboratory courier, or Peabody personnel 
must sign, date, and time these cells upon receipt of the samples.   

Note 
1. Details of the required field parameters, lab parameters, and bottles for the sample 

types are noted on the bottom right corner of the COC.  
2. Make sure measured units match units listed on the COC 
3. No erroneous information may be erased from the COC. Errors must be lined out with 

a single dash, initialed, and the correction written in.  
4. Review the COC for accuracy prior to relinquishing it.   
 

 

Attachment 4.6.3 
Revised 04/21/2021



0 1200' 2400' 3600'

SCALE:

DATE:

DRAWN BY:

1" = 1200'

JSB

GENERAL INFORMATION

PERMIT NO.: GATEWAY MINE

COULTERVILLE, TILDEN 7.5 MIN. QUADRANGLESQUADRANGLE:

DESCRIPTION:

MINE NAME:#426

REVISED  04-21-2021

ROADS

LAKE OR POND W/ID. NUMBER

STREAMS

RANDOLPH COUNTY, ILLINOIS 
T.4 S.-R.5 W. SEC'S: 16, 21





Coulterville, Illinois
PEABODY COULTERVILLE MINING LLC.



INFORMATION
HYDROGEOLOGIC

TD-14'
G-1

SW-6
STREAM SAMPLE POINT

RESIDENTIAL WELL

MONITORING WELL
26 MW-2

PERMIT #53 SURFACE EFFECTS BOUNDARY

PERMIT #51 SURFACE EFFECTS BOUNDARY

PERMIT #426 REFUSE PERMIT BOUNDARY

PERMIT #416 SURFACE EFFECTS BOUNDARY

PERMIT #225 SURFACE EFFECTS BOUNDARY

PERMIT #205 SURFACE EFFECTS BOUNDARY

PERMIT #160 SURFACE EFFECTS BOUNDARY

SW-6
INACTIVE STREAM SAMPLE POINT

SURFACE WATER CIA

R
.
 
5

 
W

.

GWN-O4E

10GW-1
TD - 32.5'

TD - 22.1'

TD - 14.6'

SLURRY CELL NO. 4

GW103

GW101

TD - 22.4'
GW100

P

E

R

M

I

T

 

5

3

P
E

R
M

I
T

 
5

3

P

E

R

M

I

T

 

5

3

PERMIT 53

PERMIT 53

PERMIT 51

P

E

R

M

I

T

 

5

1

P
E

R
M

I
T

 
4

1
6

 
 
(
P

e
n

d
i
n

g
)

P

E

R

M

I

T

 

4

1

6

PERMIT 225

PERMIT 225

PERMIT 205

P

E

R

M

I

T

 

2

0

5

PERMIT 205

PERMIT 160

PERMIT 160

P
E

R
M

I
T

 
1

6
0

PERMIT 160

P

E

R

M

I

T

 

1

6

0

PERMIT 160

PERMIT

160

P

E

R

M

I

T

 

1

6

0

SB 011
CELL "B"

S
B

 011
C

E
LL "A

"

SB 012

SB 012

SED.
POND

SED.
POND

SED.
POND

MSHA #1211-IL08-02546-02

#160-2

#160-3

#160-4

SED.
POND

FRESH WATER LAKE

SB 008
WEST 

SB 008
EAST 
CELLCELL

RECIRCULATION POND
MSHA #1211-IL08-02546-03

OUTLET
FRESH
WATER
LAKE

FWL 001

PI001B

SB001

OUTLET

CELL "B"

CELL "A"















W3-06W3-07

W3-05

W3-04

14MW-2

14MW-1

W3-09

W3-15

W3-11 TD - 27.5'
TD - 34.0'

W3-13

W3-14

W3-08R

TD - 38'

TD - 23.5'

TD - 30.0'

TD - 27.0

W3-08

TD - 23.5'

W3-12

TD - 27.0'

TD - 33.0'

W3-16

W3-10



AutoCAD SHX Text
G:\DWG\GATEWAY\REFUSE EXPANSION PERMIT 426\MAP 4SF DRAFT 20210304.DWG

AutoCAD SHX Text
21W-1

AutoCAD SHX Text
G

AutoCAD SHX Text
15W-5

AutoCAD SHX Text
15W-6

AutoCAD SHX Text
22W-1

AutoCAD SHX Text
22W-2

AutoCAD SHX Text
22W-3

AutoCAD SHX Text
FRESH

AutoCAD SHX Text
WATER

AutoCAD SHX Text
LAKE

AutoCAD SHX Text
21W-1

AutoCAD SHX Text
21W-5

AutoCAD SHX Text
21W-6

AutoCAD SHX Text
22W-5

AutoCAD SHX Text
22W-6

AutoCAD SHX Text
22W-7

AutoCAD SHX Text
16W-4

AutoCAD SHX Text
19W-3

AutoCAD SHX Text
19W-2

AutoCAD SHX Text
17W-1

AutoCAD SHX Text
20W-1

AutoCAD SHX Text
20W-2

AutoCAD SHX Text
21W-7

AutoCAD SHX Text
21W-8

AutoCAD SHX Text
21W-9

AutoCAD SHX Text
19W-7

AutoCAD SHX Text
20W-3

AutoCAD SHX Text
27W-6

AutoCAD SHX Text
28W-4

AutoCAD SHX Text
26W-1

AutoCAD SHX Text
30W-5

AutoCAD SHX Text
33W-1

AutoCAD SHX Text
33W-2

AutoCAD SHX Text
34W-1

AutoCAD SHX Text
34W-1

AutoCAD SHX Text
34W-2

AutoCAD SHX Text
34W-3

AutoCAD SHX Text
23W-1

AutoCAD SHX Text
23W-2



0 1200' 2400' 3600'

SCALE:

DATE:

DRAWN BY:

1" = 1200'

JSB

GENERAL INFORMATION

PERMIT NO.: GATEWAY MINE

COULTERVILLE, TILDEN 7.5 MIN. QUADRANGLESQUADRANGLE:

DESCRIPTION:

MINE NAME:#426

REVISED  04-21-2021

ROADS

LAKE OR POND W/ID. NUMBER

STREAMS

RANDOLPH COUNTY, ILLINOIS 
T.4 S.-R.5 W. SEC'S: 16, 21





Coulterville, Illinois
PEABODY COULTERVILLE MINING LLC.



INFORMATION
HYDROGEOLOGIC

TD-14'
G-1

SW-6
STREAM SAMPLE POINT

RESIDENTIAL WELL

MONITORING WELL
26 MW-2

PERMIT #53 SURFACE EFFECTS BOUNDARY

PERMIT #51 SURFACE EFFECTS BOUNDARY

PERMIT #426 REFUSE PERMIT BOUNDARY

PERMIT #416 SURFACE EFFECTS BOUNDARY

PERMIT #225 SURFACE EFFECTS BOUNDARY

PERMIT #205 SURFACE EFFECTS BOUNDARY

PERMIT #160 SURFACE EFFECTS BOUNDARY

SW-6
INACTIVE STREAM SAMPLE POINT

GROUNDWATER CIA

R
.
 
5

 
W

.

GWN-O4E

10GW-1
TD - 32.5'

TD - 22.1'

TD - 14.6'

SLURRY CELL NO. 4

GW103

GW101

TD - 22.4'
GW100

P

E

R

M

I

T

 

5

3

P
E

R
M

I
T

 
5

3

P

E

R

M

I

T

 

5

3

PERMIT 53

PERMIT 53

PERMIT 51

P

E

R

M

I

T

 

5

1

P
E

R
M

I
T

 
4

1
6

 
 
(
P

e
n

d
i
n

g
)

P

E

R

M

I

T

 

4

1

6

PERMIT 225

PERMIT 225

PERMIT 205

P

E

R

M

I

T

 

2

0

5

PERMIT 205

PERMIT 160

PERMIT 160

P
E

R
M

I
T

 
1

6
0

PERMIT 160

P

E

R

M

I

T

 

1

6

0

PERMIT 160

PERMIT

160

P

E

R

M

I

T

 

1

6

0

SB 011
CELL "B"

S
B

 011
C

E
LL "A

"

SB 012

SB 012

SED.
POND

SED.
POND

SED.
POND

MSHA #1211-IL08-02546-02

#160-2

#160-3

#160-4

SED.
POND

FRESH WATER LAKE

SB 008
WEST 

SB 008
EAST 
CELLCELL

RECIRCULATION POND
MSHA #1211-IL08-02546-03

OUTLET
FRESH
WATER
LAKE

FWL 001

PI001B

SB001

OUTLET

CELL "B"

CELL "A"















W3-06W3-07

W3-05

W3-04

14MW-2

14MW-1

W3-09

W3-15

W3-11 TD - 27.5'
TD - 34.0'

W3-13

W3-14

W3-08R

TD - 38'

TD - 23.5'

TD - 30.0'

TD - 27.0

W3-08

TD - 23.5'

W3-12

TD - 27.0'

TD - 33.0'

W3-16

W3-10



AutoCAD SHX Text
G:\DWG\GATEWAY\REFUSE EXPANSION PERMIT 426\MAP 4SF DRAFT 20210304.DWG

AutoCAD SHX Text
21W-1

AutoCAD SHX Text
G

AutoCAD SHX Text
15W-5

AutoCAD SHX Text
15W-6

AutoCAD SHX Text
22W-1

AutoCAD SHX Text
22W-2

AutoCAD SHX Text
22W-3

AutoCAD SHX Text
FRESH

AutoCAD SHX Text
WATER

AutoCAD SHX Text
LAKE

AutoCAD SHX Text
21W-1

AutoCAD SHX Text
21W-5

AutoCAD SHX Text
21W-6

AutoCAD SHX Text
22W-5

AutoCAD SHX Text
22W-6

AutoCAD SHX Text
22W-7

AutoCAD SHX Text
16W-4

AutoCAD SHX Text
19W-3

AutoCAD SHX Text
19W-2

AutoCAD SHX Text
17W-1

AutoCAD SHX Text
20W-1

AutoCAD SHX Text
20W-2

AutoCAD SHX Text
21W-7

AutoCAD SHX Text
21W-8

AutoCAD SHX Text
21W-9

AutoCAD SHX Text
19W-7

AutoCAD SHX Text
20W-3

AutoCAD SHX Text
27W-6

AutoCAD SHX Text
28W-4

AutoCAD SHX Text
26W-1

AutoCAD SHX Text
30W-5

AutoCAD SHX Text
33W-1

AutoCAD SHX Text
33W-2

AutoCAD SHX Text
34W-1

AutoCAD SHX Text
34W-1

AutoCAD SHX Text
34W-2

AutoCAD SHX Text
34W-3

AutoCAD SHX Text
23W-1

AutoCAD SHX Text
23W-2



Flow Acidity Alkalinity as 
CaCO3, @ pH 4.5

Lead Iron Manganese pH, Field Zinc Solids, Total 
Suspended Sulfates Total Dissolved 

Solids, Lab Chloride

N N N T T T N T N N N N
CFS MG/L MG/L MG/L MG/L MG/L S.U. MG/L MG/L MG/L MG/L MG/L

Average 0.01 -63.40 87.80 -- 0.28 0.29 7.69 -- 6.40 197.62 -- 21.18
Range 0.33 - 0 -40 - -85 118 - 68 -- 0.426 - 0.123 1.15 - 0.004 8.24 - 6.96 -- 14 - 2 390 - 35.7 -- 47.2 - 6.8
Count 185 5 5 0 5 5 21 0 5 17 0 17
Average 0.05 -79.60 113.79 0.0013 2.12 0.19 7.66 0.012 14.57 105.86 -- 53.19
Range 0.56 - 0 -38 - -177 222 - 68 0.0025 - 0.0007 8.26 - 0.414 0.648 - 0.021 8.82 - 6.48 0.017 - 0.005 46 - 3 245 - 19.8 -- 127 - 10.1
Count 222 47 47 10 46 46 89 10 47 85 0 85
Average 0.00 -- -- -- -- -- 6.92 -- -- 41.75 -- 17.75
Range 0.1 - 0 -- -- -- -- -- 7.26 - 6.11 -- -- 55.1 - 28.4 -- 22.3 - 13.2
Count 223 0 0 0 0 0 4 0 0 2 0 2
Average 0.04 -53.66 77.03 0.0007 0.31 0.06 8.00 0.007 5.70 21.98 -- 26.03
Range 0.76 - 0 -38 - -69 99 - 60 0.0007 - 0.0007 0.823 - 0.029 0.224 - 0.004 8.97 - 7 0.022 - 0.004 14 - 2 59.7 - 4.09 -- 59.4 - 2
Count 191 29 29 6 30 31 50 6 30 49 0 49
Average 0.30 -82.91 104.88 0.0009 0.75 0.24 7.90 0.047 12.88 930.58 -- 252.81
Range 11 - 0 -36 - -122 146 - 46 0.0023 - 0.0007 1.97 - 0.055 0.669 - 0.056 8.65 - 6.5 0.135 - 0.004 29 - 2 1530 - 91.7 -- 460 - 37.4
Count 293 32 32 9 32 37 58 9 32 59 0 59
Average 0.09 -55.67 80.67 0.0008 1.48 0.10 8.05 0.009 23.45 39.97 235.00 13.96
Range 1.3 - 0 -14 - -99 118 - 26 0.0013 - 0.0007 5.94 - 0.255 0.451 - 0.018 8.97 - 6.47 0.02 - 0.004 102 - 4 205 - 0.3 235 - 235 74.8 - 0.5
Count 213 60 60 10 60 60 101 11 60 102 1 102
Average 0.13 -81.76 115.70 0.0009 1.12 0.30 8.17 0.007 20.83 112.07 380.00 68.07
Range 3.3 - 0 40 - -127 172 - 59 0.0024 - 0.0007 4.19 - 0.007 8.02 - 0.004 9.04 - 7.12 0.012 - 0.004 57 - 2 386 - 15.1 380 - 380 277 - 11.2
Count 209 66 66 11 66 67 111 12 66 113 1 113

DA0001 01/01/15 12/31/20

Location Start Date End Date

DA0002 01/01/15 12/31/20

DA0003 01/01/15 12/31/20

Statistics

DA0011 01/01/15 12/31/20

DA0012 01/01/15 12/31/20

DA0007 01/01/15 12/31/20

DA0008 01/01/15 12/31/20

Attachment 4.8.4.1 
Revised 04/21/2021 

Page 1 of 1



Gateway Mine Cell 5 Phase 2 Application 
Preventative and Remedial Measures Plan 
 
Geologic conditions at Gateway Mine are described in detail in Parts 4.1 – 4.3.  In summary, the 
unconsolidated materials within and adjacent to Permit 426 are fine grained, low-permeability silts and 
clays.  Isolated deposits of sandy material are present but are limited in lateral extent and geologically 
isolated.  Shallow bedrock material consists predominantly of shales, siltstones, and sandstones of low-
permeability.  Due to the absence of significant aquifers in this geologic setting, there is limited use of 
local groundwater and surface water by adjacent residents.  Municipal water supplies are relied upon 
for residential use. 
 
The design and construction of Cell 5 Phases 1 & 2 includes several pollution control and minimization 
measures, including a liner and enhanced cover.  Details of the liner and enhanced cover is provided in 
Attachment 9.4.1.  These measures will ensure protection of the hydrologic balance within and adjacent 
to the permit area.  Additional protections are provided through refuse handling practices discussed in 
Part 4.7.8.  Proper refuse handling minimizes generation of acid or toxic drainage.  Runoff from the 
refuse area is directed through the network of surface water control structures to the sediment basins 
designed, constructed and maintained in accordance with regulatory requirements.  The surface water 
control structures and sediment basins minimize contributions of suspended sediment and other 
pollutants to receiving streams.  The extensive surface water, groundwater, and NPDES sampling plans 
offer the final level of protection that minimizes impacts to the hydrologic balance onsite and prevents 
material damage to the hydrologic balance in adjacent areas and offsite.  Monitoring and reporting 
practices also ensure compliance with Federal and State water quality laws and regulations.  Details of 
the sampling, analysis, and reporting procedures are outlined in Attachments 4.5.1 and 4.6.3. 
 
In the event that contamination or interruption of a surface water or groundwater source has occurred, 
it will be addressed through replacement with an alternative source of water or treatment, as described 
in Parts 4.8.3 and 4.8.6.  Similarly, in the event that onsite discharges exceed regulatory limits and 
discharge cannot be practicably prevented, treatment of surface water will be evaluated.  Primary 
methods of surface water treatment include pH control and flocculants to aid in settling suspended 
sediment.  Treatment chemicals may include, but are not limited to, sodium hydroxide, hydrated lime, 
soda ash briquettes, and alum.  Any treatment of surface water discharges that will occur will be 
conducted in compliance with NPDES regulations.  The protection of the hydrologic balance and the 
probably hydrologic consequences analysis is described in detail in Part 4.8. 
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